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О программе SMART Notebook
ВПО SMART Notebook можно создавать ф айлы *.notebook, соде ржащие граф ику, те кст,
таблицы, линии, ф игуры, анимацию и многое другое . Демонстрируйте ф айл и уде рживайте
внимание класса , пе ремещая объе кты и управляя ими. Если класс высказывае т комментарии
и пре дложения, з аписывайте их на странице с помощью циф ровых че рнил. Вы може те
открывать ф айлы *.notebook в ПО SMART Notebook на компьюте рах с опе рационными
системамиWindows®, Mac или Linux®. Вы также може те экспортировать свой ф айл в
различные ф орматы, включая HTML и PDF.

Для добавле ния дополните льныхф ункций ПО SMART Notebook можно установить
инструме нты SMART Notebook Tools, а также надстройки сторонних разработчиков.
Инструме нты SMART Notebook Tools включают в се бя сле дующе е .

l 3D-инструме нты для ПО SMART Notebook

l Инструме нты объе дине ния ре альносте й для докуме нт-каме ры SMART

Document Camera™

l SMART Notebook Math Tools

О другом ПО SMART, установленном на
компьютере
На вашем компьюте ре може т быть установле но другое ПО SMART.

l Драйверы продуктов SMART

Ваш инте рактивный продукт распознае т касания экрана и посылае т координаты каждого
касания вме сте с инф ормацие й о пе ре компьюте ру, к которому подключе н
инте рактивный продукт. SMART Product Drivers пре образуют инф ормацию в нажатия
кнопок мыши и циф ровые че рнила . SMART Product Drivers позволяют выполнять
стандартные компьюте рные опе рации с помощью пальце в или пе ра .

l SMART Ink™

С помощью SMART Ink можно писать или рисовать на экране циф ровыми че рнилами с
помощью пе ра , з атем сохранять или стирать записи.

l Инструменты SMART Board®

Можно привле чь внимание к опре де ле нным частям страницы с помощью инструме нтов
SMART Tools, как "Зате не ние экрана", "Подсве тка", "Лупа" и "Указате ль".
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Новые возможности
Вде кабрьской ве рсии ПО SMART Notebook 2015 появились сле дующие новые ф ункции.

Программное обе спе чение SMART Notebook 15.2
Особенность Тема

Новые занятия и темы для конструктора учебных
занятий (LAB)

В LAB добавле ны два новых занятия: Speedup (Гонки) и
Label Reveal (Открытие подписе й). Вигре Speedup (Гонки)
учащие ся соре внуются друг с другом, отве чая на
вопросы. Вигре Label Reveal (Открытие подписе й)
учащие ся посте пе нно открывают подписи, описывающие
характе ристики какого -либо объе кта .
Тепе рь во все х занятиях можно работать как с те кстом,
так и с изображе ниями (з а исключе нием занятия Fill In the
Blanks (Заполните пропуски)). Это сде лае т з анятия еще
боле е увле кате льными.
Кроме того , для LAB пре дставле ны новые темы, такие как
Knight and Dragon (Рыцарь и дракон), Bees (Пче лы) и Simple
(Простая).

Создание занятий с помощью
конструктора учебных занятий
(LAB) на странице  144

Управление материалами в
конструкторе учебных занятий
на странице  171

Новыефункции занятия Shout It Out! (Кричи!)

Вданной ве рсии занятия Shout It Out! (Кричи!) добавле ны
новые ф ункции для учите ле й. Наприме р , з агруженные
учащимися мате риалы можно ле гко пе реме стить из одной
кате гории в другую. Дополне ния для учащихся включают
значок Home (Главная страница ) для устройств и
конте кстуальную циф ровую клавиатуру для ввода циф р .
Как и все гда , с помощью своих мобильных устройств
учащие ся могут быстро создавать и отправлять
изображе ния и те ксты в занятия создания мате риалов
LAB, а учите ля могут ле гко прове рять мате риалы.

Добавление задания «Кричи!»
на странице  159

Добавление материалов
учащихся в задание «Кричи!»
на странице  162

Новые надстройки

Надстройка SMART kapp

С помощью надстройки SMART kapp се ссии kapp могут
быть инте грированы не посре дстве нно в Notebook 15.2.
Посе тите сайтwww.smarttech.com для получе ния
подробной инф ормации об установке надстройки.
Надстройка YouTube™

Надстройка YouTube™ позволяе т осуще ствлять
бе зопасный поиск, просматривать и напрямую встраивать
мате риалы из YouTube в Notebook 15.2.

Использование надстройки
SMART kapp на странице  104

Вставка материалов с
помощью надстройки YouTube
на странице  105

http://www.smarttech.com/
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Особенность Тема

Улучшения SMART Ink 3.2

SMART Ink 3.2 продолжае т впе чатлять пользовате ля
новыми инструме нтами (в том числе инструме нтом Stamp
(Штамп)), а также быстрым доступом к избранным
настройкам.

Инструмент Stamp pad (Штемпельная подушка)

Инструме нтStamp pad (Штемпе льная подушка ) SMART Ink
можно использовать с де сятью стандартными штампами.
Кроме того , можно создать собстве нные штампы.

Инструме нтStamp pad (Штемпе льная подушка ) можно
использовать для закре пле ния иде й, исправле ния
учащихся или их поощре ния и т. д. Управлять штампами (и
стирать их) так же ле гко , как и циф ровыми че рнилами.
Инструменты

Инструме нты SMART Ink 3.2 на пане ли инструме нтов
SMART Ink не занимают лишне го ме ста , поэтому вы все гда
сможе те получить доступ к инструме нтам Screen Capture
(Захват экрана ), Text Input (Ввод те кста ) и Stamp Pad
(Штемпе льная подушка ).
Быстрый доступ к избранному

Первые че тыре избранных пе ра появятся на пане ли
инструме нтов че рнил для быстрого доступа .
Подключаемый модуль SMART Ink для Adobe Reader

С помощью подключаемого модуля SMART Ink в ф айлах
PFD можно писать и рисовать циф ровыми че рнилами, а
также стирать их. Подключаемый модуль позволяе т
вставлять циф ровые че рнила в виде комментарие в и
сохранять такие комментарии в ф айле PDF. Циф ровые
че рнила прокручиваются вме сте с соде ржимым ф айла
PDF.

ПО SMART Notebook 15.1
Особенность Тема

В конструктор учебных занятий (LAB) добавле ны два
новых занятия: Speedup (Гонки) и Label Reveal (Открытие
подписе й). Также были добавле ны новые красочные темы.

Создание занятий с помощью
конструктора учебных занятий
(LAB) на странице  144



CHAPTER1
НАЧАЛО РАБОТЫ С ПРОГРАММНЫМ ОБЕСПЕЧЕНИЕМ SMART NOTEBOOK

5

Особенность Тема

Shout It Out! (Кричи!) — это инструме нт создания
мате риалов, с которым учащие ся и учите ля могут
работать в конструкторе уче бных занятий (LAB). Вданной
ве рсии было добавле но не сколько дополне ний для
учите ле й и учащихся, наприме р значок Home (Главная
страница ) для устройств и конте кстуальная циф ровая
клавиатура для ввода циф р . Как и все гда , с помощью
своих мобильных устройств учащие ся могут быстро
создавать и отправлять изображе ния и те ксты в занятия
создания мате риалов LAB, а учите ля могут ле гко
прове рять мате риалы.

Добавление задания «Кричи!»
на странице  159

В новых занятиях LAB теперь осуществляется
поддержка изображений (з а исключе нием Fill in the
Blanks (Заполните пропуски)). Добавляйте в кате гории LAB
изображе ния и списки. Тепе рь эта ф ункция также
доступна в занятии Flip cards (Пере ворачивание карточе к).

Управление материалами в
конструкторе учебных занятий
на странице  171

Улучшения SMARTInk 3.1включают:
l Обновле ние динамиче ской пане ли инструме нтов
l Оконные инструме нты SMART Ink
l Избранные пе рья SMART Ink
l Сре дство ввода рукописных данных SMART

ПО SMART Notebook 15
Особенность Тема

Конструктор уче бных занятий помогае т быстро создать
инте рактивное игровое занятие для учащихся, что сде лае т
проце сс обуче ния боле е увле кате льным.

Создание занятий с
помощью конструктора
учебных занятий (LAB) на
странице  144

Создание конце птуальных карт помогае т учащимся
систематизировать инф ормацию.

Chapter 9: Работа с
концептуальными
картами на странице  175
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Особенность Тема

Тепе рь для все х пользовате ле й в пане ли инструме нтов
доступны ф ункции для работы с ф ормами и углами:

l Инструме нт создания не правильных многоугольников

l Инструме нт "Многоугольник"

l Показать длины сторон

l Показать внутре нние углы

l Показать ве ршины

l Разде ле ние ф игур

Оптимизация характе ристик просмотра повышае т каче ство
работы YouTube™ и GeoGebra.

Запуск программного обеспечения
SMART Notebook
Запустите ПО SMART Notebook, дважды щелкнув по значку SMART Notebook на рабочем
столе .

При пе рвом запуске SMART Notebook автоматиче ски открывае тся ф айл руководства .
Прочитав мате риалы, пре дставле нные в этом ф айле , можно получить дополните льную
инф ормацию об этом программном обе спе че нии и новыхф ункциях после дних ве рсий. По
заве ршении выбе рите File &gt; New («Файл» &gt; «Новый») , чтобы создать новый пустой
ф айл.

NOTE

Впосле дующем при запуске ПО новый пустой ф айл открывае тся автоматиче ски. Чтобы
открыть обучающий ф айл, выбе рите Help &gt; Tutorial («Справка» &gt; «Руководства»).

Управление пользовательским интерфейсом
Инте рф е йс пользовате ля ПО SMART Notebook состоит из сле дующих элеме нтов:

l Меню

l Пане ль инструме нтов

l Вкладки: Page Sorter («Сортировщик страниц»), Gallery («Гале ре я»), Attachments
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(«Вложения»), Properties («Свойства»), Add-ons («Надстройки») и SMART Response®)

l Область страницы

Меню
Вменю соде ржатся все команды, которые можно использовать для управле ния ф айлами и
объе ктами в ПО SMART Notebook.

Сортировщик страниц
Сортировщик страниц отображае т все страницы в открытом ф айле в виде эскизов и
автоматиче ски обновляе т эти эскизы при изме не нии соде ржимого страниц.

При использовании сортировщика страниц вы може те выполнять сле дующе е :

l Выре зание , копирование и вставка страниц

l Отображение страниц

l Выре зание , копирование , вставка страниц

l Создание страниц

l Клонирование страниц

l Очистка страниц

l Удале ние страниц

l Пере име нование страниц

l Измене ние порядка страниц

l Пере нос объе ктов с одной страницы на другую

l Группировка страниц

Открытие сортировщика страниц

Чтобы открыть сортировщик страниц, нажмите &quot;Сортировщик страниц&quot; .

Настройка сортировщика страниц
Сортировщик страниц можно пе реме стить с одной стороны окна SMART Notebook на

другую, нажав на значок &quot;Переместить боковую панель&quot; .

Разме р сортировщика страниц можно изме нить , пе ре тягивая е го край вле во или вправо .
Если сортировщик страниц не используе тся, е го можно скрыть , установив ф лажок
&quot;Скрывать автоматически&quot; . (Чтобы отобразить скрытый сортировщик страниц,

нажмите &quot;Сортировщик страниц&quot; .)
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NOTE

Если уме ньшить разме р сортировщика страниц до минимального , ф ункция скрытия
включится автоматиче ски.

Вкладка «Гале ре я»
На вкладке Gallery («Гале ре я») соде ржится граф ика , ф оновые рисунки, мультиме дийные
мате риалы, ф айлы и страницы, которые вы може те использовать в своих уроках, а также
пре длагае тся пре дварите льный просмотр этих мате риалов. Вкладка «Гале ре я» также
пре доставляе т доступ к другим инте рактивным ре сурсам. Дополните льную инф ормацию см.

на странице Вставка материалов из Галереи на странице  88.

Кроме того , вы може те включить в гале рею свои собстве нные мате риалы и мате риалы своих
колле г (см. Организация и предоставление общего доступа к содержимому с помощью

Галереи на странице  112).

Открытие вкладки "Галерея"

Чтобы открыть вкладку Gallery («Гале ре я»), нажмите Gallery .

Настройка вкладки "Галерея"
Вкладку Gallery («Гале ре я») можно пе реме стить с одной стороны окна SMART Notebook на

другую, нажав значок Move Sidebar («Переместить боковую панель») .

Разме р вкладки Gallery (Гале ре я) можно изме нить , пе ре тягивая е е край вле во или вправо .
Если вкладка Gallery (Гале ре я) не используе тся, е е можно скрыть , установив ф лажокAuto-

hide (Скрывать автоматически). (Чтобы отобразить скрытую вкладку Gallery (Гале ре я),

нажмите Gallery (Галерея) .)

NOTE

Если уме ньшить разме р вкладки "Гале ре я" до минимального , ф ункция скрытия включится
автоматиче ски.

Вкладка «Вложения»
На вкладке Attachments («Вложения») отображаются ф айлы и ссылки на ве б -страницы,

вложенные в те кущий ф айл. Дополните льную инф ормацию см. в разде ле Вложение файлов

и веб-страниц на странице  110.

Открытие вкладки "Вложения"

Чтобы снова открыть вкладку Attachments («Вложения»), нажмите Attachments .
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Настройка вкладки "Вложения"
Вкладку Attachments («Вложения») можно пе реме стить с одной стороны окна
SMART Notebook на другую, нажав значок Move Sidebar («Переместить боковую панель»)

.

Разме р вкладки Attachments (Вложения) можно изме нить , пе ре тягивая е е край вле во или
вправо . Если вкладка Attachments (Вложения) не используе тся, е е можно скрыть , установив
ф лажок Auto-hide (Скрывать автоматически) . (Чтобы отобразить скрытую вкладку

Attachments (Вложения), нажмите Attachments (Вложения) .)

NOTE

Если уме ньшить разме р вкладки "Вложения" до минимального , ф ункция скрытия включится
автоматиче ски.

Вкладка "Свойства"
Вкладка "Свойства" позволяе т изме нять ф ормат объе ктов, таких как циф ровые че рнила ,
ф игуры, линии, те кст и таблицы. В зависимости от выбранного объе кта , вы може те изме нять :

l цве т, толщину и тип линий;

l прозрачность и эфф е кты заливки объе ктов;

l тип шриф та для те кстовых объе ктов, е го ке гль и стиль ;

l анимацию объе ктов.

На вкладке Properties («Свойства») отображаются только опции, доступные для выбранного
объе кта . Дополните льная инф ормация об отображе нии и настройке свойств объе ктов на
вкладке Properties («Свойства») пре дставле на в разде ле Изменение свойств объектов на
странице  66.

На вкладке Properties («Свойства») также име е тся кнопка Page Recording («Запись

страницы») . Вы може те использовать эту ф ункцию для записи ваших де йствий на те кущей
странице (см. разде л Запись страниц с помощью средства записи уроков на странице  188).

Открытие вкладки "Свойства"

Чтобы открыть вкладку &quot;Свойства&quot;, нажмите &quot;Свойства&quot; .

Настройка вкладки "Свойства"
Вкладку &quot;Свойства&quot; можно пе реме стить с одной стороны окна SMART Notebook

на другую, нажав на значок &quot;Переместить боковую панель&quot; .
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Разме р вкладки &quot;Свойства&quot; можно изме нить , пе ре тягивая е е край вле во или
вправо . Если вкладка &quot;Свойства&quot; не используе тся, е е можно скрыть , установив
ф лажок &quot;Скрывать автоматически&quot; . (Чтобы отобразить скрытую вкладку

&quot;Свойства&quot;, нажмите &quot;Свойства&quot; .)

NOTE

Если уме ньшить разме р вкладки "Свойства" до минимального , ф ункция скрытия включится
автоматиче ски.

Вкладка «Надстройки»
Вкладка Add-ons («Надстройки») позволяе т работать с надстройками ПО SMART Notebook

(см. Chapter 11: Расширение функционала ПО SMART Notebook с помощью надстроек на
странице  229).

Вызов вкладки "Надстройки"

Чтобы открыть вкладку Add-ons («Надстройки»), нажмите Add-ons («Надстройки») .

Настройка вкладки "Надстройки"
Вкладку Add-ons («Надстройки») можно пе реме стить с одной стороны окна SMART Notebook

на другую, нажав значок Move Sidebar («Переместить боковую панель») .

Разме р вкладки Add-ons (Надстройки) можно изме нить , пе ре тягивая е е край вле во или
вправо . Если вкладка Add-ons (Надстройки) не используе тся, е е можно скрыть , установив
ф лажок Auto-hide (Скрывать автоматически). (Чтобы отобразить скрытую вкладку Add-ons

(Надстройки), нажмите Add-ons (Надстройки) .)

NOTE

Если уме ньшить разме р вкладки "Надстройки" до минимального , ф ункция скрытия
включится автоматиче ски.

Вкладка SMART Response
Вкладка SMART Response являе тся частью ПО SMART Response и доступна , только е сли на
компьюте ре установле но ПО SMART Response.

Область страницы
Вобласти страницы отображае тся соде ржимое выбранной страницы в ф айле . Это область
страницы, где вы може те создавать объе кты и работать с ними (см. Chapter 4: Создание

основных объектов на странице  33).
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Просмотр уведомлений при смене
инструмента
Если в вашем продукте SMART включе на ф ункция распознавания касаний, ПО
SMART Notebook буде т отображать уве домле ния о сме не инструме нта при выборе нового
инструме нта или изме не нии е го параме тров. Перья, ластик и мышь являются аппаратными
инструме нтами. Вы также може те просматривать уве домле ния при сме не инструме нта , когда
касае те сь пальцем пове рхности экрана .

NOTE

Не все аппаратные продукты SMART подде рживают те хнологию распознавания касаний.
Дополните льная инф ормация приве де на в руководстве пользовате ля оборудования
SMART.

Просмотр уведомлений о смене инструмента

Нажмите на пане ль инструме нтов с помощью пе ра или пальца , а з атем выбе рите
параме тры инструме нта .

Под пане лью инструме нтов появится пане ль состояния, на которой будут отображаться
активный инструме нт и е го параме тры. Пане ль состояния обновляе тся при каждом
выборе инструме нта или изме не нии параме тров.

NOTE

Пане ль состояния также появляе тся при задании параме тров че рнил аппаратного
пе ра на пане ли Properties («Свойства») (см. разде л Изменение свойств объектов на
странице  66).
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Использование жестов
С объе ктами в ПО SMART Notebook можно взаимоде йствовать с помощью сле дующих
же стов (е сли они подде рживаются инте рактивным продуктом):

Смахивание (сле ва направо ) Смахивание (справа нале во )

Жест-щипок для уве личе ния изображе ния
/ масштабирования (уве личе ния)

Жест-щипок для уме ньшения
изображе ния / масштабирования

(уме ньшения)

Панорамировать Вращать
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Встряхивать Быстрое движение

Отмена и возврат действий
При вне се нии изме не ний в ф айл можно отме нить эфф е кт пре дыдущих де йствий и команд.

NOTE

Если инте рактивный продукт используе тся двумя пользовате лями, нажатие Undo

(«Отменить») и Redo («Восстановить») влияе т на де йствия обоих пользовате ле й.

Отмена последнего действия:

Нажмите кнопку Undo («Отменить») .

NOTE

Вы може те отме нять не ограниче нное количе ство де йствий.

Восстановление последнего действия, отмененного командой Undo («Отмена»):

Нажмите кнопку Redo («Восстановить») .
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Chapter 2: Создание файлов и работа с ними

Создание ф айлов 15
Открытие ф айлов 16
Сохране ние ф айлов 16
Экспортф айлов 17
Печать ф айлов 20
Автоматиче ское сохране ние ф айлов 21
Вложение ф айлов в сообщения эле ктронной почты 25

Впрограммном обе спе че нии SMART Notebook можно создавать или открывать ф айлы
*.notebook. После создания или открытия ф айла *.notebook е го можно сохранить ,
распе чатать и выполнить с ним другие стандартные де йствия.

Создание файлов
При пе рвом запуске программного обе спе че ния SMART Notebook автоматиче ски
открывае тся ф айл руководства . Вдальне йшем при запуске программного обе спе че ния
автоматиче ски открывае тся новый пустой ф айл *.notebook. Однако новый ф айл можно
создать в любой момент.

Чтобы создатьфайл:

Выбе рите File &gt; New («Файл» &gt; «Создать»).

Если вы работае те с ф айлом, в котором имеются не сохране нные изме не ния, появится
диалоговое окно с вопросом о сохране нии те куще го ф айла . Нажмите Yes («Да») , чтобы
сохранить изме не ния, а з атем сле дуйте инструкциям на экране .
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Открытие файлов
ПО SMART Notebook 15.х открывае т и сохраняе тф айлы *.notebook (ф ормат по умолчанию
для ПО SMART Notebook 9.5, 9.7, 10 и 11).

NOTE

SMART Notebook ве рсий 8.x, 9.0 и 9.1 може т открыть ф айлы ф ормата *.xbk, а не *.notebook.

Метод открытия ф айла одинаковый для все х ве рсий программного обе спе че ния
SMART Notebook.

Чтобы открытьфайл, выполните следующие действия:

1. Нажмите Open File («Открытьфайл») .

Появится диалоговое окноOpen («Открыть»).

2. Найдите и выбе рите ф айл.

3. Нажмите кнопку Open («Открыть»).

TIP

Вы може те открыть не давно открывавшийся ф айл, выбрав ме ню File («Файл») , а з атем
выбрав имя ф айла .

Сохранение файлов

ПО SMART Notebook 15.х открывае т и сохраняе тф айлы в ф ормате *.notebook (ф ормат по
умолчанию для ПО SMART Notebook 9.5, 9.7, 10 и 11)

NOTE

По умолчанию для программного обе спе че ния SMART Notebook ве рсии 8, 9.0 и 9.1

используе тся ф орматф айла *.xbk. Однако ф ормат *.xbk не подде рживае т не которые
объе кты и свойства , имеющие ся в этой ве рсии программного обе спе че ния
SMART Notebook.
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Сохранение нового файла:

1. Нажмите Save («Сохранить») .

Появится диалоговое окно Save As («Сохранить как»).

2. Выбе рите папку для сохране ния нового ф айла .

3. Вве дите имя ф айла в поле File name (Имя файла).

4. Нажмите &quot;Сохранить&quot;.

Сохранение существующего файла:

Нажмите Save («Сохранить») .

Сохранение под новым именем или в новом месте:

1. Выбе рите File &gt; Save As («Файл» &gt; «Сохранить как»).

Появится диалоговое окно Save As («Сохранить как»).

2. Выбе рите папку для сохране ния нового ф айла .

3. Вве дите имя ф айла в поле File name («Имя файла») .

4. Нажмите &quot;Сохранить&quot;.

Экспорт файлов
Файлы *.notebook можно экспортировать в сле дующие ф орматы:

l Веб -страницы

l Форматы изображений

o BMP

o GIF

o JPEG

o PNG

l PowerPoint®

l PDF

l Используемый ф орматф айлов инте рактивных досок (CFF)
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NOTES

l ПО SMART Notebook не включае т вложения при экспортировании ф айлов в виде
изображе ний. Чтобы включить вложения, сле дуе т экспортировать ф айл как ве б -
страницу или PDF (Adobe Acrobat Reader 6.0 и боле е поздне й ве рсии).

l Программное обе спе че ние SMART Notebook не экспортируе тф айлы, прикре пле нные
к ф айлу *.notebook в виде ярлыков. Чтобы вложить ф айл, прикре пите е го копию (см.

Вложение файлов и веб-страниц на странице  110).

l ПО SMART Notebook не экспортируе т не которые эфф е кты градие нтов, узоров и
изображе ний. Эти эфф е кты могут отображаться в экспортированном ф айле не ве рно
или в виде сплошной заливки.

Вы также може те настроить ПО SMART Notebook на сохране ние ф айла *.notebook при
пе ре ходе к другой странице или по исте че нии заданного време ни (см. Автоматическое

сохранение файлов на странице  21).

Экспорт файла в формате веб-страниц

1. Выбе рите File &gt; Export As &gt; Web Page («Файл» &gt; «Экспортировать как» &gt;

«Веб-страница»).

Появится диалоговое окно Save As («Сохранить как»).

2. Выбе рите папку для экспорта ф айла .

3. Вве дите имя ф айла в поле File name («Имя файла») .

4. Нажмите &quot;Сохранить&quot;.

Экспорт файла в формате изображения

1. Выбе рите File &gt; Export As &gt; Image Files («Файл» &gt; «Экспортировать как» &gt;

«Файлы изображений»).

Появится диалоговое окно Save As («Сохранить как»).

2. Выбе рите папку, в которую нужно экспортировать ф айлы изображений.

3. Выбе рите тре буемый ф ормат изображе ния из выпадающе го списка Image Type (Тип

изображения).

4. Выбе рите разме р изображе ния из выпадающе го списка Size (Размер).

5. Нажмите OK.
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Экспорт файла в PowerPoint

1. Выбе рите пунктме ню File &gt; Export As &gt; PowerPoint («Файл» &gt; «Экспортировать

как» &gt; PowerPoint).

Появится диалоговое окно Save As («Сохранить как»).

2. Выбе рите папку для экспорта ф айла .

3. Вве дите имя ф айла в поле File name («Имя файла») .

4. Выбе рите PowerPoint 2007 Files (*.pptx) (Файлы PowerPoint 2007 (*.pptx)) или
PowerPoint Files (*.ppt) (Файлы PowerPoint (*.ppt)) в выпадающем списке Save at type

(Сохранить в формате).

5. Нажмите &quot;Сохранить&quot;.

NOTE

Файлы PowerPoint можно также импортировать (см. Импорт файлов PowerPoint на
странице  102).

Экспорт файла в формате PDF

1. Выбе рите File &gt; Export As &gt; PDF («Файл» &gt; «Экспорт» &gt; PDF).

Появится диалоговое окно Export PDF («Экспорт PDF»).

2. Нажмите Thumbnails («Эскизы»), Handouts («Проспекты») или Full Page («Вся

страница»).

3. Дополните льно вве дите те кст з аголовка в поле Header («Заголовок») те кст нижне го
колонтитула в поле Footer («Нижний колонтитул») и те кущую дату в поле Date («Дата») .

4. Дополните льно установите ф лажок Show page numbers («Показывать номера

страниц») , чтобы показывать номе р каждой страницы.

5. Если вы нажали Thumbnails («Эскизы») илиHandouts («Проспекты») на шаге 2,

выбе рите разме р эскиза в выпадающем списке Thumbnail size («Размер эскиза») и
опционально установите ф лажок Page borders («Границы страниц») , чтобы показать
границу вокруг каждого эскиза , и ф лажок Thumbnail titles («Названия эскизов») , чтобы
показать название под каждым эскизом.
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6. Выбе рите All («Все») , чтобы включить все страницы.

ИЛИ

Выбе рите Pages («Страницы») , чтобы включить избранные страницы, з атем вве дите
номе ра страниц в поле . Разде ляйте номе ра страниц запятыми, а для указания диапазона
страниц используйте деф ис (наприме р , 1,2,4-7).

7. Нажмите &quot;Сохранить&quot;.

Появится диалоговое окно Save as PDF File (Сохранить как файл PDF).

8. Выбе рите папку для экспорта ф айла .

9. Вве дите имя ф айла в поле File name («Имя файла») .

10. Нажмите &quot;Сохранить&quot;.

Экспорт файла в формате CFF

1. Выбе рите File &gt; Export As &gt; CFF («Файл» &gt; «Экспортировать как» &gt; CFF).

Появится диалоговое окно Save As («Сохранить как»).

2. Выбе рите папку для экспорта ф айла .

3. Вве дите имя ф айла в поле File name («Имя файла») .

4. Нажмите &quot;Сохранить&quot;.

NOTE

Можно также импортировать ф айлы CFF (см. Импорт файлов из других программ для

работы с интерактивными досками на странице  103).

Печать файлов
Можно напе чатать все или выбранные страницы ф айла *.notebook. Страницы можно
распе чатывать в виде эскизов, раздаточныхмате риалов или це лых страниц.

Печатьфайла:

1. Выбе рите File &gt; Print («Файл» &gt; «Печать»).

Появится диалоговое окноPrint («Печать»).

2. Нажмите Thumbnails («Эскизы»), Handouts («Проспекты») или Full Page («Вся

страница»).
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3. Дополните льно вве дите те кст з аголовка в поле Header («Заголовок») те кст нижне го
колонтитула в поле Footer («Нижний колонтитул») и те кущую дату в поле Date («Дата») .

4. Дополните льно установите ф лажок Show page numbers («Показывать номера

страниц») , чтобы показывать номе р каждой страницы.

5. Если вы нажали Thumbnails («Эскизы») илиHandouts («Проспекты») на шаге 2,

выбе рите разме р эскиза в выпадающем списке Thumbnail size («Размер эскиза») и
опционально установите ф лажок Page borders («Границы страниц») , чтобы показать
границу вокруг каждого эскиза , и ф лажок Thumbnail titles («Названия эскизов») , чтобы
показать название под каждым эскизом.

6. Выбе рите All («Все») , чтобы включить все страницы.

ИЛИ

Выбе рите Pages («Страницы») , чтобы включить избранные страницы, з атем вве дите
номе ра страниц в поле . Разде ляйте номе ра страниц запятыми, а для указания диапазона
страниц используйте деф ис (наприме р , 1,2,4-7).

7. Выбе рите вкладку Printer Setup («Настройка принтера») .

8. Укажите другие параме тры пе чати, такие как имя принте ра и количе ство копий.

9. Нажмите Print («Печать»).

Автоматическое сохранение файлов
Вы може те в любой момент вручную сохранить ф айлы *.notebook (см. Сохранение файлов

на странице  16), а также экспортировать их в различные ф орматы (см. Экспорт файлов на
странице  17). Вы также може те настроить программное обе спе че ние SMART Notebook на
автоматиче ское сохране ние ф айла при пе ре ходе к другой странице или по исте че нии
установле нного пе риода време ни.

NOTES

l ПО SMART Notebook не включае т вложения при экспортировании ф айлов в виде
изображе ний. Чтобы включить вложения, сле дуе т экспортировать ф айл как ве б -
страницу или PDF (Adobe Reader 6.0 и боле е поздне й ве рсии).

l Программное обе спе че ние SMART Notebook не экспортируе тф айлы, прикре пле нные
к ф айлу *.notebook в виде ярлыков. Чтобы вложить ф айл, прикре пите е го копию (см.

Вложение файлов и веб-страниц на странице  110).

l ПО SMART Notebook не экспортируе т не которые эфф е кты градие нтов, узоров и
изображе ний. Эти эфф е кты могут отображаться в экспортированном ф айле не ве рно
или в виде сплошной заливки.
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Автоматическое сохранениефайлов:

1. Выбе рите File &gt; Timed Saves («Файл» &gt; «Сохранения по времени»).

Появится окно Timed Save Wizard (Мастер планирования сохранений).

2. Выбе рите Every time I move to a different page («При каждом переходе на другую

страницу») , чтобы ф айл автоматиче ски сохранялся, когда вы выбирае те другую
страницу.

ИЛИ

Выбе рите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы ф айл сохранялся
че ре з указанные промежутки време ни.

3. Нажмите &quot;Далее&quot;.

4. Выбе рите Notebook Document («Документ Notebook»).

5. Нажмите &quot;Далее&quot;.

Появится диалоговое окно Save As («Сохранить как»).

6. Выбе рите папку для сохране ния нового ф айла .

7. Вве дите имя ф айла в поле File name (Имя файла). Программное обе спе че ние
SMART Notebook автоматиче ски сохранитф айл с расшире нием *.notebook.

8. Нажмите &quot;Сохранить&quot;.

Автоматическое сохранениефайла в формате веб-страниц:

1. Выбе рите File &gt; Timed Saves («Файл» &gt; «Сохранения по времени»).

Появится окно Timed Save Wizard (Мастер планирования сохранений).

2. Выбе рите Every time I move to a different page («При каждом переходе на другую

страницу») , чтобы ф айл автоматиче ски экспортировался, когда вы выводите на экран
другую страницу.

ИЛИ

Выбе рите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы ф айл
экспортировался че ре з указанные промежутки време ни.

3. Нажмите &quot;Далее&quot;.

4. Выбе рите Web Page (HTML) («Веб-страница (HTML)»).

5. Нажмите &quot;Далее&quot;.

Появится диалоговое окно Save As («Сохранить как»).

6. Выбе рите папку для экспорта ф айла .
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7. Вве дите имя ф айла в поле File name («Имя файла») .

8. Нажмите &quot;Сохранить&quot;.

Автоматическое сохранениефайла в файлы PDF:

1. Выбе рите File &gt; Timed Saves («Файл» &gt; «Сохранения по времени»).

Появится окно Timed Save Wizard (Мастер планирования сохранений).

2. Выбе рите Every time I move to a different page («При каждом переходе на другую

страницу») , чтобы ф айл автоматиче ски экспортировался, когда вы выводите на экран
другую страницу.

ИЛИ

Выбе рите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы ф айл
экспортировался че ре з указанные промежутки време ни.

3. Нажмите &quot;Далее&quot;.

4. Выбе рите PDF.

ИЛИ

Выбе рите Time Stamped PDFs («PDF с отметкой времени»), е сли вы хотите , чтобы имя
ф айла соде ржало время экспорта .

5. Нажмите &quot;Далее&quot;.

Появится диалоговое окно Save As («Сохранить как»).

6. Выбе рите папку для экспорта ф айла .

7. Вве дите имя ф айла в поле File name («Имя файла») .

8. Нажмите &quot;Сохранить&quot;.

Автоматическое сохранениефайла в формате изображения:

1. Выбе рите File &gt; Timed Saves («Файл» &gt; «Сохранения по времени»).

Появится окно Timed Save Wizard (Мастер планирования сохранений).

2. Выбе рите Every time I move to a different page («При каждом переходе на другую

страницу») , чтобы ф айл автоматиче ски экспортировался, когда вы выводите на экран
другую страницу.

ИЛИ

Выбе рите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы ф айл
экспортировался че ре з указанные промежутки време ни.
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3. Нажмите &quot;Далее&quot;.

4. Выбе рите Image Files («Файлы изображений»).

5. Нажмите &quot;Далее&quot;.

6. Нажмите Browse («Обзор»), найдите папку, в которую нужно экспортировать ф айлы и
нажмите Open («Открыть»).

7. Выбе рите тре буемый ф ормат изображе ния из выпадающе го списка Image Type (Тип

изображения).

8. Выбе рите разме р изображе ния из выпадающе го списка Size (Размер).

9. Нажмите OK.

Автоматическое сохранениефайла в файл PowerPoint:

1. Выбе рите File &gt; Timed Saves («Файл» &gt; «Сохранения по времени»).

Появится окно Timed Save Wizard (Мастер планирования сохранений).

2. Выбе рите Every time I move to a different page («При каждом переходе на другую

страницу») , чтобы ф айл автоматиче ски экспортировался, когда вы выводите на экран
другую страницу.

ИЛИ

Выбе рите «1 минута», «5 минут», «15 минут» или «30 минут» , чтобы ф айл
экспортировался че ре з указанные промежутки време ни.

3. Нажмите &quot;Далее&quot;.

4. Выбе рите PowerPoint.

5. Нажмите &quot;Далее&quot;.

Появится диалоговое окно Save As («Сохранить как»).

6. Выбе рите папку для экспорта ф айла .

7. Вве дите имя ф айла в поле File name («Имя файла») .

8. Нажмите &quot;Сохранить&quot;.

Отмена автоматического сохранения файла:

1. Выбе рите File &gt; Timed Saves («Файл» &gt; «Сохранения по времени»).

Появится окно Timed Save Wizard (Мастер планирования сохранений).
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2. Выбе рите Do not save the document automatically («Не сохранять документ

автоматически»).

3. Нажмите &quot;Далее&quot;.

Вложение файлов в сообщения электронной
почты
Вы може те отправить ф айл другому че лове ку, вложив ф айл или PDF-ве рсию ф айла в
сообщение эле ктронной почты.

Вложениефайла к сообщению электронной почты:

Выбе рите File &gt; Send To &gt; Mail Recipient («Файл» &gt; «Отправить» &gt;

«Отправить адресату»).

Запустится заданная по умолчанию программа эле ктронной почты, буде т создано новое
сообщение , и те кущий ф айл буде т вложен в это сообщение .

Если вы не сохранили ф айл, SMART Notebook сохранит е го как време нный ф айл с
име нем untitled.notebook , и ваша почтовая программа вложит этот време нный ф айл в
сообщение эле ктронной почты.

Вложениефайла в сообщение электронной почты в виде PDF:

Выбе рите пунктме ню File &gt; Send To &gt; Mail Recipient (as PDF) («Файл» &gt;

«Отправить» &gt; «Отправить адресату (как PDF)»).

Запустится заданная по умолчанию программа эле ктронной почты, буде т создано новое
сообщение , и PDF-ве рсия те куще го ф айла буде т вложена в это сообщение .

Если вы не сохранили ф айл, SMART Notebook сохранит е го как време нный PDF-ф айл с
име нем untitled.pdf , и ваша почтовая программа вложит этот време нный ф айл в
сообщение эле ктронной почты.
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Файл *.notebook состоит из набора страниц, каждая из которых соде ржит свои объе кты и
обладае т своими свойствами.

Эскиз каждой страницы отображае тся в сортировщике страниц. С помощью сортировщика
страниц или команд ме ню можно выве сти суще ствующую страницу на экран, создать пустую
страницу, добавить дубликат суще ствующей страницы или удалить страницу.

Отображение страниц в файле
Любую страницу в ф айле можно отобразить с помощью сортировщика страниц. Сле дующую
или пре дыдущую страницу ф айла можно отобразить с помощью кнопок или же стов.

Вывод страницы на экран

1. Если &quot;Сортировщик страниц&quot; не отображае тся, нажмите &quot;Сортировщик

страниц&quot; .

2. Выде лите эскиз страницы, которую вы хотите отобразить .

Вывод следующей страницы файла

Нажмите Next Page («Следующая страница») .

ИЛИ

Сове ршите быстрое движение пальцем по странице справа нале во .
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Появится сообщение с номе ром те кущей страницы.

Вывод предыдущей страницы файла

Нажмите Previous Page («Предыдущая страница») .

ИЛИ

Сове ршите быстрое движение пальцем по странице сле ва направо .

Появится сообщение с номе ром те кущей страницы.

Создание страниц
Воткрытый ф айл можно добавить пустую новую страницу с помощью кнопки Add Page

(«Добавить страницу») или сортировщика страниц.
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Добавление страницы с помощью кнопки Add Page («Добавить страницу»)

Нажмите кнопку Add Page («Добавить страницу») .

После те кущей страницы появится новая страница .

Вставка страницы с помощью сортировщика страниц

1. Если &quot;Сортировщик страниц&quot; не отображае тся, нажмите &quot;Сортировщик

страниц&quot; .

2. Выде лите эскиз той страницы, посл которой тре буе тся вставить новую страницу.

3. Нажмите на стре лку ме ню этого эскиза и выбе рите пункт Insert Blank Page («Вставить

пустую страницу»).

После выбранной страницы появится новая страница .

Клонирование страниц
Вкаче стве альте рнативы созданию пустой страницы, вы може те создать копию (клон)
суще ствующей страницы.

NOTE

Вы може те клонировать страницу, только е сли на не й что -нибудь соде ржится.

Клонирование страницы:

1. Если &quot;Сортировщик страниц&quot; не отображае тся, нажмите &quot;Сортировщик

страниц&quot; .

2. Выде лите эскиз страницы, которую тре буе тся клонировать .

3. Нажмите на стре лку ме ню этого эскиза и выбе рите Clone Page («Клонировать

страницу»).

Клонированная страница появится не посре дстве нно после те кущей страницы.

NOTE

Данную опе рацию можно повторять нужное количе ство раз .
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Увеличение пространства страниц
Если вам тре буе тся больше ме ста в нижне й части страницы, вы може те уве личить страницу
по ве ртикали, не затрагивая е е ширину. Эту ф ункцию можно отключить , чтобы исключить
уве личе ние высоты страниц.

Увеличение пространства страницы

1. Если страница отображае тся в режиме "Вся страница", выбе рите другой урове нь
уве личе ния для страницы.

2. Нажмите Extend Page («Растянуть страницу») в нижне й части страницы.

Включение и выключение функции «Растянуть страницу»

1. Выбе рите View &gt; Extend Page («Вид» &gt; «Растянуть страницу»).

2. Выбе рите Off («Отключить») , чтобы отключить ф ункцию Extend Page

(«Растянуть страницу»).

ИЛИ

Выбе рите On («Включить») , чтобы включить ф ункцию Extend Page

(«Растянуть страницу».

Переименование страниц
При создании страницы ПО SMART Notebook автоматиче ски присваивае т е й имя с указанием
даты и време ни создания. Это имя можно изме нить .

Переименование страницы:

1. Если &quot;Сортировщик страниц&quot; не отображае тся, нажмите &quot;Сортировщик

страниц&quot; .

2. Дважды нажмите имя страницы.

3. Вве дите новое имя страницы.

4. Нажмите в любом ме сте экрана .
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Вырезание , копирование и вставка страниц
Тепе рь вы може те выре зать , копировать и вставлять страницы из те куще го ф айла с
помощью сортировщика страниц.

Вырезание, копирование или вставка страницы с помощью сортировщика страниц

1. Если &quot;Сортировщик страниц&quot; не отображае тся, нажмите &quot;Сортировщик

страниц&quot; .

2. Выде лите эскиз страницы, которую тре буе тся выре зать .

3. Нажмите на стре лку ме ню этого эскиза и выбе рите вариант&quot;Вырезать

страницу&quot; или &quot;Копировать страницу&quot; .

4. Выде лите эскиз страницы, которая должна сле довать за вставляемой странице й.

5. Нажмите на стре лку ме ню этого эскиза и выбе рите &quot;Вставить страницу&quot;.

Новый эскиз появится пе ре д эскизом, выбранном на пре дыдущем этапе .

TIP

Также можно копировать и вставлять страницы из других ф айлов ПО SMART Notebook.

Изменение порядка страниц
При же лании вы може те изме нить порядок страниц в ф айле .

Изменение порядка страниц:

1. Если &quot;Сортировщик страниц&quot; не отображае тся, нажмите &quot;Сортировщик

страниц&quot; .

2. Выде лите эскиз страницы, которую вы хотите пе реме стить в пре де лах ф айла .

Вокруг эскиза появится синяя рамка .

3. Пере тащите эскиз в новое ме сто в сортировщике страниц.

Синяя линия показывае т новое положение страницы.

4. Отпустите эскиз .
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Удаление страниц
Вы може те удалить страницу из те куще го ф айла с помощью кнопки Delete Page («Удалить

страницу») или сортировщика страниц.

TIP

Вме сто удале ния страницы можно просто удалить с не е все объе кты (см. Очистка страниц

на странице  224).

Удаления страницы с помощью кнопки Delete Page («Удалить страницу»)

1. Если этого не было сде лано ране е , выве дите на экран страницу, которую вы хотите
удалить .

2. Выбе рите Delete Page («Удалить страницу») .

Удаление страницы с помощью сортировщика страниц

1. Если &quot;Сортировщик страниц&quot; не отображае тся, нажмите &quot;Сортировщик

страниц&quot; .

2. Выде лите эскиз страницы, которую тре буе тся удалить .

3. Нажмите на стре лку ме ню этого эскиза и выбе рите Delete Page («Удалить страницу»).
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Объе кты являются строите льными блоками соде ржимого ф айлов *.notebook. Объе кт— это
просто элеме нт на странице , который вы создае те или импортируе те для дальне йшей работы
с ним. Основные типы объе ктов включают:

l Циф ровые че рнила (написанное и нарисованное от руки)

l Фигуры

l Прямые линии

l Дуги

l Те кст

l Таблицы

Написание , рисование и стирание цифровых
чернил
Циф ровые че рнила — те кст или объе кты, нарисованные от руки с помощью пе ра или пе рье в
инте рактивного экрана , или с помощью пе ра ПО SMART Notebook. Написание или рисование
с помощью циф ровых че рнил позволяе т быстро добавлять мате риал в ф айлы
SMART Notebook при создании ф айлов или во время пре дставле ния ф айлов учащимся.

Вы може те стирать надписи или рисунки, сде ланные циф ровыми че рнилами.

Написание или рисование цифровыми чернилами
Перья инте рактивного экрана — самый простой способ писать или рисовать циф ровыми
че рнилами.
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Вы также може те создавать рукописные объе кты с помощью инструме нта "Перо".
Инструме нт "Перо" позволяе т писать или рисовать циф ровыми че рнилами с помощью
сле дующих типов пе ра .

Тип пера Цель и пример Примечания

Стандартное
пе ро

Пишите или рисуйте циф ровыми
че рнилами разных цве тов и типов линий.

С помощью пе ра типа
«Стандартное » можно
писать или рисовать
циф ровыми че рнилами,
исче зающими че ре з
не сколько се кунд (см.
разде л Использование
инструмента Standard pen
(Стандартное перо) для
создания исчезающих
объектов на странице  198).

Каллиграф иче ское
пе ро

Пишите или рисуйте циф ровыми
че рнилами тем же способом, что и
пе ром "Стандартное ", но толщина линии
може т изме няться.

Перо типа
"Каллиграф иче ское "
удобно для обуче ния
учащихся письму.

Мелок Пишите или рисуйте циф ровыми
че рнилами с эфф е ктом ме лка .

Тип пе ра "Мелок"
пре дназначе н не столько
для письма , сколько для
творче ской работы,
наприме р живописи и
раскрашивания
изображе ний.

Выде ле ние Выде ляйте те кст и другие объе кты.

Те кстовое

пе ро

Сде ланные вами записи будут
автоматиче ски пре образовываться в
те кст с возможностью ре дактирования.

Вы сможе те ре дактировать
те кст во время работы бе з
помощи клавиатуры (см.
разде л Использование
инструмента Text Pen
(Текстовое перо) на
странице  192).
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Тип пера Цель и пример Примечания

Художе стве нное
пе ро

Добавляйте цве тные элеме нты в ваши
пре зе нтации.

Можно создавать
пользовате льские стили
художе стве нного пе ра (см.
разде л Создание
пользовательских стилей
художественного пера на
странице  120).

Кисть Пишите или рисуйте циф ровыми
че рнилами с эфф е ктом кисти.

Тип пе ра "Кисть"
пре дназначе н не столько
для письма , сколько для
творче ской работы,

наприме р живописи и
раскрашивания
изображе ний.

Волшебное
пе ро

Пишите или рисуйте циф ровыми
че рнилами, исче зающими че ре з
не сколько се кунд.

Волшебное пе ро также
можно использовать для
открытия окна уве личе ния
или окна подсве тки (см.
разде л Работа с
инструментом Magic Pen
(Волшебное перо) на
странице  191).

Распознавание
ф игур

Рисуйте различные ф игуры с помощью
циф ровых че рнил.

Вы може те рисовать круги,
овалы, квадраты,
прямоугольники,
тре угольники и дуги (см.
разде л Создание фигур с
помощью инструмента
Shape Recognition Pen
(Перо распознавания
фигур) на странице  40).

Написание или рисование цифровыми чернилами:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите тип пе ра .

3. Выбе рите тип линии.
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4. По же ланию можно настроить тип линии с помощью пе ре ключате ле й свойств.

NOTE

Настроить тип линии или дуги можно с помощью вкладки Properties («Свойства») (см.

Изменение свойств объектов на странице  66).

5. Пишите или рисуйте на странице циф ровыми че рнилами.

TIPS

o Во время письма или рисования не облокачивайте сь на пове рхность
инте рактивного продукта и не кладите на не го ладонь .

o Если вы пише те или рисуе те не сколько линий, ПО SMART Notebook

автоматиче ски объе диняе т линии в один объе кт. Наприме р , е сли вы пише те буквы
слова , SMART Notebook объе диняе т отде льные буквы, позволяя вам работать с
це лым словом. Если вы хотите писать слова на одной строке , но не хотите ,чтобы
они объе динялись , оставляйте между ними большой инте рвал, используйте
разные пе рья или не надолго положите пе ро в лоток пе ре д написанием другого
слова (только для инте рактивных досок).

o Если вы хотите писать по диагонали, нарисуйте прямую линию, а потом пове рните
е е (см. разде л Поворот объектов на странице  82).

o Если вы хотите писать мале нькими буквами, напишите большими, а з атем
уме ньшите их разме р (см. разде л Изменение размеров объектов на
странице  80).

o Можно использовать з аливку для все х областе й, ограниче нных циф ровыми
че рнилами (см. разде л Заливка рисунков, выполненных цифровыми чернилами

на странице  69).
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Стирание цифровых чернил
Циф ровые че рнила можно стирать с инте рактивного диспле я с помощью ластика или же ста
стирания. Если циф ровые че рнила стираются со страницы ф айла *.notebook, тогда объе кты
можно стирать с помощью инструме нта Eraser (Ластик).

NOTE

Можно стирать циф ровые че рнила , но не объе кты других типов, включая ф игуры, линии,
те кст и изображе ния. Чтобы убрать такие объе кты, их сле дуе т удалить (см. Удаление

объектов на странице  86).

Стирание цифровых чернил

1. Нажмите инструме нтEraser («Ластик») , а з атем выбе рите тип ластика .

2. Сотрите циф ровые че рнила .

Создание фигур и линий
Фигуры и линии можно создавать не только рукописным способом циф ровыми че рнилами,
но и с помощью спе циальных инструме нтов в SMART Notebook.

NOTE

Чтобы убрать ф игуру или линию со страницы, е е не обходимо удалить (см. Удаление

объектов на странице  86). Инструме нт&quot;Ластик&quot; не удаляе тф игуры.

Создание фигур с помощью инструмента «Фигуры»
С помощью инструме нта "Фигуры" можно создавать разнообразные ф игуры, в том числе
круги, квадраты и тре угольники, другие ге оме триче ские ф игуры, се рдце образные ф игуры,

галочки, кре стики, и т.п.

Вы може те добавить ф игуру на страницу, а з атем отре дактировать е е свойства . И, наоборот,
вы може те настроить цве т контура ф игуры, цве т заливки, толщину линий, а з атем добавить
ф игуру на страницу.
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Чтобы создатьфигуру, выполните следующие действия:

1. Нажмите Shapes («Фигуры») .

Появляе тся кнопка инструме нта "Фигуры".

2. Выбе рите ф игуру на пане ли инструме нтов.

ИЛИ

Нажмите , з атем выбе рите ф игуру.

3. По же ланию можно настроить ф игуру с помощью пе ре ключате ле й свойств.

NOTE

Настроить тип ф игуры можно с помощью вкладки Properties («Свойства») (см.

Изменение свойств объектов на странице  66).

4. Создайте ф игуру, нажав на то ме сто , куда вы хотите е е поме стить , и тащите е е границу,
пока ф игура не приобре те т нужный разме р .

TIPS

o Вы може те создавать правильные круги, квадраты, тре угольники и другие
ф игуры, уде рживая нажатой клавишу SHIFT во время рисования.

o Вы може те выбирать ф игуры, когда активе н инструме нтShapes («Фигуры») ,

не пе ре ключаясь на инструме нтSelect («Выбор») . Нажмите один раз на
ф игуру, после че го вокруг не е появится рамка выде ле ния.

Создание фигур с помощью инструмента Regular Polygons
(Правильные многоугольники)
Помимо создания ф игур с помощью инструме нта "Фигуры", можно также создавать
правильные многоугольники с количе ством сторон от3 до 15 с помощью инструме нта
"Правильные многоугольники".



CHAPTER4
СОЗДАНИЕ ОСНОВНЫХ ОБЪЕКТОВ

40

Созданиефигур с помощью инструмента «Правильные многоугольники»:

1. Нажмите Regular Polygons («Правильные многоугольники») .

Появляе тся кнопка инструме нта "Правильные многоугольники".

2. Выбе рите ф игуру на пане ли инструме нтов.

ИЛИ

Нажмите , з атем выбе рите ф игуру.

NOTE

Число на ф игуре указывае т на количе ство е е сторон.

3. По же ланию можно настроить ф игуру с помощью пе ре ключате ле й свойств.

NOTE

Настроить тип ф игуры можно с помощью вкладки Properties («Свойства») (см.

Изменение свойств объектов на странице  66).

4. Создайте ф игуру, нажав на то ме сто , куда вы хотите е е поме стить , и тащите е е границу,
пока ф игура не приобре те т нужный разме р .

Создание фигур с помощью инструмента Shape Recognition Pen
(Перо распознавания фигур )
Вы може те использовать инструме нт "Перо распознавания ф игур" для рисования таких
ф игур , как круги, овалы, квадраты, прямоугольники, тре угольники и дуги.

NOTE

Фигуры можно также рисовать с помощью инструме нта «Фигуры» (см. Создание фигур с

помощью инструмента «Фигуры» на странице  38) или инструме нта «Правильные
многоугольники» (см. Создание фигур с помощью инструмента Regular Polygons

(Правильные многоугольники) на пре дыдущей странице ).
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Рисованиефигуры:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Shape Recognition Pen («Перо

распознавания фигур»).

3. Нарисуйте ф игуру на странице .

Если ПО SMART Notebook распознае т ваш рисунок как круг, овал, квадрат,
прямоугольник, тре угольник или дугу, эта ф игура буде т добавле на на страницу.

Создание прямых линий и дуг
Для рисования прямых линий и дуг можно использовать инструме нт "Линии".

Вы може те добавить линию на страницу, а з атем отре дактировать е е свойства . Или можно
настроить линию и добавить е е на страницу.

Чтобы нарисовать прямую линию или дугу, выполните следующие действия:

1. Нажмите кнопку Lines («Линии») .

Появляе тся кнопка инструме нта "Линии".

2. Выбе рите тип линии или дуги.



CHAPTER4
СОЗДАНИЕ ОСНОВНЫХ ОБЪЕКТОВ

42

3. По же ланию можно настроить тип линии или дуги с помощью пе ре ключате ле й свойств.

NOTE

Настроить тип линии или дуги можно с помощью вкладки Properties («Свойства») (см.

Изменение свойств объектов на странице  66).

4. Для создания линии нажмите в ме сте , где должна начинаться линия, и тащите е е в ме сто ,
где она должна заканчиваться.

Создание текста
Вводить те кст в SMART Notebook можно любым из сле дующих способов:

l С клавиатуры компьюте ра

l Ввод те кста с клавиатуры SMART

l Написание те кста от руки (см. разде л Написание, рисование и стирание цифровых

чернил на странице  34) и пре образование е го в пе чатный те кст с помощью ф ункции
распознавания рукописного те кста

После ввода те кста е го можно ре дактировать , прове рять орф ограф ию и изме нять е го
свойства , включая стиль , разме р и цве тшриф та .

Ввод те кста
Можно вводить новый те кст или ре дактировать суще ствующий.

Ввод нового текста:

1. Если клавиатура не доступна , нажмите на значок SMART Board в области
уве домле ний, а з атем выбе рите Keyboard («Клавиатура»).

2. Нажмите инструме нтText («Текст») , а з атем выбе рите доступный тип шриф та .

3. При же лании можно настраивать тип шриф та (см. разде л Форматирование текста на
странице  44).

4. Нажмите в ме сте , где должен начинаться те кст.

5. Вве дите те кст.

6. По заве ршении нажмите за пре де лами те кстового объе кта .
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Изменение существующего текста:

1. Дважды нажмите те кстовый объе кт.

2. Отре дактируйте те кст.

3. По заве ршении нажмите за пре де лами те кстового объе кта .

Преобраз ование рукописного те кста в пе чатный
Вы може те писать на экране инте рактивного продукта с помощью инструме нта "Стандартное
пе ро" или "Каллиграф иче ское пе ро" и пре образовывать написанное в пе чатный те кст.
SMART Notebook може т пре образовывать рукописный те кст на не скольких языках.

Преобразование рукописного текста в печатный:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Pen («Перо») или Calligraphic Pen

(«Каллиграфическое перо»).

3. Напишите те кст.

TIP

Пишите аккуратно , пе чатными буквами, по горизонтальной линии. Хотя SMART

Notebook може т пре образовывать написанный наклонно или письме нными буквами
те кст, это не все гда получае тся должным образом.

4. Выде лите те кстовый объе кт.

Функция распознавания рукописного те кста SMART Notebook сравнивае т написанное
вами слово со своим словарем и иде нтиф ицируе т слова , наиболе е похожие на
написанное .
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5. Нажмите на стре лку ме ню те кстового объе кта .

Появится ме ню и список совпадающих слов, пе ре д каждым из которых буде т пункт
Recognize («Распознать»).

NOTES

o Если вы хотите , чтобы SMART Notebook распознавал слова на другом языке ,
выбе рите Recognize Languages («Распознавать языки») и выбе рите другой язык
из списка . SMART Notebook обновит список совпадающих слов, включив в не го
слова на выбранном языке .

o Если вы меняе те язык распознавания рукописного те кста , вы не ме няе те
з аданный по умолчанию язык пользовате льского инте рф е йса SMART Notebook

или вашей опе рационной системы.

6. Выбе рите слово из списка совпадающих слов.

Выбранное слово появится на странице .

Форматирование те кста
Если хотите отф орматировать ве сь те кст в те кстовом объе кте , выде лите этот те кстовый
объе кт.

ИЛИ

Если вы хотите отф орматировать только часть те кста в те кстовом объе кте , дважды нажмите
те кстовый объе кт, з атем выде лите нужную часть те кста .

Для ф орматирования те кста можно использовать кнопки на пане ли инструме нтов,
параме тры на вкладке "Свойства" и меню "Формат".

NOTE

Если вкладка Properties («Свойства») не отображае тся, нажмите Properties («Свойства») ,

з атем выбе рите Text Style («Стиль текста»).

Всле дующей таблице описаны изме не ния в ф орматировании, которые можно вне сти с
помощью упомянутых выше инструме нтов.

Заменить Панель
инструментов

Вкладка
"Свойства"

Меню
"Формат"

Символ, абзац или объект

Измене ние шриф та
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Заменить Панель
инструментов

Вкладка
"Свойства"

Меню
"Формат"

Изменить разме р шриф та

TIP

Для выбора разме ра шриф та , который не
пре дставле н в раскрывающемся списке ,
(включая дробные значе ния, такие как 20,5)
вве дите этот разме р в поле Font Size
(«Размер шрифта») на пане ли инструме нтов.

Измене ние цве та

Полужирное наче ртание , курсив или
подче ркивание

Заче ркивать те кст 1

Подстрочные и надстрочные инде ксы 2

Абзац или объект

Измене ние выравнивания (по ле вому краю, по
правому краю или по це нтру)

Измене ние отступа 3

Создание маркированных или нуме рованных
списков

4

Вставка буквицы

TIP

Для вставки буквицы в начале абзаца
нажмите кнопку Drop Cap («Буквица») на

вкладке Properties («Свойства») окна Text
Style («Стиль текста»).

ИЛИ

Выбе рите Format &gt; Paragraph &gt; Drop
Cap («Формат» &gt; «Абзац» &gt; «Буквица».

1Впункте More TextOptions («Другие параметры текста»)

2Впункте More TextOptions («Другие параметры текста»)

3Впункте More TextOptions («Другие параметры текста»)

4Впункте More TextOptions («Другие параметры текста»)
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Заменить Панель
инструментов

Вкладка
"Свойства"

Меню
"Формат"

Измене ние межстрочного инте рвала

TIP

Для уве личе ния инте рвала между абзацами
установите ф лажок Add space after
paragraphs («Добавить пробел после
абзацев») на вкладке Properties («Свойства»)
или выбе рите Format &gt; Paragraph &gt; Line
Spacing &gt; Add space after paragraphs
(«Формат» &gt; «Абзац» &gt; «Межстрочный
интервал» &gt; «Добавить пробел после
абзацев»).

Измене ние направле ния письма (сле ва направо
или справа нале во )

NOTE

Выбе рите Format &gt; Paragraph &gt;
Direction &gt; Left to Right («Формат» &gt;
«Абзац» &gt; «Направление» &gt; «Слева
направо») для языков с письмом сле ва
направо (наприме р , английского или
ф ранцузского ).

ИЛИ

Выбе рите Format &gt; Paragraph &gt;
Direction &gt; Right to Left («Формат» &gt;
«Абзац» &gt; «Направление» &gt; «Справа
налево») для языков с письмом справа
нале во (наприме р , арабского или иврита ).

Объект

Измене ние направле ния те кста
(горизонтальное или ве ртикальное )

5

Измене ние прозрачности

5Впункте More TextOptions («Другие параметры текста»)
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Изменение размеров те кстовых объе ктов
Измене ние те кстового объе кта в соотве тствии с проце дурой, описанной в разде ле
Изменение размеров объектов на странице  80, приводит к изме не нию разме ра те кста этого
объе кта .

Если хотите изме нить разме р те кстового объе кта , не изме няя разме р те кста этого объе кта ,
выполните сле дующую проце дуру.

Для изменения размера текстового объекта

1. Дважды нажмите те кстовый объе кт.

2. Нажмите один из бе лых кружков, расположенных по бокам те кстового объе кта , з атем
пе ре тащите е го , чтобы уве личить или уме ньшить разме р объе кта .

Вставка математиче ских символов
Можно вставлять на страницу различные математиче ские и научные символы.

NOTE

Математиче ские обозначе ния пре дставляют собой только символы. Они не выполняют
математиче ских опе раций.

Вставка математического символа

1. Вве дите те кст на странице .

2. Нажмите More Text Options («Другие параметры текста») , з атем выбе рите Insert

Symbol («Вставка символа») .

Появится диалоговое окно Insert Symbols («Вставить символы»).

3. Нажмите на кате горию.

Появится список символов.

4. Нажмите на символ, который вам нужно добавить в те кст.

5. Нажмите Insert («Вставить»).

Символ появится в те кстовом объе кте .
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Проверка правописания в те кстовых объе ктах
Во время ввода те кста SMART Notebook прове ряе т правописание . Если слово вве де но
не правильно , ПО SMART Notebook подче ркивае т е го красной линие й.Можно щелкнуть по
слову правой кнопкой мыши и выбрать правильный вариант из пре длагаемого списка .

При же лании можно отключить эту ф ункцию и прове рять правописание с помощью
диалогового окна Spelling Check (Проверка правописания).

Отключение автоматической проверки правописания:

1. Нажмите Text («Текст») .

2. Нажмите More Text Options («Другие параметры текста») , з атем выбе рите Check

Spelling («Проверка правописания») .

Ручная проверка правописания текстового объекта:

1. Выде лите те кстовый объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите пунктCheck Spelling («Проверка

правописания»).

При обнаружении не ве рно написанного слова в ПО SMART Notebook появляе тся
диалоговое окно Spelling Check (Проверка правописания). Вэтом диалоговом окне
отображае тся не ве рно написанное слово и пре длагаются альте рнативные варианты е го
написания.
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3. Для каждого не правильно написанного слова выполните одно из сле дующих де йствий:

o Нажмите Ignore Once («Пропустить») , чтобы сохранить написание слова для

текущего случая.

o Нажмите Ignore All («Пропустить все»), чтобы сохранить написание слова для

всех случаев.

o Нажмите Add to Dictionary («Добавить в словарь»), чтобы сохранить текущее

написание слова для всех случаев в данном файле и добавить это написание в

словарь.

o Чтобы изме нить написание слова для данного случая, выбе рите ве рный вариант из
списка Suggestions («Рекомендации») и нажмите Change («Изменить»).

o Чтобы изме нить написание слова для все х случае в, выбе рите ве рный вариант из
списка Suggestions («Рекомендации») и нажмите Change All («Изменить все»).

NOTE

Если вы по ошибке нажали не правильную кнопку, нажмите Undo («Отменить») , чтобы
отме нить выполне нное изме не ние .

После выполне ния этого шага для каждого не правильно написанного слова появится
диалоговое окно с вопросом, нужно ли прове рять правописание в оставшейся части
ф айла .

4. Нажмите Yes («Да») , чтобы прове рить правописание в оставшейся части ф айла .

ИЛИ

Нажмите No («Нет») , чтобы закрыть диалоговое окно Spelling Check («Правописание»)

бе з прове рки оставшейся части ф айла .

Выре з ание и вставка те кста
Можно выре зать , копировать и вставлять те кст точно так же , как и любые другие объе кты
(см. Вырезание, копирование и вставка объектов на странице  76). Также можно выре зать и
вставлять те кст в те кстовых объе ктах.

Вырезание и вставка текста в другое место на той же странице

1. Дважды нажмите те кстовый объе кт.

2. Выде лите те кст, который тре буе тся выре зать .

3. Пере тащите выде ле нный те кст в другое ме сто на той же странице .
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Вырезание и вставка текста на другую страницу

1. Если вкладка сортировщика страниц не отображае тся, нажмите Page Sorter

(«Сортировщик страниц») .

2. Дважды нажмите те кстовый объе кт.

3. Выде лите те кст, который тре буе тся скопировать .

4. Пере тащите выде ле нный те кст на значок другой страницы на вкладке сортировщика
страниц.

Создание таблиц
Вы може те создавать таблицы в ПО SMART Notebook или вставлять их из других программ.

После создания таблицы можно добавлять в е е яче йки объе кты.

Чтобы настроить таблицу, можно выде лить таблицу, столбе ц, строку, яче йку или набор яче е к,
а з атем:

l Переме стить таблицу

l Изменить тип линий, з аливку или свойства те кста

l Изменить разме р таблицы, столбца или строки

l Вставить и удалить столбцы, строки и яче йки

l Разбить или объе динить яче йки

l Удалить таблицу

Создание таблиц

Добавление таблицы с помощью кнопки Table («Таблица»):

1. Нажмите Table («Таблица») .

Появится се тка .
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2. Перемещая указате ль по се тке , выбе рите нужное количе ство столбцов и строк
таблицы.

NOTE

Ячейки се тки соотве тствуют яче йкам создаваемой таблицы.

TIP

По умолчанию в се тке отображае тся восемь столбцов и восемь строк.Можно
добавить строки, пе ремещая указате ль ниже после дне й строки. Таким же образом
можно добавлять столбцы, пе ремещая указате ль дале е правого столбца .

Если вы используе те мышь , нажмите и уде рживайте нажатой ле вую кнопку мыши,
пе ремещая при этом указате ль .

3. Нажмите на экране или ще лкните мышкой.

На странице появится таблица .

Добавление таблицы с помощью диалога Insert Table («Вставить таблицу»):

1. Выбе рите Insert &gt; Table («Вставка» &gt; «Таблица»).

Появится диалоговое окно Insert Table (Вставить таблицу).

2. Вве дите число столбцов и строк в соотве тствующие поля.

3. Или выбе рите Make cells square («Сделать ячейки квадратными») , чтобы сде лать
яче йки квадратными.

4. Или выбе рите Remember dimensions for new tables («Запомнить размеры для новых

таблиц») , чтобы использовать разме ры те кущей таблицы для сле дующих таблиц,
создаваемых в ПО SMART Notebook.

5. Нажмите OK.

На странице появится таблица .

Рисование таблицы:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Pen («Перо») или Calligraphic Pen

(«Каллиграфическое перо»).

3. Выбе рите тип линии.



CHAPTER4
СОЗДАНИЕ ОСНОВНЫХ ОБЪЕКТОВ

52

4. Нарисуйте таблицу на экране .

TIP

Делайте линии таблицы максимально прямыми и сое диняйте углы.

5. Нажмите Select («Выбор») .

6. Выде лите ваш рисунок.

7. Нажмите на стре лку ме ню таблицы и выбе рите Recognize Table («Распознать таблицу»).

Если SMART Notebook распознае т ваш рисунок как таблицу, ваш рисунок буде т убран, а
на страницу буде т добавле на таблица .

Вставка таблиц из других программ
Можно выре зать или скопировать таблицу из Word или PowerPoint и вставить е е в ф айл
*.notebook.Формат и структура таблицы могут быть иными, чем в ф айле *.notebook.

Если вы хотите выре зать или скопировать не сколько таблиц, вы должны копировать или
выре зать их по одной.

NOTE

Можно также выре зать или скопировать таблицу из ф айла *.notebook и вставить е е в Word

или PowerPoint. Однако ф ормат и структура таблицы могут быть иными, чем в Word или
PowerPoint.

При добавле нии таблицы в ф айл PowerPoint, в котором е сть яче йки и не те кстовые
объе кты, не те кстовые объе кты будут находиться за пре де лами таблицы в PowerPoint.

Добавление объе ктов в таблицы
После добавле ния таблицы на страницу вы може те вставлять объе кты в яче йки таблицы.

NOTE

Вкаждую яче йку вы може те добавить только один объе кт. Если не обходимо добавить
не сколько объе ктов в яче йку, выполните сле дующе е :

l Сгруппируйте объе кты пе ре д добавле нием в таблицу (см. Группировка объектов на
странице  84).

l Выде лите все объе кты, з атем добавьте их в таблицу как описано ниже . SMART

Notebook автоматиче ски группируе т объе кты в яче йке таблицы.
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Добавление объекта в таблицу

1. Выбе рите объе кт.

2. Пере тащите объе кт в яче йку таблицы.

NOTE

Нельзя пе ре таскивать объе кт, е сли он заблокирован на ме сте (см.

LockingObjects.htm).

Объе кт появится в яче йке таблицы.

NOTE

Если вы добавляе те те кстовый объе кт в таблицу, разме р яче йки изме няе тся в
соотве тствии с разме рами те кстового объе кта . Если вы добавляе те в таблицу объе кты
других типов, разме ры объе кта изме няются в соотве тствии с разме рами яче йки.

Удаление объекта из таблицы

1. Выбе рите объе кт.

2. Пере тащите объе кт за пре де лы таблицы.

Выделение таблиц, столбцов, строк и яче е к
Вы може те выде лить таблицу, столбе ц, строку, яче йку или группу яче е к. После того , как вы
выде лите таблицу или часть таблицы, вы сможе те :

l Переме стить таблицу

l Изменить свойства таблицы или е е яче е к

l Изменить разме ры таблиц, столбцов и строк

l Добавить или удалить столбцы, строки или яче йки

l Разбить или объе динить яче йки

l Удалить таблицу
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Выделение таблицы:

1. Нажмите Select («Выбор») .

2. Нажмите за пре де лами яче йки, но вблизи е е угла , и тащите рамку в сторону
противоположного угла .

NOTE

Не начинайте пе ре таскивать границу из области таблицы. Вэтом случае буде т
выде ле на яче йка таблицы, а не сама таблица .

Выделение столбца:

1. Нажмите Select («Выбор») .

2. Нажмите внутри ве рхне й яче йки столбца и тащите рамку к нижне й яче йке .

Выделение строки:

1. Нажмите Select («Выбор») .

2. Нажмите внутри самой ле вой яче йки строки и тащите рамку к правой яче йке .

Выделение ячейки:

1. Нажмите Select («Выбор») .

2. Нажмите внутри яче йки.

Выделение нескольких ячеек:

1. Нажмите Select («Выбор») .

2. Нажмите внутри ве рхне й ле вой яче йки столбца и тащите рамку к нижне й правой яче йке .

NOTE

Если выде лить не сколько яче е к и пе ре тащить их в другое ме сто страницы, буде т
создана новая таблица , состоящая из выбранных яче е к и их соде ржимого .
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Перемещение таблиц
После создания таблицы е е можно пе ремещать по странице .

Перемещение таблицы:

Выде лите таблицу и пе ре тащите е е в другое ме сто на странице .

ИЛИ

Выде лите все яче йки таблицы и пе ре тащите яче йки в другое ме сто на странице .

Изменение свойств таблицы
Вы може те использовать вкладку "Свойства" для изме не ния свойств таблицы, включая
прозрачность , цве т яче е к и цве т линий.

Изменение заливки таблицы:

1. Выде лите таблицу, столбе ц, строку, яче йку или диапазон яче е к.

2. Нажмите стре лку ме ню таблицы, столбца , строки или яче йки и выбе рите Properties

(«Свойства»).
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3. Нажмите кнопку &quot;Эффекты заливки&quot;.
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4. Выбе рите тип заливки

Тип заливки Порядок действий

Бе з з аливки
(прозрачный)

Выбе рите No fill («Без заливки»).

Сплошная заливка a. Выбе рите Solid fill («Сплошная заливка»).

b. Выбе рите один из сле дующих вариантов:
o Выбе рите один из 40 цве тов палитры.

o Нажмите More («Еще»)и выбе рите тре буемый цве т в
диалоговом окне .

o Нажмите пипе тку и выбе рите цве т на экране .

Градие нт из двух
цве тов

a. Выбе рите Gradient fill («Градиентная заливка»).

b. Для каждого цве та выполните одно из сле дующих де йствий:
o Выбе рите один из 40 цве тов палитры.

o Нажмите More («Еще»)и выбе рите тре буемый цве т в
диалоговом окне .

o Нажмите пипе тку и выбе рите цве т на экране .
c. Выбе рите нужный параме тр из выпадающе го списка Style

(Стиль).

Заливка узором a. Выбе рите Pattern fill («Заливка по шаблону»).

b. Выбе рите узор .
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Тип заливки Порядок действий

Рисунок a. Выбе рите Image fill («Заливка изображением»).

b. Нажмите &quot;Обзор&quot;.

c. Найдите и выде лите изображе ние , которое вы хотите
использовать в каче стве ф она , и нажмите Open
(«Открыть»).

NOTE

При вставке большого изображе ния може т открыться
диалоговое окно с пре дложением уменьшить разме р
ф айла изображе ния либо оставить е го бе з изме не ний.
Дополните льную инф ормацию см. в разде ле Настройка
параметров оптимизации изображения на странице  237.

d. Выбе рите Keep image size («Сохранить размер
изображения») , чтобы сохранить разме р изображе ния,
не зависимо от того , больше изображе ние , чем объе кт, или
ме ньше .
ИЛИ
Выбе рите Scale image to fit («Масштабировать
изображение по размеру») , чтобы изме нить разме р
изображе ния до разме ра объе кта .

5. Можно также пе ре тащить ползунок Object transparency («Прозрачность объекта»)

вправо , чтобы сде лать таблицу прозрачной.

Изменение типа линий таблицы:

1. Выде лите таблицу.

NOTE

Можно изме нить тип линии только все й таблицы, но не отде льных яче е к, столбцов или
строк.

2. Нажмите стре лку ме ню таблицы, столбца , строки или яче йки и выбе рите Properties

(«Свойства»).

3. Выбе рите &quot;Тип линии&quot;.

4. Измените тип линий таблицы.
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Изменение стиля текста таблицы:

1. Выде лите таблицу, столбе ц, строку, яче йку или набор яче е к.

2. Нажмите стре лку ме ню таблицы, столбца , строки или яче йки и выбе рите Properties

(«Свойства»).

3. Нажмите Text Style («Стиль текста»).

4. Измените стиль те кста таблицы (см. Форматирование текста на странице  44).

Изменение размеров таблиц, столбцов или строк
Если вам нужно настроить таблицу, вы може те изме нить разме р таблицы, столбцов или строк.

Изменение размера таблицы:

1. Выбе рите таблицу.

2. Нажмите ручку изме не ния разме ра (се рый кружок) таблицы, и тащите е е , чтобы
уве личить или уме ньшить разме р таблицы.

Изменение размера столбца:

1. Нажмите Select («Выбор») .

2. Нажмите на ве ртикальную границу справа от столбца .

Появится указате ль разме ров.

3. Пере тащите ве ртикальную границу для изме не ния разме ра столбца .

Изменение размера строки:

1. Нажмите Select («Выбор») .

2. Нажмите на горизонтальную границу под строкой.

Появится указате ль разме ров.

3. Пере тащите горизонтальную границу для изме не ния разме ра строки.

Изменение размера всех ячеек таблицы:

1. Выбе рите таблицу.

2. Нажмите стре лку ме ню таблицы и выбе рите Adjust size («Настроить размер»).
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3. Выбе рите один из сле дующих вариантов:

o Make same height («Использовать одну высоту») , чтобы сде лать все яче йки
таблицы одной высоты.

o Make samewidth («Использовать одну ширину») , чтобы сде лать все яче йки
таблицы одной ширины.

o Make same size («Использовать один размер») , чтобы сде лать все яче йки таблицы
одного разме ра .

o Make cells square («Сделать ячейки квадратными») , чтобы сде лать яче йки
квадратными.

Добавление и удаление столбцов, строк и яче е к
Для настройки таблицы в не е можно добавить столбцы или строки.

Добавление столбца:

1. Выде лите столбе ц.

2. Нажмите стре лку ме ню столбца и выбе рите Insert Column («Вставить столбец»).

Новый столбе ц появится справа от те куще го .

Удаление столбца:

1. Выде лите столбе ц.

2. Нажмите стре лку ме ню столбца и выбе рите Delete Column («Удалить столбец»).

Добавление строки:

1. Выде лите строку.

2. Нажмите стре лку ме ню строки и выбе рите Insert Row («Вставить строку»).

Под те кущей строкой появится новая строка .

Удаление строки:

1. Выде лите строку.

2. Нажмите стре лку ме ню строки и выбе рите Delete Row («Удалить строку»).
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Удаление ячейки:

1. Выде лите яче йку.

2. Нажмите на стре лку ме ню яче йки и выбе рите Delete Cells («Удалить ячейки»).

NOTE

o При удале нии яче йки удаляе тся также е е соде ржимое .

o Нельзя удалить яче йку, е сли она являе тся е динстве нной яче йкой, сое диняющей
две половины таблицы.

Разде ление и объединение яче е к таблиц
Вы може те добавлять таблицы на страницу и вставлять объе кты в яче йки таблицы. Чтобы
настроить таблицу, можно разде лить или объе динить опре де ле нные яче йки.

Разделение ячейки:

1. Выде лите яче йку.

2. Нажмите на стре лку ме ню таблицы и выбе рите Split («Разделить»).

3. Выбе рите вариант разде ле ния на не сколько столбцов и (или) строк.

NOTE

Если вы разде ляе те яче йку, соде ржащую данные , это соде ржимое буде т находиться
после разде ле ния в ве рхне й ле вой яче йке .

Объединение ячеек:

1. Выде лите яче йки.

2. Нажмите на стре лку ме ню таблицы и выбе рите Merge Cells («Объединить ячейки»).

NOTE

Если вы объе диняе те яче йки, соде ржащие данные , яче йка после объе дине ния буде т
соде ржать данные , соде ржащие ся в ве рхне й ле вой яче йке . Если ве рхняя ле вая
яче йка пуста , соде ржимое объе дине нных яче е к, в яче йке после объе дине ния буде т
находиться соде ржимое сле дующей яче йки по направле нию сле ва направо , све рху
вниз .
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Удаление таблиц и их соде ржимого
Можно удалить таблицу или е е соде ржимое .

NOTE

Вы може те удалить все объе кты со страницы, включая таблицы, очистив страницу (см.

Очистка страниц на странице  224).

Удаление содержимого таблицы

1. Выде лите яче йки с соде ржимым, которое тре буе тся удалить .

2. Нажмите кнопку Delete («Удалить») .

Удаление таблицы

1. Выбе рите таблицу.

2. Нажмите на стре лку ме ню таблицы и выбе рите Delete («Удалить»).
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После создания объе кта можно е го выде лить и работать с ним, как описано в данном
разде ле .

NOTE

Задачи, описанные в данном разде ле , приме нимы ко всем объе ктам, а не только к
основным объе ктам.

Выделение объектов
Для того чтобы работать с объе ктами, их не обходимо сначала выде лить .Можно выде лить
отде льный объе кт, не сколько объе ктов или все объе кты на странице . При выде ле нии вокруг
объе кта появляе тся прямоугольная рамка .

Серый кружок в нижнем правом углу объе кта — это ручка изме не ния разме ра (см.

Изменение размеров объектов на странице  80).

Зе ле ный кружок над объе ктом — это ручка поворота (см. Поворот объектов на странице  82).

Направле нная вниз стре лка в ве рхнем правом углу объе кта — это стре лка ме ню. Нажмите
стре лку ме ню, и меню команд появится на экране .

NOTE

При нажатии на стре лку ме ню объе кта выводится тотже список команд, что и при ще лчке
по объе кту правой кнопкой мыши.
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Выделение объекта

1. Нажмите Select («Выбор») .

2. Нажмите объе кт, который не обходимо выде лить .

Вокруг объе кта появится рамка выде ле ния.

NOTE

Если при нажатии на объе кт вме сто стре лки ме ню появится значок блокировки,
объе кт заблокирован. В зависимости от типа блокировки може т потре боваться
разблокировать объе кт, прежде чем управлять объе ктом (см. разде л
LockingObjects.htm).

Выделение нескольких объектов

1. Нажмите Select («Выбор») .

2. Косните сь инте рактивного экрана и тащите рамку, пока она не охватит объе кты, которые
вам нужно выде лить .

ИЛИ

Уде рживая клавишу CTRL, нажимайте на объе кты, которые вы хотите выде лить .

Вокруг выде ле нных объе ктов появится рамка выде ле ния.

NOTE

Если нарисовать рамку вокруг не скольких объе ктов, не которые из которых
заблокированы (см. LockingObjects.htm), будут выде ле ны только не заблокированные
объе кты.

Выделение всех объектов на странице:

Выбе рите Edit &gt; Select All («Правка» &gt; «Выделить все»).

Вокруг все х объе ктов страницы появится рамка выде ле ния.

NOTE

Если не которые из объе ктов заблокированы (см. разде л LockingObjects.htm),

выде лятся только не заблокированные объе кты.

Выделение всех объектов на странице:

Выбе рите Edit &gt; Select All Locked Notes («Правка» &gt; «Выделить все

заблокированные заметки»).
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Вокруг все х заблокированных объе ктов страницы появится рамка выде ле ния.

Изменение свойств объектов
Вы може те изме нять свойства объе ктов. Свойства , которые можно изме нять , з ависят от
выбранного объе кта . Вы може те также выде лить не сколько объе ктов и изме нять их свойства
одновреме нно .

Изменение з аливки
Заливку объе кта можно изме нить , выбрав нужный объе кт, а з атем выбрав заливку на

вкладке Properties («Свойства»), либо нажав Fill («Заливка») , выбрав заливку, а з атем
выде лив не обходимый объе кт.

Для изменения заливки объекта после его выделения:

1. Выбе рите объе кт.

2. Если вкладка Properties («Свойства») не отображае тся, нажмите Properties («Свойства»)

.
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3. Нажмите кнопку &quot;Эффекты заливки&quot;.
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4. Выбе рите тип заливки

Тип заливки Порядок действий

Бе з з аливки
(прозрачный)

Выбе рите No fill («Без заливки»).

Сплошная заливка a. Выбе рите Solid fill («Сплошная заливка»).

b. Выбе рите один из сле дующих вариантов:
o Выбе рите один из 40 цве тов палитры.

o Нажмите More («Еще»)и выбе рите тре буемый цве т в
диалоговом окне .

o Нажмите пипе тку и выбе рите цве т на экране .

Градие нт из двух
цве тов

a. Выбе рите Gradient fill («Градиентная заливка»).

b. Для каждого цве та выполните одно из сле дующих де йствий:
o Выбе рите один из 40 цве тов палитры.

o Нажмите More («Еще»)и выбе рите тре буемый цве т в
диалоговом окне .

o Нажмите пипе тку и выбе рите цве т на экране .
c. Выбе рите нужный параме тр из выпадающе го списка Style

(Стиль).

Заливка узором a. Выбе рите Pattern fill («Заливка по шаблону»).

b. Выбе рите узор .
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Тип заливки Порядок действий

Рисунок a. Выбе рите Image fill («Заливка изображением»).

b. Нажмите &quot;Обзор&quot;.

c. Найдите и выде лите изображе ние , которое вы хотите
использовать в каче стве ф она , и нажмите Open
(«Открыть»).

NOTE

При вставке большого изображе ния може т открыться
диалоговое окно с пре дложением уменьшить разме р
ф айла изображе ния либо оставить е го бе з изме не ний.
Дополните льную инф ормацию см. в разде ле Настройка
параметров оптимизации изображения на странице  237.

d. Выбе рите Keep image size («Сохранить размер
изображения») , чтобы сохранить разме р изображе ния,
не зависимо от того , больше изображе ние , чем объе кт, или
ме ньше .
ИЛИ
Выбе рите Scale image to fit («Масштабировать
изображение по размеру») , чтобы изме нить разме р
изображе ния до разме ра объе кта .

5. Можно также пе ре тащить ползунок Object transparency («Прозрачность объекта»)

вправо , чтобы сде лать объе кт прозрачным.

TIP

Для изме не ния свойств объе кта можно также использовать пе ре ключате ли свойств на
пане ли инструме нтов.

Для изменения заливки объекта после нажатия кнопки Fill («Заливка»):

1. Нажмите Fill («Заливка») , з атем выбе рите цве т.

2. Выбе рите объе кт.

3. Повторите шаг 2 для каждого объе кта , к которому нужно приме нить данную заливку.

Заливка рисунков, выполненных цифровыми чернилами
Помимо заливки ф игур , правильных и не правильных многоугольников, с помощью кнопки Fill

(«Заливка») можно заливать области, ограниче нные циф ровыми че рнилами.
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NOTES

l Для заливки произвольной области не обходимо оче ртить эту область з амкнутым
контуром, нарисованным циф ровыми че рнилами.

l Замкнутая область , являющаяся частью группы, не подлежит заливке (см. Группировка

объектов на странице  84).

l Заливка замкнутой области приводит к созданию отде льного объе кта , который можно
пе ремещать отде льно от исходной замкнутой области.Можно залить замкнутую
область , а з атем многократно пе ремещать получившийся в ре зультате з аливки
объе кт.

Изменение других свойств
Кроме изме не ния заливки можно также изме нять тип линий и стиль те кста объе ктов.

Изменение типа линий объекта:

1. Выбе рите объе кт.

2. Если вкладка Properties («Свойства») не отображае тся, нажмите Properties («Свойства»)

.
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3. Выбе рите &quot;Тип линии&quot;.

4. Измените тип линий объе кта .

Изменение стиля текста объекта:

1. Выбе рите объе кт.

2. Если вкладка Properties («Свойства») не отображае тся, нажмите Properties («Свойства»)

.

3. Нажмите Text Style («Стиль текста»).

4. Измените стиль те кста объе кта (см. Форматирование текста на странице  44).

Сохранение свойств инструмента
После выбора инструме нта на пане ли инструме нтов вы може те изме нить настройки по
умолчанию для этого инструме нта с помощью вкладки Properties («Свойства»), а з атем
сохранить их, нажав Save Tool Properties («Сохранить свойства инструмента»).

После изме не ния настрое к инструме нта по умолчанию кнопка этого инструме нта
изме няе тся сле дующим образом:

Проце дуру восстановле ния настрое к по умолчанию см. в разде ле Настройка панели

инструментов на странице  233.

Расположение объектов
Положение объе ктов можно менять , пе ремещая их в другую область те кущей страницы или
на другую страницу. Вы также може те выравнивать объе кты или изме нять порядок объе ктов
в сте ке .

Перемещение объе ктов
Вы може те пе ремещать объе кты в другое ме сто страницы.Можно также быстро
пе ремещать объе кты.

NOTE

Нельзя пе ре таскивать объе кт, е сли он заблокирован на ме сте (см. LockingObjects.htm).
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TIP

Вы може те управлять не сколькими объе ктами, выде лив их и создав группу (см.

Группировка объектов на странице  84).

Перемещение объекта или объектов:

1. Выде лите объе кт или объе кты.

2. Пере тащите один или не сколько объе ктов в другое ме сто на странице .

TIP

Вы може те пе ремещать объе кт не большими шагами, нажимая клавиши со стре лками
на клавиатуре .

Перемещение файла, совместимого с плеером Adobe Flash®:

1. Нажмите на цве тную полосу в ве рхне й части ф айла , совме стимого с пле е ром Adobe

Flash.

2. Пере тащите ф айл в другое ме сто .

Перемещение объекта

1. Выбе рите объе кт.

2. Сове ршите быстрое движение пальцем в любом направле нии.

Перемещение объе ктов на другую страницу
Вы може те пе ремещать объе кты на другую страницу ф айла .

Перемещение объекта или объектов на другую страницу:

1. Если &quot;Сортировщик страниц&quot; не отображае тся, нажмите &quot;Сортировщик

страниц&quot; .
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2. Если вы не видите страницу, на которую тре буе тся пе реме стить объе кт, прокрутите окно
сортировщика страниц до нужного эскиза страницы.

3. Выде лите объе кт или объе кты, который(-е ) вы хотите пе реме стить .

4. Пере тащите один или не сколько объе ктов в сортировщик страниц на эскиз страницы, на
которую тре буе тся пе реме стить объе кты.

Перемещение файлов, совместимых с плеером Adobe Flash, на другую страницу:

1. Если &quot;Сортировщик страниц&quot; не отображае тся, нажмите &quot;Сортировщик

страниц&quot; .

2. Если вы не видите страницу, на которую тре буе тся пе реме стить объе кт, прокрутите окно
сортировщика страниц до нужного эскиза страницы.

3. Нажмите на цве тную полосу в ве рхне й части ф айла , совме стимого с пле е ром Adobe

Flash.

4. Пере тащите ф айл в сортировщик страниц на эскиз страницы, на которую тре буе тся
пе реме стить объе кт.

Выравнивание объе ктов
Надстройка инструме нта выравнивания позволяе т выровнять и распре де лить объе кты на
странице . Выбранные объе кты можно выровнять по нижне й части, сле ва , справа , по ве рхне й
части, по горизонтали или по ве ртикали. Также можно выровнять объе кты в сте ке по
горизонтали или по ве ртикали.

При же лании вы може те выве сти на странице направляющие , помогающие выравнивать
вручную объе кты по другим объе ктам, а также по ве ртикальной и горизонтальной оси
страницы. Также вы може те задать автоматиче ское выравнивание объе ктов по
направляющим при пе ремещении объе ктов по странице (см. page 71).

Выравнивание объектов на странице:

1. Выбе рите объе кт, который хоте выровнять (см. Выделение объектов на странице  64).

2. Нажмите кнопку Add-ons («Надстройки») , расположенную на пане ли инструме нтов,
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чтобы отобразить кнопки инструме нта выравнивания.

3. Нажмите на кнопку выравнивания :

Кнопка Имя Нажмите на эту кнопку, чтобы:

Выравнивание
по нижне й
границе

Выровнять выбранные объе кты по их нижне й границе .

Выравнивание
по ле вой
границе

Выровнять выбранные объе кты по их нижне й границе .

Выравнивание
по це нтру на
оси X

Выровнять выбранные объе кты ве ртикально по их
це нтральным линиям.

Выравнивание
по це нтру на
оси Y

Выровнять выбранные объе кты горизонтально по их
це нтральным линиям.

Выравнивание
по правой
границе

Выровнять выбранные объе кты по их правой границе .

Выравнивание
по ве рхне й
границе

Выровнять выбранные объе кты по их ве рхне й границе .

Сте к по
горизонтали

Выровнять выбранные объе кты в сте ке по горизонтали.

Сте к по
ве ртикали

Выровнять выбранные объе кты в сте ке по ве ртикали.

Отображение направляющих:

1. Выбе рите View &gt; Alignment («Вид» &gt; «Выравнивание»).

Появится диалоговое окноAlignment («Выравнивание»).
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2. Установите ф лажки направляющих, которые вы хотите выве сти на страницу:

Флажок Установите этот флажок, чтобы

Show guides for
active objects
(«Показать
направляющие для
активных
объектов»)

Выводить направляющую при выравнивании объе кта
относите льно другого объе кта .

Show vertical page
center guide
(«Показать
центральную
направляющую по
вертикали»)

Выводить направляющую при выравнивании объе кта по
ве ртикальной оси страницы.

Show horizontal
page center guide
(«Показать
центральную
направляющую по
горизонтали»)

Выводить направляющую при выравнивании объе кта по
горизонтальной оси страницы.

Snap objects to
guides («Привязать
объекты к
направляющим»)

При пе ремещении объе ктов по странице автоматиче ски
выравнивать объе кты по направляющим.

3. Если вы хотите изме нить цве т направляющих, нажмите на цве тную полоску сле ва от
надписи Guide color («Цвет направляющей») и выбе рите цве т.

4. Нажмите OK.

Изменение порядка объе ктов в сте ке
Если объе кты на странице пе ре крываются, вы може те изме нить их порядок в сте ке (то е сть ,
вы може те управлять тем, какой объе кт буде т отображаться пе ре д другими).

NOTE

Нельзя пе ре таскивать объе кт в сте ке , е сли он заблокирован на ме сте (см.

LockingObjects.htm).
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Перемещение выделенного объекта на передний план стека:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Order &gt; Bring to Front («Порядок» &gt;

«На передний план»).

Перемещение выделенного объекта на задний план стека:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Order &gt; Send to Back («Порядок» &gt;

«На задний план»).

Перемещение в стеке выделенного объекта на одну позицию вперед:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Order &gt; Bring Forward («Порядок»

&gt; «Переместить вперед»).

Перемещение в стеке выделенного объекта на одну позицию назад:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Order &gt; Send Backward («Порядок»

&gt; «Переместить назад»).

Вырезание , копирование и вставка объектов
Можно выре зать , копировать и вставлять объе кты, включая те кст, изображе ния, прямые
линии, дуги и ф игуры в ф айле *.notebook.

TIPS

l Можно вставлять те кст из других программ в ПО SMART Notebook и выре зать те кст из
ПО SMART Notebook и вставлять е го в другие программы (см. Вырезание,

копирование и вставка материалов из других программ на странице  99 и Вырезание

и вставка текста на странице  49).

l Можно создать точную копию объе кта при помощи ф ункции клонирования (см.

Клонирование объектов на странице  79).
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Вырезание и вставка объекта

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Cut («Вырезать»).

TIP

Дополните льно вы може те нажать Cut («Вырезать») , е сли вы добавили эту кнопку
на пане ль инструме нтов (см. Настройка панели инструментов на странице  233).

3. Если объе кт не обходимо вставить на другую страницу, выве дите эту страницу на экран.

4. Нажмите кнопку Paste («Вставить») .

Копирование и вставка объекта

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите пунктCopy («Копировать»).

TIP

Дополните льно вы може те нажать Copy («Копировать») , е сли вы добавили эту
кнопку на пане ль инструме нтов (см. Настройка панели инструментов на странице  233).

3. Если вы хотите вставить элеме нт на другую страницу, выве дите эту страницу на экран.

4. Нажмите кнопку Paste («Вставить») .

Обрезка изображений с маской
Для обре зки изображе ний можно использовать маску.Маска скрывае т "выре заемый"
участок изображе ния, а не удаляе т е го . Это позволяе т вам ре дактировать маску при
не обходимости обре зки другой части изображе ния. Вы также може те снять маску для
возврата исходного изображе ния.

NOTE

Вы може те обре зать только растровые изображе ния. Наприме р , вы може те обре зать
растровые картинки, вставле нные из Гале ре и или с ваше го компьюте ра . Вы не може те
обре зать объе кты других типов.
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Для обрезки изображения с маской:

1. Выбе рите изображе ние .

2. Нажмите стре лку ме ню изображения и выбе рите Mask («Маска»).

На изображении появится маска для обре зки. Обре занные се кции изображе ния
окрашиваются в се рый цве т.

3. Пере таскивайте изображе ние до те х пор , пока се кция изображе ния, которую вы хотите
сохранить , не появится в маске обре зки.

4. Также вы може те нажать на одно из сре дств изме не ния разме ра маски для обре зки
(бе лые кружки), з атем пе ре тащите е го для уве личе ния или уме ньшения разме ра маски
обре зки.

5. Для обре зки нажмите на любую область за пре де лами изображе ния.

Для редактирования маски:

1. Выбе рите изображе ние .

2. Нажмите на стре лку ме ню изображения и выбе рите Edit Mask («Изменить маску»).

На изображении появится маска для обре зки. Обре занные се кции изображе ния
окрашиваются в се рый цве т.

3. Пере таскивайте изображе ние до те х пор , пока се кция изображе ния, которую вы хотите
сохранить , не появится в маске обре зки.

4. Также вы може те нажать на одно из сре дств изме не ния разме ра маски для обре зки
(бе лые кружки), з атем пе ре тащите е го для уве личе ния или уме ньшения разме ра маски
обре зки.

5. Для обре зки нажмите на любую область за пре де лами изображе ния.
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Для восстановления изображения:

1. Выбе рите изображе ние .

2. Нажмите стре лку ме ню изображения и выбе рите Unmask («Удалить маску»).

Буде т восстановле но исходное изображе ние .

Клонирование объектов
Вы може те создать дубликат объе кта с помощью команды "Клонировать" или создать
не сколько копий объе кта с помощью команды "Бе сконе чное клонирование ".

NOTE

Вы также може те копировать и вставлять объе кты, включая те кст, изображе ния, прямые
линии, изогнутые линии и ф ормы (см. Вырезание, копирование и вставка объектов на
странице  76).

Клонирование объекта:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Clone («Клонировать»).

На странице появится дубликат объе кта .

Клонирование объекта с помощью инструмента Infinite Cloner («Бесконечное

клонирование»):

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите пункт Infinite Cloner («Бесконечное

клонирование»).

3. Выде лите объе кт снова .

Символ бе сконе чности появится на экране вме сто стре лки ме ню объе кта .

4. Пере тащите объе кт в другое ме сто на странице .

5. Повторите шаг 4 нужное количе ство раз .

6. После заве ршения клонирования объе кта выде лите исходный объе кт.

7. Нажмите на символ бе сконе чности и отключите Infinite Cloner («Бесконечное

клонирование»).
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Изменение размеров объектов
Разме р объе ктов на странице можно менять с помощью ручки изме не ния разме ра или
же ста масштабирования (е сли ваш инте рактивный продукт подде рживае т режим не скольких
касаний).

NOTE

Нельзя изме нить разме ры объе кта , е сли он заблокирован на ме сте (см.

LockingObjects.htm).

Использование ручки изменения размера

Изменение размеров объекта:

1. Выбе рите объе кт.

2. Нажмите ручку изме не ния разме ра (се рый кружок) и потяните за не е , чтобы уве личить
или уме ньшить разме р объе кта .

NOTE

Чтобы сохранять исходное соотношение высоты к ширине , пе ре тащите кружок при
нажатой клавише SHIFT.

Изменение размеров нескольких объектов:

1. Сгруппируйте объе кты (см. разде л Группировка объектов на странице  84), а з атем
выде лите группу.

Вокруг группы появится рамка выде ле ния.

2. Нажмите ручку изме не ния разме ра в нижнем правом углу рамки выде ле ния.

3. Тащите этот кружок для уве личе ния или уме ньшения разме ра объе ктов.

Использование же ста масштабирования

Изменение размера объекта от центра:

1. Выбе рите объе кт.

2. С помощью указате льных пальце в нажмите на противоположные стороны объе кта .
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3. Двигайте пальцы в противоположных направле ниях, чтобы уве личить разме р объе кта .

ИЛИ

Двигайте пальцы по направле нию друг к другу для уме ньшения разме ра объе кта .

Изменение размера объекта от угла или стороны:

1. Выбе рите объе кт.

2. С помощью указате льных пальце в нажмите на угол или сторону, откуда вы хотите
изме нить разме р объе кта .

3. Двигайте пальцы в противоположных направле ниях, чтобы уве личить разме р объе кта .

ИЛИ

Двигайте пальцы по направле нию друг к другу для уме ньшения разме ра объе кта .

Изменение размеров нескольких объектов:

1. Выде лите объе кты.

2. С помощью указате льных пальце в нажмите на противоположные стороны одного из
объе ктов.
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3. Двигайте пальцы в противоположных направле ниях, чтобы уве личить разме р объе ктов.

ИЛИ

Двигайте пальцы по направле нию друг к другу для уме ньшения разме ра объе ктов.

NOTE

Разме р объе ктов изме няе тся от их це нтров вне зависимости от того , где вы
нажимае те на экран.

Поворот объектов
Объе кты на странице можно поворачивать с помощью ручки поворота или же ста поворота
(е сли ваш инте рактивный продукт подде рживае т режим не скольких касаний).

NOTES

l Нельзя пове рнуть объе кт, е сли он заблокирован на ме сте (см. LockingObjects.htm).

l Нельзя поворачивать таблицы.

Использование ручки поворота

Поворот объекта:

1. Выбе рите объе кт.

2. Нажмите ручку поворота (з е ле ный кружок) объе кта , и тащите е е в нужном направле нии,
чтобы пове рнуть объе кт.

Поворот нескольких объектов:

1. Выде лите объе кты.

Вокруг каждого объе кта появится рамка выде ле ния.

2. Нажмите ручку поворота (з е ле ный кружок) на любом из выбранных объе ктов, и тащите
е е в нужном направле нии, чтобы пове рнуть объе кт. При повороте одного объе кта все
прочие выде ле нные объе кты будут поворачиваться автоматиче ски.
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Использование же ста поворота

Поворот объекта от центра:

1. Выбе рите объе кт.

2. С помощью указате льных пальце в нажмите на противоположные стороны объе кта .

3. Двигайте пальцы по кругу вокруг це нтра объе кта , чтобы пове рнуть е го .

Поворот объекта вокруг угла:

1. Выбе рите объе кт.

2. С помощью указате льных пальце в нажмите на угол, вокруг которого вы хотите
пове рнуть объе кт.

3. Двигайте пальцы по кругу вокруг угла объе кта , чтобы пове рнуть е го .

Поворот нескольких объектов:

1. Выде лите объе кты.

2. С помощью указате льных пальце в нажмите на противоположные стороны одного из
объе ктов.

3. Двигайте пальцы по кругу.

NOTE

Объе кты поворачиваются вокруг своих це нтров вне зависимости от того , где вы
нажимае те на экран.
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Отражение объектов
Вы може те зе ркально отобразить объе кт на странице .

NOTE

Нельзя отразить объе кт, е сли он заблокирован на ме сте (см. LockingObjects.htm).

Зеркальное отражение объекта

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Flip &gt; Up/Down («Повернуть» &gt;

«Вверх/Вниз») или Flip &gt; Left/Right («Зеркально отразить» &gt; «Влево/Вправо»).

Зеркальное отражение нескольких объектов

1. Выде лите объе кты.

2. Нажмите на стре лку ме ню и выбе рите пунктFlip &gt; Up/Down («Повернуть» &gt;

«Вверх/Вниз») или Flip &gt; Left/Right («Зеркально отразить» &gt; «Влево/Вправо»).

Группировка объектов
Вы може те создавать группы объе ктов, что дае т возможность работать со всеми
сгруппированными элеме нтами одновреме нно . После создания группы вы може те выде лять ,
пе ремещать , поворачивать или изме нять разме ры группы, как е сли бы это был один объе кт.
Однако е сли вы хотите работать с отде льным объе ктом в группе , не обходимо сначала
раз группировать объе кты.

Группировка объе ктов вручную
Объе кты можно группировать и раз группировывать вручную с помощью меню или же ста
встряхивания.

Использование меню

Группировка объектов

1. Выде лите объе кты.

2. Нажмите стре лку ме ню любого из выбранных объе ктов и выбе рите пунктGroup &gt;

Group («Группировка» &gt; «Группировать»).
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Разгруппирование объектов

1. Выде лите группу.

2. Нажмите на стре лку ме ню группы и выбе рите пунктGroup &gt; Ungroup («Группа» &gt;

«Разгруппировать»).

Использование жеста встряхивания

NOTES

l Нельзя выполнить же ст встряхивания с помощью мыши.

l Жест встряхивания работае т только при касании пове рхности инте рактивного
продукта .

Группировка объектов

Быстро встряхните пальцем над объе ктами три раза .

Разгруппирование объектов

Быстро встряхните пальцем над группой три раза .
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Автоматиче ская группировка объе ктов
Если вы пише те или рисуе те не сколько линий, ПО SMART Notebook автоматиче ски
объе диняе т линии в один объе кт. Наприме р , е сли вы пише те буквы слова , SMART Notebook

объе диняе т отде льные буквы, позволяя вам работать с це лым словом. Если вы хотите писать
слова на одной строке , но не хотите ,чтобы они объе динялись , оставляйте между ними
большой инте рвал, используйте разные пе рья или не надолго положите пе ро в лоток пе ре д
написанием другого слова (только для инте рактивных досок).

Если SMART Notebook объе диняе т в один объе кт строки, с которыми вы хоте ли работать как
с отде льными объе ктами, можно раз группировать их так, как описано выше .

Удаление объектов
Не смотря на то , что можно стирать циф ровые че рнила (см. Стирание цифровых чернил на
странице  38), не которые типы объе ктов стирать не льзя, включая пе чатный те кст, ф игуры,

прямые линии, дуги и картинки. Чтобы убрать такие объе кты со страницы, их сле дуе т удалить .

NOTE

Нельзя удалить объе кт, е сли он заблокирован на ме сте (см. LockingObjects.htm). Чтобы
удалить заблокированный объе кт, е го нужно сначала разблокировать .

Удаление объекта

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню таблицы и выбе рите Delete («Удалить»).
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Chapter 6: Вставка, упорядочивание и обмен
материалами

Вставка мате риалов из Гале ре и 88
Вставка мате риалов из GeoGebra 90
Вставка мате риалов с ве б -сайта SMART Exchange 92
Вставка мате риалов из других источников 93

Вставка изображе ний 93
Вставка изображе ний из ф айлов 93
Вставка изображе ний, получе нных со скане ра 94
Вставка изображе ний, получе нных с каме ры SMART Document Camera 94
Работа с изображе ниями 94
Создание прозрачных областе й в изображе ниях 95

Вставка ф айлов мультиме диа 95
Вставка ф айлов, совме стимых с пле е ром Adobe Flash 96
Вставка виде оф айлов, совме стимых с пле е ром Adobe Flash Player 97
Добавле ние звуковыхф айлов 98
Работа с мультиме дийными ф айлами 98
Установка кодировщиков для дополните льныхф орматов 98

Вставка соде ржимого из других программ 98
Выре зание , копирование и вставка мате риалов из других программ 99
Импортмате риалов с помощью ф ункции захвата пе чати SMART Notebook Print

Capture 99
Импортмате риалов с помощью ф ункции написания докуме нтов
SMART Notebook Document Writer 101
Импортф айлов PowerPoint 102
Импортф айлов из других программ для работы с инте рактивными досками 103

Использование надстройки SMART kapp 104
Вставка мате риалов с помощью надстройки YouTube 105

Вставка ф ормул в математиче ском ре дакторе 106
Вставка ве б -браузе ров 108

Добавле ние ве б -браузе ра 108
Настройка прокси-се рве ров 109

Вложение ф айлов и ве б -страниц 110
Организация и пре доставле ние обще го доступа к соде ржимому с помощью Гале ре и 112
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Добавле ние соде ржимого в Гале рею 112
Организация соде ржимого в Гале ре е 114
Пре доставле ние другим учите лям доступа к соде ржимому 115
Подключе ние к кате гориям группового соде ржимого 116

Пре доставле ние обще го доступа к соде ржимому с помощью ве б -сайта SMART Exchange 117

Вф айлы *.notebook можно вставить изображе ния, мультиме дийные ф айлы и другие
мате риалы из различных источников. Сре ди этих источников могут быть Gallery (Гале ре я),
ве б -сайтSMART Exchange® и Инте рне т.

После вставки мате риалов вы може те систематизировать их в гале ре е и пре доставить к ним
общий доступ для других пре подавате ле й с помощью гале ре и или ве б -сайта
SMART Exchange.

Вставка материалов из Галереи
Гале ре я — это вкладка пользовате льского инте рф е йса SMART Notebook, где можно
просматривать или искать мате риалы, которое потом можно добавить в свои ф айлы
*.notebook.

Всостав Гале ре и входят приме ры уче бных занятий, которые в свою оче ре дь включают
приме ры конструктора занятий (см. Создание учебного задания на соответствие на
странице  134), инте рактивных ме тодик и 3D-моде ле й, чтобы помочь вам в создании
собстве нных уче бных занятий.

Во время установки SMART Notebook ваш администратор може т также установить
сле дующие элеме нты:

l Основные темы гале ре и пре дставляют собой колле кцию из не скольких тысяч
изображе ний, мультиме дийных объе ктов и т.п., организованных по тематиче ским
кате гориям.

l Инструме нтарий для уче бных занятий пре дставляе т собой набор настраиваемых
инструме нтов и шаблонов, которые можно использовать для создания инте рактивных
занятий с продуманной ме тодикой. Этот инструме нтарий помогае т создать
з анимате льные мате риалы, такие как игры со словами, опросы и задачи на
классиф икацию. Также пре длагаются совме стимые ф айлы Adobe Flash для заданий со
скрытием, отображе нием и пе ре таскиванием.
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Гале ре я де лится на две части. Верхняя часть гале ре и— это список кате горий. Когда вы
выде ляе те кате горию или подкате горию в списке , е е соде ржимое отображае тся в нижне й
части гале ре и.

TIP

l Вы може те изме нить разме ры списка кате горий и списка соде ржимого , нажав на
границу между ними и пе ре тащив е е вве рх или вниз .

Вы може те просмотре ть список кате горий и ознакомиться с соде ржимым каждой кате гории.
Эскизы в кате гориях позволяют пре дварите льно просмотре ть соде ржимое .

l Вкате гории Pictures («Изображения»)изображе ния пре дставле ны в виде эскизов.

l Вкате гории Interactive and Multimedia («Интерактивные средства и мультимедиа»)

виде ообъе кты пре дставле ны кадрами из виде ороликов, звуковые объе кты— значком
громкоговорите ля в нижнем ле вом углу, а ф айлы, совме стимые с пле е ром Adobe Flash,

пре дставле ны значком Adobe Flash или эскизом соде ржимого с мале ньким значком
Adobe Flash в ве рхнем ле вом углу.

l Вкате гории 3D Objects («Объекты 3D») моде ли 3D пре дставле ны в виде эскизов.

l Вкате гории Notebook Files and Pages («Файлы и страницыNotebook») ф айлы
пре дставле ны изображением пе ре пле та , а страницы изображены с отогнутым ве рхним
правым углом.

l Вкате гории Backgrounds and Themes («Фоны и темы») ф оновые рисунки показаны как
страницы с отогнутым нижним правым углом, а темы— в виде эскизов.

Вгале ре е можно выполнять поиск элеме нтов по ключе вому слову.

Элеме нт, найде нный в гале ре е че ре з поиск или обзор , можно вставить в ф айл *.notebook.

Обзор Галереи

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Нажмите значок плюса кате гории, чтобы увиде ть е е подкате гории.

NOTE

Чтобы закрыть кате горию, можно нажать значок минуса .

3. Выде лите кате горию или подкате горию, чтобы отобразить соде ржимое .
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Выполнение поиска в Галерее

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Вве дите ключе вое слово в поле Type search terms here («Введите слова для поиска») , а

з атем нажмите Search («Поиск») .

Будут выве де ны все мате риалы гале ре и, соде ржащие ключе вое слово .

Добавление элемента Галереи в файл *.notebook

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Найдите тре буемый элеме нт гале ре и, воспользовавшись ф ункцие й поиска или обзора .

3. Дважды щелкните по эскизу элеме нта гале ре и.

o Если вы добавляе те рисунок, ф айл, совме стимый с пле е ром Adobe Flash,

виде оф айл или аудиоф айл, он появится на те кущей странице .

o Если вы добавляе те ф оновый рисунок, он заме нит суще ствующий ф оновый
рисунок страницы (см. Применение фонов и тем к страницам на странице  129).

o Если вы добавляе те одну страницу из ф айла *.notebook, SMART Notebook вставит
е е пе ре д те кущей странице й.

o Если вы добавляе те ф айл *.notebook, SMART Notebook вставит страницы ф айла
пе ре д те кущей странице й.

NOTE

SMART Notebook не буде т подде рживать Flash, так как е го после дние ве рсии име ли
ошибки совме стимости с ПО Notebook.

Вставка материалов из GeoGebra
GeoGebra являе тся инте рактивным математиче ским ПО для любого уровня обуче ния. При
вставке видже та GeoGebra в ПО SMART Notebook вы и ваши студе нты сможе те
воспользоваться ге оме триче скими и алге браиче скими ф ункциями, таблицами, граф иками,
статистиче скими ф ункциями и калькулятором.

ВGeoGebraTube также можно найти рабочие листы с помощью поиска по ключе вым словам.

После нахожде ния рабоче го листа е го можно добавить в ф айл *.notebook. GeoGebraTube

(geogebratube.org) соде ржит тысячи рабочих листов, созданных и опубликованных другими
учите лями.

http://www.geogebratube.org/
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NOTE

Боле е подробную инф ормацию об использовании ПО GeoGebra см. в GeoGebra Wiki

(wiki.geogebra.org).

Получение доступа к виджету GeoGebra

Нажмите кнопку Add-ons («Надстройки») , з атем нажмите GeoGebra.

Вставка виджета GeoGebra

1. Если видже тGeoGebra не отображае тся, нажмите Add-ons («Надстройки») , з атем
нажмите GeoGebra.

2. Выбе рите Insert GeoGebra Widget («Вставить виджет GeoGebra»).

Поиск по GeoGebraTube

1. Если видже тGeoGebra не отображае тся, нажмите Add-ons («Надстройки») , з атем
нажмите GeoGebra.

2. Вве дите ключе вое слово в поле Search in Free Materials («Поиск по бесплатным

материалам») , а з атем нажмите Search («Поиск»).

Видже тGeoGebra отобразит изображе ния эскизов рабочих листов, соде ржащих
ключе вые слова .

Добавление рабочего листа GeoGebraTube в файл *.notebook

1. Если видже тGeoGebra не отображае тся, нажмите Add-ons («Надстройки») , з атем
нажмите GeoGebra.

2. Найдите рабочий листGeoGebraTube, который не обходимо добавить .

3. Нажмите эскиз рабоче го листа , з атем выбе рите Insert GeoGebra Widget («Вставить

виджет GeoGebra»).

На те кущей странице появится рабочий лист.

TIP

Для получе ния боле е подробных све де ний о рабочем листе нажмите на название
эскиза и пе ре йдите на страницу загрузки рабоче го листа в GeoGebraTube.

http://wiki.geogebra.org/
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Вставка материалов с веб-сайта
SMART Exchange
Веб -сайтSMART Exchange (exchange.smarttech.com) соде ржит тысячи уче бных планов,
наборов вопросов, видже тов и проче го соде ржимого , которое можно загрузить на свой
компьюте р , а потом открыть в SMART Notebook.

NOTES

l Вы также може те пре доставить другим учите лям доступ к своим уче бным планам
че ре з ве б -сайтSMART Exchange. Дополните льную инф ормацию см. в разде ле
Предоставление общего доступа к содержимому с помощью веб-сайта

SMART Exchange на странице  117.

l Сле дующие ве рсии SMART Notebook не будут подде рживать Flash, так как е го
после дние ве рсии име ли ошибки совме стимости с Notebook.

Вставка содержимого с веб-сайта SMART Exchange

1. Нажмите SMART Exchange .

Веб -сайтSMART Exchange открывае тся в вашем ве б -браузе ре .

2. Если вы не заре гистрированы на ве б -сайте SMART Exchange, нажмите Join for free

(«Зарегистрироваться бесплатно»), з атем сле дуйте инструкциям на экране , чтобы
создать уче тную запись .

ИЛИ

Если у вас уже е сть уче тная запись , нажмите Sign In («Войти»), а з атем сле дуйте
инструкциям на экране , чтобы войти в свою уче тную запись на ве б -сайте
SMART Exchange.

3. Найдите не обходимое соде ржимое , воспользовавшись ф ункцие й поиска или
просмотра , а з атем загрузите е го на свой компьюте р .

4. Импортирование соде ржимого в Гале рею (см. Предоставление другим учителям

доступа к содержимому на странице  115).

http://exchange.smarttech.com/
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Вставка материалов из других источников
Если вы или другие учите ля вашей школы создали мате риалы не в программном
обе спе че нии SMART Notebook, вы може те добавлять эти мате риалы в ф айлы *.notebook. В
частности, можно выполнить сле дующе е :

l добавлять изображе ния, ф айлы, совме стимые с пле е ром Adobe Flash, виде о - и
звуковые ф айлы;

l Выре зать , копировать и вставлять мате риалы из других программ

l Импортируйте мате риалы из других источников (наприме р , YouTube) с помощью
надстройки YouTube™ SMART Notebook.

Вставка изображений
Вы може те помещать на страницы изображения из ф айлов, сканированные изображе ния или
изображе ния, получе нные с SMART Document Camera.

NOTE

Также можно добавлять изображе ния из вкладки Gallery («Гале ре я»). Дополните льную
инф ормацию см. в разде ле Вставка материалов из Галереи на странице  88.

После добавле ния изображе ния вы може те опре де лить в нем прозрачную область .

Вставка изображений из файлов
Вы може те добавить на страницу изображе ние .

ПО SMART Notebook подде рживае т ф орматы BMP, GIF, JPEG, PNG, TIFF иWMF.

Вставка изображения из файла:

1. Выбе рите Insert &gt; Picture («Вставка» &gt; «Файл рисунка»).

Появится диалоговое окно Insert Picture File («Вставить файл изображения»).

2. Найдите и выде лите изображе ние , который вы хотите добавить .

TIP

При выборе изображе ний уде рживайте клавишу Ctrl, чтобы выбрать не сколько
изображе ний.

3. Нажмите кнопку Open («Открыть»).

Изображение появится в ве рхнем ле вом углу страницы.
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Вставка изображений, полученных со сканера
Если к вашему компьюте ру подключе н скане р , вы може те вставлять сканированные
изображе ния на страницу.

NOTE

Пере д добавле нием изображений со скане ра в SMART Notebook вы должны установить на
компьюте р драйве р и программное обе спе че ние скане ра .

Добавление изображения со сканера:

1. Выбе рите Insert &gt; Picture From Scanner («Вставка» &gt; «Изображение со сканера»).

Появится диалоговое окно Insert Scanned Picture («Вставка сканированного

изображения»).

2. Выбе рите скане р из списка .

3. Нажмите Scan («Сканировать»).

4. Сле дуйте инструкциям по работе со скане ром для сканирования изображе ния.

Вставка изображений, полученных с камеры SMART Document Camera
Вы може те вставлять изображе ния, получе нные с каме ры SMART Document Camera на
страницу.

Вставка изображения, полученного с камеры SMART Document Camera:

1. Выбе рите пункт Insert &gt; Picture From SMART Document Camera («Вставить» &gt;

«Изображение из SMART Document Camera»).

На странице появится окно SMART Document Camera.

2. Вставьте изображе ние в соотве тствии с инструкциями в Справке .

Работа с изображениями
При добавле нии в ф айл *.notebook изображе ния оно становится объе ктом. Поэтому
изображе ния можно пе ремещать , изме нять их разме р , вращать и сове ршать с ними другие
изме не ния точно так же , как и любые другие объе кты.

Инф ормацию о том, как работать с объе ктами, включая рисунки и изображе ния, в ф айлах
*.notebook, см. в разде ле Chapter 5: Работа с объектами на странице  63.
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Создание прозрачных областей в изображениях
Вдобавляемых на страницу изображе ниях можно создавать прозрачные области. Эта
ф ункция поле зна для удале ния ф она изображе ния. Любой цве т изображе ния можно сде лать
прозрачным.

NOTE

Разме р вставляемого в ф айл изображе ния можно уме ньшить (см. Настройка параметров

оптимизации изображения на странице  237). Но е сли потом в таком изображении создать
прозрачную область , то изображе ние больше не буде т оптимизированным.

Создание прозрачной области в изображении

1. Выбе рите изображе ние .

2. Нажмите на стре лку ме ню изображения и выбе рите &quot;Задать прозрачность

изображения&quot;.

Появится диалоговое окно Picture Transparency («Прозрачность изображения»).

3. Потяните за угол диалогового окна в соотве тствующем направле нии, чтобы изме нить
е го разме р .

4. Нажмите на любую область изображе ния, которую вы хотите сде лать прозрачной.

NOTE

Нажатие на область де лае т прозрачной только эту область , даже е сли изображе ние
соде ржит такой же цве т в других областях.

5. Нажмите OK.

Вставка ф айлов мультимедиа
На страницы можно добавлять мультиме дийные ф айлы, включая ф айлы, совме стимые с
Adobe Flash Player, виде о - и звуковые ф айлы.

NOTE

Соде ржимое Adobe Flash може т не работать в SMART Notebook. Нажмите зде сь для
получе ния дополните льной инф ормации.

NOTE

Также можно добавлять мультиме дийные ф айлы из вкладки Gallery («Гале ре я»).
Дополните льную инф ормацию см. в разде ле Вставка материалов из Галереи на
странице  88.

http://www.smarttech.com/kb/110742
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Вставка файлов, совместимых с плеером Adobe Flash
Вы може те добавить на страницу ф айлы, совме стимые с пле е ром Adobe Flash.

После добавле ния на страницу ф айла , совме стимого с Adobe Flash, а также после вывода на
экран страницы, соде ржащей ф айл, совме стимый с Adobe Flash, автоматиче ски начинае тся
воспроизве де ние этого ф айла . Однако этим проце ссом можно управлять . Если ф айл
соде ржит кнопки, можно нажимать их на инте рактивном продукте . Если же ф айл не снабжен
кнопками, можно использовать пункты, появляющие ся при нажатии на стре лку ме ню этого
ф айла .

NOTES

l Файлы, совме стимые с пле е ром Adobe Flash, размещаемые на странице , должны быть
самораспаковывающимися. Нельзя использовать ф айлы, совме стимые с Adobe Flash,

з агружающие или использующие другие ф айлы, совме стимые с пле е ром Adobe Flash.

l Нельзя пе ре таскивать ф айл, совме стимый с пле е ром Adobe Flash из ве б -браузе ра на
страницу.

l Если на компьюте ре не установле н пле е р Adobe Flash, SMART Notebook пре дупре дит
об этом при попытке поме стить на страницу ф айл, совме стимый с пле е ром Adobe

Flash.

l Вы може те установить Adobe Flash Player с ве б -сайта adobe.com, но для установки
не обходимо использовать браузе р Internet Explorer®. При использовании другого
браузе ра ф айлы, совме стимые с Adobe Flash Player, не будут работать в программном
обе спе че нии SMART Notebook.

l Чтобы писать пове рх ф айла , совме стимого с пле е ром Adobe Flash, с помощью
компоне нта распознавания рукописного те кста , начните писать за пре де лами ф айла и
продолжайте пове рх не го . Это позволит программному обе спе че нию SMART

Notebook распознать циф ровые че рнила как объе кт, отде льный отф айла ,
совме стимого с пле е ром Adobe Flash.

Добавление файлов, совместимых с плеером Adobe Flash

1. Выбе рите Insert &gt; Adobe Flash Player Compatible File («Вставка» &gt; «Файлы,

совместимые с Adobe Flash Player»).

Появится диалоговое окно Insert Flash File (Вставить файл Flash).

2. Найдите и выде лите ф айл, совме стимый с пле е ром Adobe Flash, который вы хотите
добавить на страницу.

http://www.adobe.com/
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3. Нажмите кнопку Open («Открыть»).

Файл, совме стимый с пле е ром Adobe Flash, появится в ле вом ве рхнем углу страницы.

Управление файлом, совместимым с плеером Adobe Flash

1. Выбе рите ф айл, совме стимый с пле е ром Adobe Flash.

2. Управляйте ф айлом, выполняя любое из сле дующих де йствий:

o Чтобы запустить воспроизве де ние ф айла , нажмите на стре лку ме ню ф айла и
выбе рите Flash &gt; Play (Flash &gt; «Воспроизведение»).

o Чтобы запустить воспроизве де ние ф айла с начала , нажмите на стре лку ме ню ф айла
и выбе рите Flash &gt; Rewind (Flash &gt; «Назад»).

o Чтобы прокрутить воспроизве де ние ф айла немного впе ре д и сде лать паузу,
нажмите на стре лку ме ню ф айла и выбе рите Flash &gt; Step Forward (Flash &gt;

«Шаг вперед»).

o Чтобы прокрутить воспроизве де ние ф айла немного назад и сде лать паузу, нажмите
на стре лку ме ню ф айла и выбе рите Flash &gt; Step Back (Flash &gt; «Шаг назад»).

o Для не пре рывного воспроизве де ния ф айла нажмите на стре лку ме ню ф айла и
выбе рите Flash &gt; Loop (Flash &gt; «Цикл»).

o Для отме ны не пре рывного воспроизве де ния ф айла нажмите на стре лку ме ню
ф айла и снимите ф лажок Flash &gt; Loop (Flash &gt; «Цикл»).

Вставка видеофайлов, совместимых с плеером Adobe Flash Player
Вы може те добавить на страницу виде оф айлы, совме стимые с пле е ром Adobe Flash.

NOTE

ПО SMART Notebook подде рживае т ф ормат виде оф айлов (FLV), совме стимый с пле е ром
Adobe Flash. Если вы хотите , чтобы программное обе спе че ние SMART Notebook

подде рживало другие типы ф айлов, вы може те установить дополните льные кодировщики
(см. Установка кодировщиков для дополнительныхформатов на сле дующей странице ).

Добавление файлов, совместимых с плеером Adobe Flash

1. Выбе рите пунктме ню Insert &gt; Video («Вставка» &gt; «Видео»).

Появится диалоговое окно Insert Video File (Вставить видеофайл).

2. Найдите и выде лите ф айл, совме стимый с пле е ром Adobe Flash, который вы хотите
добавить на страницу.

3. Нажмите кнопку Open («Открыть»).



CHAPTER6
ВСТАВКА, УПОРЯДОЧИВАНИЕ И ОБМЕН МАТЕРИАЛАМИ

98

Добавление звуковых файлов
Клюбому объе кту (кроме объе ктов, совме стимых с Adobe Flash Player) в ф айле *.notebook

можно добавить звуковой ф айл. Дополните льную инф ормацию см. в Добавление звуков к

объектам на странице  124.

Работа с мультимедийными файлами
При добавле нии в ф айл *.notebook ф айла мультиме диа после дний становится объе ктом.

Поэтому эти ф айлы можно пе ремещать , изме нять их разме р , вращать и сове ршать с ними
другие изме не ния точно так же , как и любые другие объе кты.

Инф ормацию о том, как работать с объе ктами, включая мультиме дийные ф айлы, в ф айлах
*.notebook, см. разде л Chapter 5: Работа с объектами на странице  63.

Установка кодировщиков для дополнительных форматов
SMART Notebook подде рживае т ф ормат звука FLV иMP3. Чтобы SMART Notebook

подде рживал другие виде о и аудиоф орматы, можно установить дополните льный
кодировщик. После установки дополните льного кодировщика SMART Notebook

автоматиче ски обнаружит е го и буде т подде рживать е го ф орматы виде о и аудио .

Кодировщик Форматы видео Форматы звука Ссылка

MediaCoder Full
Pack 0.3.9

l ASF

l AVI

l MOV

l MPEG иMPG

l WMV

l AIF и AIFF

l WAV

mediacoderhq.com/dlfull.htm

NOTE

SMART Technologies ULC дае т ссылку на эти программы в порядке любе зности. Компания
не де лае т пре дставле ния и не дае т никаких гарантий относите льно этих программ и любой
связанной с ними инф ормации. Все вопросы, жалобы или пре те нзии, касающие ся этих
программ, сле дуе т направлять разработчику соотве тствующе го ПО.

Вставка соде ржимого из других программ
Если у вас е сть мате риалы, созданные в других программах, и вы хотите использовать их в
своих ф айлах *.notebook, такие мате риалы можно пе ре не сти в ПО SMART Notebook,

выполнив сле дующие де йствия:

l Выре зание , копирование и после дующая вставка

l Импорт соде ржимого

http://www.mediacoderhq.com/dlfull.htm
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Вырезание, копирование и вставка материалов из других программ
Вы може те выре зать или копировать соде ржимое из других программ в ПО SMART

Notebook.

Вырезание содержимого из другой программы

1. Вдругой программе выде лите соде ржимое , которое вы хотите выре зать , и выбе рите
Edit &gt; Cut («Правка» &gt; «Вырезать»).

2. ВПО SMART Notebook нажмите Paste («Вставить») .

Копирование содержимого из другой программы

1. Вдругой программе выде лите соде ржимое , которое вы хотите скопировать , и выбе рите
Edit &gt; Copy («Правка» &gt; «Копировать»).

2. ВПО SMART Notebook нажмите Paste («Вставить») .

Импорт материалов с помощью функции захвата печати SMART Notebook Print Capture
При установке программного обе спе че ния SMART Notebook на компьюте р с опе рационной
системойWindows XP также устанавливае тся ф ункция SMART Notebook Print Capture.

SMART Notebook Print Capture работае т как обычный драйве р принте ра . Единстве нное
отличие заключае тся в том, что захваче нное изображе ние не пе чатае тся на бумаге , а
сохраняе тся в ф айл *.notebook. Каждая страница импортированного ф айла отображае тся как
объе кт на отде льной странице , с сохране нием исходного ф ормата и де ле ния страниц.

NOTE

Вслучае установки SMART Notebook на компьюте р с опе рационной системойWindows 7

илиWindows 8 мате риалы можно импортировать при помощи ф ункции написания
докуме нтов SMART Notebook Document Writer (см. Импорт материалов с помощью

функции написания документов SMART Notebook Document Writer на странице  101).

Использование функции SMART Notebook Print Capture:

1. Висходном ф айле , который вам нужно экспортировать в ф айл *.notebook, выбе рите File

&gt; Print («Файл» &gt; «Печать»).

Появится диалоговое окноPrint («Печать»).

2. Выбе рите SMART Notebook Print Capture в списке принте ров.

3. При же лании можно изме нить орие нтацию страниц и разрешение изображе ний (см.

Изменение ориентации страниц и разрешения изображений: на сле дующей странице ).
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4. Укажите диапазон страниц, а з атем нажмите OK или Print («Печать»).

Если суще ствующий ф айл *.notebook з акрыт, открое тся новый ф айл *.notebook. Каждая
страница исходного ф айла буде т отображаться на отде льной странице .

ИЛИ

При наличии открытого ф айла *.notebook каждая страница исходного ф айла буде т
вставле на в этотф айл сразу за те кущей странице й.

NOTE

Этот проце сс може т занять не сколько минут.

Изменение ориентации страниц и разрешения изображений:

1. Нажмите кнопку Properties (Свойства) или Preferences (Настройки).

Появится диалоговое окно SMART Notebook Print Capture Properties (Свойства

SMART Notebook Print Capture).

2. Выбе рите Portrait («Книжная») или Landscape («Альбомная»).

3. Выбе рите разрешение по умолчанию из выпадающе го списка Resolution (Разрешение).

ИЛИ

Выбе рите CUSTOMResolution (ПОЛЬЗОВАТЕЛЬСКОЕ разрешение) в выпадающем
списке Resolution (Разрешение) и вве дите числа в поляхHorizontal Resolution

(Разрешение по горизонтали) и Vertical Resolution (Разрешение по вертикали).

TIPS

o Используйте в обоих полях одинаковые значе ния, чтобы избежать искаже ния
изображе ния.

o Чем выше разрешение , тем больше изображе ние .

o Не используйте параме тры Draft («Черновик»), Low («Низкое») илиMedium

(«Среднее») , поскольку изображе ние може тмасштабироваться
не пропорционально .

4. Нажмите OK.



CHAPTER6
ВСТАВКА, УПОРЯДОЧИВАНИЕ И ОБМЕН МАТЕРИАЛАМИ

101

Импорт материалов с помощью функции написания документов SMART Notebook

Document Writer
При установке программного обе спе че ния SMART Notebook на компьюте р с опе рационной
системойWindows 7 илиWindows 8 также устанавливае тся ф ункция SMART Notebook

Document Writer. SMART Notebook Document Writer работае т как обычный драйве р принте ра .
Единстве нное отличие заключае тся в том, что захваче нное изображе ние не пе чатае тся на
бумаге , а сохраняе тся в ф айл *.notebook.

NOTE

Вслучае установки SMART Notebook на компьюте р с опе рационной системойWindows XP

мате риалы можно импортировать при помощи ф ункции захвата пе чати SMART Notebook

(см. Импорт материалов с помощью функции захвата печати SMART Notebook Print

Capture на странице  99).

Использование функции SMART Notebook Document Writer:

1. Висходном ф айле , который вам нужно экспортировать в ф айл *.notebook, выбе рите File

&gt; Print («Файл» &gt; «Печать»).

Появится диалоговое окноPrint («Печать»).

2. Выбе рите SMART Notebook Document Writer в списке принте ров.

3. При же лании можно изме нить орие нтацию страниц (см. Изменение ориентации страницы:

на сле дующей странице ).

4. Укажите диапазон страниц, а з атем нажмите OK или Print («Печать»).

Появится диалоговое окно .

5. Выбе рите SMART Notebook pages with images («Страницы SMART Notebook с

изображениями») , чтобы импортировать мате риалы из ф айла в виде изображе ний.

ИЛИ

Выбе рите SMART Notebook pagewith editable objects («Страницы SMART Notebook с

редактируемыми объектами») , чтобы импортировать мате риалы из ф айла в виде
ре дактируемых объе ктов.

NOTE

Вслучае импорта мате риалов в виде ре дактируемых объе ктов, не которые объе кты
могут отображаться не корре ктно . Вэтом случае можно импортировать мате риал в
виде изображе ний.
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6. Нажмите OK.

Открое тся новый ф айл *.notebook. Каждая страница исходного ф айла буде т
отображаться на отде льной странице .

Изменение ориентации страницы:

1. Нажмите Properties («Свойства») или Preferences («Настройки»).

Появится диалоговое окно Printing Preferences (Настройки печати).

2. Выбе рите Landscape (Альбомная) или Portrait (Книжная) из выпадающе го списка
Orientation (Ориентация).

3. Нажмите OK.

Импорт файлов PowerPoint
Вы може те импортировать мате риалы в ф айл *.notebook из различных источников, включая
ф айлы PowerPoint.

NOTE

Программное обе спе че ние SMART Notebook не импортируе т не которые эфф е кты
градие нтов, узоров и изображе ний. Вре зультате эти эфф е кты могут не корре ктно
отображаться в ф айлах *.notebook.

TIP

Можно экспортировать ф айлы *.notebook в PowerPoint (см. Экспорт файлов на
странице  17).

Импорт файла PowerPoint:

1. Выбе рите File &gt; Import («Файл» &gt; «Импорт»).

Появится диалоговое окноOpen («Открыть»).

2. Выбе рите All PowerPoint Files (*.ppt;*.pptx) (Всефайлы PowerPoint (*.ppt; *.pptx)) в
выпадающем списке Files of type (Тип файлов).

3. Найдите и выде лите ф айл PowerPoint, который вы хотите импортировать .

4. Нажмите кнопку Open («Открыть»).

ПО SMART Notebook добавляе т соде ржимое ф айла PowerPoint в ф айл *.notebook.
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Импорт файлов из других программ для работы с интерактивными досками
Вы може те импортировать мате риалы в ф айлы *.notebook из различных источников, включая
другие программы для работы с инте рактивными досками.

Если другие программы для работы с досками подде рживают используемый ф орматф айлов
инте рактивной доски (CFF), вы може те экспортировать ф айл CFF из этих программ и затем
импортировать е го в ПО SMART Notebook.

Или вы може те попробовать импортировать ф айл в родном ф ормате другой программы для
работы с инте рактивными досками.

NOTE

Вы также може те экспортировать ф айлы CFF (см. Экспорт файлов на странице  17).

Импорт файлов CFF

1. Выбе рите File &gt; Import («Файл» &gt; «Импорт»).

Появится диалоговое окноOpen («Открыть»).

2. Выбе рите All Common File Format Files (*.iwb) (Всефайлы используемого формата

(*.iwb)) в выпадающем списке Files of type (Тип файлов).

3. Найдите и выде лите ф айл, который вы хотите импортировать .

4. Нажмите кнопку Open («Открыть»).

Файл открывае тся.
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Импорт других файлов:

1. Нажмите Open File («Открытьфайл») .

Появится диалоговое окноOpen («Открыть»).

2. Выбе рите All Files (*.*) (Всефайлы (*.*)) в выпадающем списке Files of type (Тип файлов).

3. Найдите и выде лите ф айл, который вы хотите импортировать .

4. Нажмите кнопку Open («Открыть»).

Если вы импортируе те ф айл, который ПО SMART Notebook подде рживае т, ф айл
открое тся.

ИЛИ

Если вы импортируе те ф айл, который ПО SMART Notebook не подде рживае т, SMART

Notebook добавит е го на вкладку "Вложения". Вы може те открывать такие вложенные
ф айлы с помощью сторонне го программного обе спе че ния, но не може те добавлять их
на страницу.

Использование надстройки SMART kapp
Надстройка SMART lapp — это автономное приложение , позволяюще е взаимоде йствовать с
входной инф ормацие й kapp в ПО SMART Notebook.

NOTE

Для использования надстройки SMART kapp Notebook не обходимо оборудование SMART

kapp и ПО SMART Notebook для совме стного обуче ния с ПО надстройки SMART kapp для
совме стимого устройства . Посе тите сайтwww.smarttech.com для получе ния инф ормации
об установке надстройки.

Для использования надстройки SMART kapp в SMART Notebook выполните следующие

действия:

1. После установки надстройки SMART kapp она появится на пане ли надстроек. Нажмите

на значок SMART kapp .

Открое тся надстройка SMART kapp.

2. Укажите ID се ссии SMART kapp, созданный приложением SMART kapp на мобильном
устройстве , подключе нном к доске kapp.

http://www.smarttech.com/


CHAPTER6
ВСТАВКА, УПОРЯДОЧИВАНИЕ И ОБМЕН МАТЕРИАЛАМИ

105

3. Нажмите Connect (Подключиться).

Произойде т подключе ние се ссии SMART kapp, и появится окно Board view (Вид доски)

SMART kapp.

4. Нажмите Open Board View (Открыть вид доски).

Отобразится те кущая инф ормация, написанная циф ровыми че рнилами на подключе нной
доске SMART kapp. Если на доске ниче го не было написано , появится сообщение
Nothing on SMART kapp board yet (На доске SMART kapp пока ничего нет).

5. Напишите что -нибудь циф ровыми че рнилами на доске kapp, и оно буде т отображе но в
окне надстройки. При не обходимости соде ржимое можно стирать .

6. Вокне надстройки kapp прокручивайте элеме нт управле ния воспроизве де нием для
пе ремещения впе ре д и назад по се ссии.

Нажмите Ink to this page (Перенести чернила на эту страницу) или Ink to new page

(Перенести чернила на новую страницу), чтобы вставить че рнила в SMART Notebook.

7. Закройте окно надстройки для возобновле ния работы в SMART Notebook.

Вставка мате риалов с помощью надстройки YouTube
С помощью надстройки YouTube можно ле гко вставлять мате риалы YouTube™ в страницы
Notebook.

TIP

Если в Notebook не установле на надстройка YouTube, используйте диспе тче р надстрое к.
См. Установка надстроек на странице  229.

Вставка материалов с помощью надстройки YouTube:

1. Всортировщике страниц Notebook нажмите на значок YouTube.

Открое тся диалоговое окно Add You Tube Videos (Добавить видео из YouTube).

2. Напишите или скопируйте URL-адре с виде о из YouTube в диалоговое окно и нажмите на
стре лку рядом. Виде о из YouTube появится на те кущей странице Notebook. Для поиска
виде о напишите крите рий поиска в окне и нажмите Search (Поиск).

Появится диалоговое окно Add Videos (Добавить видео).

3. Нажмите на виде о для начала воспроизве де ния. Все стандартное управле ние YouTube

доступно для использования.

4. Выбе рите виде о . См. Выделение объектов на странице  64.
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Вставка формул в математическом редакторе
С помощью математиче ского ре дактора вы може те пре дставить рукописные ф ормулы в
боле е удобном для чте ния виде .Математиче ский ре дактор распознае т рукописный те кст и
автоматиче ски пре образуе т е го в пе чатный ф ормат. Вы также сможе те добавить
распознанную ф ормулу на рабочий листGeoGebra, е сли ф ормат е е граф ика
подде рживае тся этим ПО.

Вставка уравнения на страницу

1. Нажмите кнопку Add-ons («Надстройки») , а з атем выбе рите Insert Equation

(«Вставитьформулу») .

Открое тся математиче ский ре дактор .

2. Выбе рите инструме нт «Перо» и е го цве т (см. разде л page 34).

3. Напишите ф ормулу в разлинованной области ре дактора .

Рукописная ф ормула буде т пре образована в пе чатную ф ормулу, которая появится
ниже разлинованной области. Рядом с распознанной ф ормулой появятся значки
«Принять» или «Отклонить».

4. Нажмите , чтобы сохранить распознанную ф ормулу.

Печатная ф ормула появится на странице .

ИЛИ

Нажмите , чтобы не сохранять распознанную ф ормулу и закрыть математиче ский
ре дактор .
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Изменение распознанного уравнения

1. Нажмите Select («Выбрать») и дважды нажмите на странице на распознанное
уравне ние .

Вматематиче ском ре дакторе появится рукописная ф ормула .

2. Отре дактируйте рукописную ф ормулу с помощью инструме нта «Ластик» и пе ра .

Отре дактированная ф ормула буде т распознана и появится ниже разлинованной
области. Рядом с распознанной ф ормулой появятся значки «Принять» или «Отклонить».

3. Нажмите , чтобы сохранить распознанную ф ормулу.

Вф ормулу будут вне се ны ваши исправле ния.

ИЛИ

Нажмите , чтобы не сохранять распознанную ф ормулу и закрыть математиче ский
ре дактор .

Формула не обновляе тся.

Добавление распознанного уравнения на рабочий лист GeoGebra

1. Вставка рабоче го листа GeoGebra на страницу (см. Вставка материалов из GeoGebra на
странице  90).

2. Пере тащите ф ормулу со страницы на видже тGeoGebra.

Формула автоматиче ски появится на рабочем листе .
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Вставка веб-браузеров
На страницу *.notebook можно добавить ве б -браузе р . Веб -браузе р можно использовать для
навигации и демонстрации ве б -страниц. Веб -браузе р можно изме нять точно так же , как и
любой другой объе кт в программном обе спе че нии SMART Notebook (см. Chapter 5: Работа с

объектами на странице  63).

NOTE

При изме не нии разме ров ве б -браузе ра соде ржимое в е го окне буде т масштабироваться
автоматиче ски, таким образом вы буде те виде ть ве б -страницу це ликом.

Добавление ве б-брауз е ра

Вставка веб-браузера:

1. Выбе рите Insert &gt; Internet Browser («Вставка» &gt; «Веб-браузер»).

Появится ве б -браузе р .
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2. Дважды нажмите в адре сной строке , вве дите адре с нужной ве б -страницы и нажмите Go

(«Перейти») .

TIP

Если к используемому компьюте ру не подключе на клавиатура , нажмите

SMART Keyboard , чтобы показать экранную клавиатуру.

3. Для работы с ве б -страницами можно использовать сле дующие кнопки на пане ли
инструме нтов ве б -браузе ра :

Кнопка Команда Действие

Назад Просмотре ть пре дыдущую ве б -страницу.

Впе ре д Просмотре ть сле дующую ве б -страницу.

Возврат на
закре пле нную
страницу

Открыть закре пле нную ве б -страницу.

Заф иксировать
страницу

Закре пить те кущую ве б -страницу.
При пе рвом открытии ф айла *.notebook в окне ве б -
браузе ра отображае тся закре пле нная ве б -страница . К
закре пле нной странице можно ве рнуться в любое время в
проце ссе работы, нажав Return to Pinned Page (Возврат на

закрепленную страницу) .

Пере загрузить Пе ре загрузить те кущую ве б -страницу.

Переме стить
пане ль

Изме нить положение пане ли инструме нтов ве б -браузе ра .

Настройка прокси-се рве ров
Веб -браузе ры в ПО SMART Notebook работают с любыми прокси-се рве рами, которые
отве чают тре бованиям стандарта RFC 2068 HTTP. Если системный администратор установил
ПО SMART Notebook в се ти с прокси-се рве ром, потре буе тся создать правила политики
доступа для входяще го и исходяще го потоков данных для этого прокси-се рве ра . В
дальне йшем можно буде т повысить бе зопасность се ти, включив ауте нтиф икацию, наприме р
базовую ауте нтиф икацию или ауте нтиф икацию диспе тче ра локальной се ти NT (NTLM).

NOTE

Прокси-се рве ры заме чате льно защищают внутре нние се ти от не санкционированного
взлома , но их использование приводит к значите льному уве личе нию се те вой заде ржки.
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Вложение файлов и веб-страниц
Можно прикре плять копии ф айлов, ярлыки ф айлов и ссылки на ве б -страницы с помощью
вкладки "Вложения".

Прикре пле ние ф айлов или ссылок на ве б -страницы позволит быстро найти и открыть эти
элеме нты во время пре зе нтации ф айла *.notebook.

NOTES

l Файлы и ссылки на ве б -страницы можно также связать с объе ктом на странице (см.

Добавление ссылок к объектам на странице  122).

l Вкаче стве альте рнативы добавле нию ссылки на ве б -страницу в ф айл *.notebook

можно добавить ве б -браузе р (см. Вставка веб-браузеров на странице  108).

Вложение копии файла:

1. Если вкладка Attachments («Вложения») не отображае тся, нажмите пунктAttachments .

2. Нажмите Insert («Вставить») в нижне й части вкладки Attachments («Вложения») , а з атем
выбе рите Insert Copy of File («Вставить копию файла»).

Появится диалоговое окно Insert Copy of File («Вставить копию файла»).

3. Найдите и выде лите ф айл, который вы хотите вложить .

4. Нажмите кнопку Open («Открыть»).

На вкладке Attachments (Вложения) появятся имя и разме р ф айла .

NOTE

При вложении ф айла разме р ф айла *.notebook уве личивае тся. Программное
обе спе че ние SMART Notebook сжимае тф айлы для экономии ме ста . При этом одни
типы ф айлов сжимаются лучше , чем другие .

Вложение ярлыка файла:

1. Если вкладка Attachments («Вложения») не отображае тся, нажмите пунктAttachments .

2. Нажмите Insert («Вставить») в нижне й части вкладки Attachments («Вложения») , а з атем
выбе рите Insert Shortcut to File («Вставить ярлык файла»).

Появится диалоговое окно Insert File Shortcut («Вставить ярлык файла»).

3. Найдите и выде лите ф айл, который вы хотите вложить .
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4. Нажмите кнопку Open («Открыть»).

На вкладкеAttachments (Вложения) появится имя ф айла и Shortcut (Ярлык).

NOTES

o SMART Notebook не экспортируе т ярлыки. Если не обходимо экспортировать
ф айловое вложение , прикре пите копию ф айла , а не ярлык.

o Убе дите сь , что ф айл присутствуе т на компьюте ре , который буде т использован во
время урока .

Вложение ссылок на веб-страницу:

1. Если вкладка Attachments («Вложения») не отображае тся, нажмите пунктAttachments .

2. Нажмите кнопку Insert («Вставить») в нижне й части вкладки Attachments («Вложения») , а
з атем выбе рите пункт Insert Hyperlink («Вставить гиперссылку»).

Появится диалоговое окно Insert Hyperlink («Вставка гиперссылки»).

3. Вве дите адре с ве б -страницы в поле Hyperlink (Гиперссылка).

4. Вве дите название ссылки в поле Display name (Отображаемое имя).

5. Нажмите OK.

На вкладке Attachments (Вложения) появятся отображаемое имя и URL (URL-адрес).

Для открытия файла или веб-страницы с вкладки Attachments («Вложения»):

1. Если вкладка Attachments («Вложения») не отображае тся, нажмите пунктAttachments .

На вкладке "Вложения" показан список все х вложений для те куще го ф айла .

o Если прикре пле нный элеме нт пре дставляе т собой копию ф айла , в столбце Size

(«Размер») отображае тся разме р ф айла .

o Если вложенный элеме нт пре дставляе т собой ярлык ф айла , в столбце Size (Размер)

появится Shortcut (Ярлык).

o Если вложенный элеме нт пре дставляе т собой ссылку на ве б -страницу, в столбце
Size (Размер) отображае тся URL (URL-адрес).

2. Чтобы открыть ф айл, дважды нажмите на е го име ни или ярлыке .

ИЛИ

Чтобы открыть ве б -страницу, дважды нажмите на ссылку.
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Организация и предоставление общего
доступа к содержимому с помощью Галереи
Гале ре я — это вкладка пользовате льского инте рф е йса программного обе спе че ния
SMART Notebook, где можно просматривать или искать мате риалы, которые потом можно
добавить в ф айлы *.notebook. Гале ре я соде ржит набор кате горий, одной из которых
являе тся кате гория My Content (Мое соде ржимое ).

При использовании одних и те хже мате риалов в не скольких ф айлах *.notebook можно
добавить эти мате риалы в кате гориюMy Content (Мое соде ржимое ). Вы може те пре доставить
доступ к мате риалам из кате горииMy Content (Мое соде ржимое ) другим учите лям вашей
школы путем импорта или экспорта ф айлов колле кции гале ре и. Вы также може те
подключиться к кате гории Team Content (Соде ржимое группы), в которой находятся
мате риалы, пре доставле нные вами и другими учите лями вашей школы.

После добавле ния ваших мате риалов в Гале рею вы може те вставлять их в ф айлы *.notebook,

как описано в разде ле Вставка материалов из Галереи на странице  88.

Добавление соде ржимого в Гале рею
Вы може те добавлять объе кты и страницы SMART Notebook, а также вспомогате льные
ф айлы в кате горию "Мое соде ржимое " в гале ре е .

Добавление объекта в Галерею:

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Выде лите объе кт, который тре буе тся добавить в гале рею.

3. Пере тащите объе кт со страницы в кате гориюMy Content («Мое содержимое») гале ре и
или в одну из е е подкате горий.

NOTES

o Нельзя пе ре тащить объе кт, е сли он заблокирован на ме сте (см.

LockingObjects.htm).

o Если вы хотите изме нить имя элеме нта гале ре и, выде лите элеме нт, нажмите
стре лку ме ню и выбе рите Rename («Переименовать»).

Добавление страницы в Галерею:

1. Продолжайте создавать и изме нять объе кты на странице до те х пор , пока она не буде т
выгляде ть точно так, как вы хотите .
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2. Выбе рите File &gt; Export Page as Gallery Item («Файл» &gt; «Экспортировать страницу

как элемент галереи»).

Появится диалоговое окно Save Page as Gallery Item (Сохранить страницу как элемент

галереи).

3. Выбе рите папку, в которую нужно сохранить страницу.

4. Вве дите имя страницы в поле File name (Имя файла).

5. Нажмите &quot;Сохранить&quot;.

6. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

7. Выбе рите кате гориюMy Content («Мое содержимое») (или одну из е е подкате горий) в
списке кате горий гале ре и, нажмите стре лку ме ню и выбе рите пунктAdd to My Content

(«Добавить в мое содержимое»).

Появится диалоговое окно Add to My Content («Добавить в «Мое содержимое») .

8. Найдите и выде лите элеме нт, сохране нный в шаге 5.

9. Нажмите кнопку Open («Открыть»).

Добавление поддерживаемого файла в Галерею:

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Выбе рите кате гориюMy Content («Мое содержимое») (или одну из е е подкате горий) в
списке кате горий гале ре и, нажмите стре лку ме ню и выбе рите пунктAdd to My Content

(«Добавить в мое содержимое»).

Появится диалоговое окно Add to My Content («Добавить в «Мое содержимое») .

3. Найдите и выде лите элеме нт, который вы хотите добавить в гале рею.

4. Нажмите кнопку Open («Открыть»).

NOTE

По умолчанию SMART Notebook присваивае т новому элеме нту гале ре и имя на основе
исходного име ни ф айла . Если вы хотите изме нить имя элеме нта , выде лите эскиз
элеме нта гале ре и, нажмите стре лку ме ню и выбе рите пунктRename

(«Переименовать»).
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Организ ация соде ржимого в Гале ре е
При добавле нии объе ктов, страниц и подде рживаемыхф айлов в кате горию гале ре и "Мое
соде ржимое ", вам може т понадобиться ре организовать структуру кате гории. Вы може те
создавать подкате гории и пе ремещать элеме нты гале ре и между подкате гориями.

Для создания подкатегории выполните следующее:

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Выбе рите кате гориюMy Content («Мое содержимое») (или одну из е е подкате горий) в
списке кате горий гале ре и, нажмите стре лку ме ню и выбе рите New Folder («Новая

папка»).

Появится новая подкате гория.

3. Вве дите новое имя подкате гории и нажмите ENTER.

Переименование подкатегории:

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Выбе рите My Content («Мое содержимое») в списке кате горий гале ре и и пе ре йдите к
подкате гории, которую тре буе тся пе ре име новать .

3. Выде лите подкате горию, нажмите на стре лку е е ме ню и выбе рите Rename

(«Переименовать»).

4. Вве дите новое имя подкате гории и нажмите ENTER.

Перемещение элемента Галереи в другую подкатегорию:

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Пере йдите к кате гории, соде ржащей элеме нт гале ре и, который вам нужно пе реме стить .

Буде т выве де но соде ржимое кате гории.

3. Пере тащите элеме нт в другую подкате горию.
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Предоставление другим учите лям доступа к соде ржимому
Импортирование и экспортирование ф айлов колле кций— это иде альный способ поде литься
своими пользовате льскими кате гориями с другими учите лями и использовать кате гории,
созданные другими учите лями. Вы може те использовать ф айлы колле кций, чтобы добавлять
элеме нты в кате горию "Мое соде ржимое " гале ре и. После импортирования ф айла колле кции
все е го элеме нты появляются в новой подкате гории гале ре и.

Импортирование файла коллекции другого учителя

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Выбе рите кате гориюMy Content («Мое содержимое») (или одну из е е подкате горий) в
списке кате горий гале ре и, нажмите стре лку ме ню и выбе рите пунктAdd to My Content

(«Добавить в «Мое содержимое»).

Появится диалоговое окно Add to My Content («Добавить в «Мое содержимое») .

3. Пере йдите к папке , соде ржащей ф айл колле кции, который вам нужно импортировать .

NOTE

Файл колле кции име е т расшире ние *.gallery.

4. Выде лите ф айл колле кции и нажмите Open («Открыть»).

Колле кция появится в новой подкате гории.

Экспортирование файла коллекции для предоставления общего доступа другим

учителям

1. Выде лите кате горию, соде ржащую элеме нты, которые вы хотите сохранить в колле кции.

NOTE

SMART Notebook экспортируе т выбранную кате горию, но не экспортируе т е е
подкате гории.

2. Нажмите на стре лку ме ню кате гории и выбе рите Export as Collection File

(«Экспортировать как файл коллекции»).

Появится диалоговое окно Save As («Сохранить как»).

3. Выбе рите папку, в которую сле дуе т сохранить ф айл колле кции.

4. Вве дите имя ф айла в поле File name («Имя файла») .

5. Нажмите &quot;Сохранить&quot;.
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Подключение к кате гориям группового соде ржимого
С помощью кате горий "Групповое соде ржимое " можно подключиться к соде ржимому
Гале ре и в общей се те вой папке вашей школы. Кодной папке могут подключаться не сколько
учите ле й. SMART Notebook автоматиче ски де лае т ваши изме не ния доступными другим
учите лям.

NOTE

Ккате гории "Соде ржимое для группы" у вас имеются такие же права доступа , как к
се те вым папкам вашей школы. Если вы име е те полный доступ к се те вой папке , вы може те
добавлять и удалять элеме нты в кате гории "Соде ржимое для группы" этой папки. Однако
е сли вы име е те доступ только для чте ния, вы сможе те копировать ф айлы из кате гории
"Соде ржимое для группы", но не сможе те добавлять , ре дактировать или удалять элеме нты.

Подключение к категории «Содержимое для группы»:

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Нажмите Show additional Gallery actions («Показать дополнительные операции

Галереи») , а з атем выбе рите Connect to Team Content («Подключение к папке

«Содержимое для группы»).

Появится диалоговое окноBrowse For Folder («Обзор папок»).

3. Найдите и выде лите папку, соде ржащую кате горию Team Content («Соде ржимое для
группы»), к которой вы хотите подключиться, и нажмите ОК.

ВГале ре е появится кате гория "Соде ржимое для группы".

Добавление материалов в категорию «Содержимое для группы»:

Мате риалы в кате горию «Соде ржимое для группы» добавляются так же , как и в
кате горию «Мое соде ржимое » (см. Добавление содержимого в Галерею на
странице  112).
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Предоставление общего доступа к
содержимому с помощью веб-сайта
SMART Exchange
Уче бными мате риалами и ф айлами *.notebook можно обме ниваться не только с колле гами в
пре де лах одной школы (см. разде л Предоставление другим учителям доступа к

содержимому на странице  115), но и с учите лями по всему миру, используя ве б -сайт
SMART Exchange (exchange.smarttech.com).

Предоставление доступа к файлу *.notebook на веб-сайте SMART Exchange:

1. Откройте ф айл *.notebook, к которому хотите открыть доступ.

2. Выбе рите File &gt; Share on SMART Exchange («Файл» &gt; «Совместно использовать

на сервере SMART Exchange»).

Появится диалоговое окно .

3. Если вы не заре гистрированы на ве б -сайте SMART Exchange, нажмите Join for free!

(Зарегистрироваться бесплатно) и сле дуйте инструкциям на экране , чтобы создать
уче тную запись .

ИЛИ

Если у вас уже е сть уче тная запись , вве дите свой адре с эле ктронной почты в поле Email

Address («Адрес электронной почты») и свой пароль в поле Password («Пароль») , а
з атем нажмите Sign In («Вход»).

TIPS

o Если вы забыли свой пароль , нажмите Forgot your password («&quot;Забыли

пароль?») и сле дуйте инструкциям на экране , чтобы сбросить пароль .

o Чтобы не вводить данные уче тной записи ве б -сайта SMART Exchange каждый раз
при публикации мате риалов, установите ф лажок Keep me signed in (Оставаться в

системе).

http://exchange.smarttech.com/
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4. Вве дите соотве тствующую инф ормацию:

Управление Инструкции

Введите подробные
сведения о ресурсе

Вве дите заголовок для ф айла *.notebook.

Описание Вве дите описание ф айла *.notebook.

Предмет(-ы) Выбе рите пре дме ты, при изуче нии которых можно
использовать данный ф айл *.notebook.

Класс(-ы) Выбе рите классы, при обуче нии которых можно
использовать данный ф айл *.notebook.

Ключевые слова Вве дите слова или ф разы, которые могут вводить другие
пользовате ли SMART Exchange для поиска данного ф айла
*.notebook. Слова или ф разы разде ляйте запятыми.

5. Прочитайте соглашение о совме стном использовании ре сурсов.

6. Если вы согласны с условиями этого соглашения, нажмите Agree and Submit («Согласен

и принимаю условия»).
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Chapter 7: Создание учебных заданий

Использование расшире нныхф ункций объе ктов 120
Создание пользовате льских стиле й художе стве нного пе ра 120
Добавле ние ссылок к объе ктам 122
Добавле ние звуков к объе ктам 124
Добавле ние анимации к объе ктам 126

Использование расшире нныхф ункций страницы 126
Отображение границ страниц учащихся 126
Запись страниц с помощью сре дства записи уроков 127
Примене ние ф онов и тем к страницам 129

Примене ние тем с помощью вкладки "Свойства" 129
Примене ние ф она и тем с помощью гале ре и 132

Создание тем 133
Создание приме ров уче бных заданий 134

Создание уче бного задания на соотве тствие 134
Создание уче бных занятий типа «скрыть/показать» 136
Создание уче бного задания на посте пе нное открытие 139
Создание других типов уче бных заданий 141

ПО SMART Notebook позволяе т не только пре дставлять инф ормацию учащимся, но и
привле кать их к проце ссу обуче ния с помощью инте рактивных уче бных занятий.

Во время создания уче бных занятий можно добавлять в них такие объе кты, как ф игуры,

изображе ния и таблицы, и использовать такие ф ункции, как масте р создания занятий и же ст
масштабирования.

Вэтом разде ле описываются дополните льные ф ункции, которые вы може те использовать
для создания уче бных занятий, и указаны способы создания наборов приме ров уче бных
занятий. Вы може те использовать эти приме ры уче бных занятий или разработать свои
собстве нные . Кроме того , можно использовать мате риалы и ре сурсы гале ре и и ве б -сайта
SMART Exchange.
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Использование расширенных функций
объектов
При создании уче бных занятий вы може те использовать сле дующие расшире нные ф ункции
объе ктов:

l Пользовате льские стили художе стве нного пе ра

l Ссылки на объе кты

l Звуки объе ктов

l Анимация объе ктов

l Добавле ние ссылки на инструме нт для объе кта

Также объе кты можно блокировать , е сли вы не хотите , чтобы они пе ремещались или
изме нялись в проце ссе пре зе нтации уче бных занятий.

Создание польз овате льских стилей художе ственного пе ра
ПО SMART Notebook соде ржит восемь различных стиле й художе стве нного пе ра (см.

Написание или рисование цифровыми чернилами на странице  34). Вдополне нии к этим
стилям вы може те создавать свои собстве нные стили, используя изображе ния или объе кты
выбранной страницы.

Создание пользовательского стиля художественного пера с помощью изображений

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Creative Pen («Художественное

перо»).

3. Выбе рите тип линии.

4. Если вкладка Properties («Свойства») не отображае тся, нажмите Properties («Свойства»)

.

5. Выбе рите &quot;Тип линии&quot;.

6. Выбе рите Use a custom stamp image («Использовать пользовательское изображение

для клонирования»).

7. Нажмите кнопку Browse («Обзор»).

Появится диалоговое окно Insert Image File («Вставить файл изображения»).
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8. Найдите и выде лите изображе ние , которое хотите использовать для создания стиля
художе стве нного пе ра .

9. Нажмите кнопку Open («Открыть»).

10. Пишите или рисуйте на странице циф ровыми че рнилами.

TIP

o Для восстановле ния стиля, созданного на основе типа линий по умолчанию,

выбе рите Use the default pattern («Использовать узор по умолчанию»).

o Если вы хотите сохранить созданный пользовате льский стиль художе стве нного
пе ра для после дующе го использования, нажмите Save Tool Properties

(«Сохранить свойства инструмента»). Позже настройки стиля художе стве нного
пе ра можно буде т сбросить (см. Настройка панели инструментов на
странице  233).

Создание пользовательского стиля художественного пера с помощью объектов

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Creative Pen («Художественное

перо»).

3. Если вкладка Properties («Свойства») не отображае тся, нажмите Properties («Свойства»)

.

4. Выбе рите &quot;Тип линии&quot;.

5. Выбе рите Use a custom stamp image («Использовать пользовательское изображение

для клонирования»).

6. Нажмите Select object («Выбрать объект»), з атем выде лите нужный объе кт на странице .

7. Пишите или рисуйте на странице циф ровыми че рнилами.

TIP

o Для восстановле ния стиля, созданного на основе типа линий по умолчанию,

выбе рите Use the default pattern («Использовать узор по умолчанию»).

o Если вы хотите сохранить созданный пользовате льский стиль художе стве нного
пе ра для после дующе го использования, нажмите Save Tool Properties

(«Сохранить свойства инструмента»). Позже настройки стиля художе стве нного
пе ра можно буде т сбросить (см. Настройка панели инструментов на
странице  233).
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Добавление ссылок к объе ктам
Вы може те связать любой объе кт на странице с ве б -странице й, другой странице й ф айла ,
ф айлом на компьюте ре или с вложением. Вложение пре дставляе т собой копию ф айла , ярлык
ф айла или ссылку на ве б -страницу, добавле нные на вкладку "Вложения".

NOTE

Вы може те отобразить анимированные индикаторы ссылок вокруг все х ссылок на
странице (см. Отображение ссылок на странице  186).

Добавление ссылок на веб-страницу:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Link («Ссылка»).

Появится диалоговое окно Insert Link («Вставить ссылку»).

3. Нажмите Web Page (Веб-страница), з атем вве дите адре с ве б -страницы в поле Address

(Адрес).

4. Если вы хотите открывать ссылку, нажимая на значок, выбе рите Corner icon («Угловой

значок»).

ИЛИ

Если вы хотите открывать ссылку, нажимая в любом ме сте объе кта , выбе рите пункт
Object («Объект»).

5. Нажмите OK.

Если вы выбрали вариантCorner icon («Угловой значок»), в нижнем ле вом углу объе кта

появится значок .

Добавление ссылки на другую страницу файла:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Link («Ссылка»).

Появится диалоговое окно Insert Link («Вставить ссылку»).

3. Нажмите Page in this File (Страница в этом файле), з атем выбе рите параме тр в поле
Select a page (Выбрать страницу).
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4. Если вы хотите открывать ссылку, нажимая на значок, выбе рите Corner icon («Угловой

значок»).

ИЛИ

Если вы хотите открывать ссылку, нажимая в любом ме сте объе кта , выбе рите пункт
Object («Объект»).

5. Нажмите OK.

Если вы выбрали вариантCorner icon («Угловой значок»), в нижнем ле вом углу объе кта

появится значок .

Добавить ссылку на файл на вашем компьютере:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Link («Ссылка»).

Появится диалоговое окно Insert Link («Вставить ссылку»).

3. Нажмите File on this Computer (Файл на этом компьютере), з атем выбе рите
ме стоположение ф айла и вве дите е го имя в поле File (Файл).

4. Если вы хотите прикре пить копию ф айла , выбе рите Copy of file («Копия файла»).

ИЛИ

Если нужно вставить ярлык ф айла , выбе рите Shortcut to file («Ярлык файла»).

5. Если вы хотите открывать ссылку, нажимая на значок, выбе рите Corner icon («Угловой

значок»).

ИЛИ

Если вы хотите открывать ссылку, нажимая в любом ме сте объе кта , выбе рите пункт
Object («Объект»).

6. Нажмите OK.

Если вы выбрали вариантCorner icon («Угловой значок»), в нижнем ле вом углу объе кта

появится значок .

Добавление ссылки к вложению:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Link («Ссылка»).

Появится диалоговое окно Insert Link («Вставить ссылку»).
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3. Нажмите Current Attachments («Текущие вложения»), з атем выбе рите вложение из
списка .

4. Если вы хотите открывать ссылку, нажимая на значок, выбе рите Corner icon («Угловой

значок»).

ИЛИ

Если вы хотите открывать ссылку, нажимая в любом ме сте объе кта , выбе рите пункт
Object («Объект»).

5. Нажмите OK.

Если вы выбрали вариантCorner icon («Угловой значок»), в нижнем ле вом углу объе кта

появится значок .

Удаление ссылки:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Link («Ссылка»).

Появится диалоговое окно Insert Link («Вставить ссылку»).

3. Нажмите Remove Link («Удалить ссылку»).

Добавление з вуков к объе ктам
Клюбому объе кту (кроме ф айлов и видже тов, совме стимых с пле е ром Adobe Flash) можно
добавить звук в виде звукового ф айла или звуковой записи, созданной с помощью
микроф она компьюте ра . Вы може те воспроизве сти звук в ходе урока , нажав на значок в
углу объе кта или на сам объе кт.

NOTE

SMART Notebook подде рживае т ф ормат звука MP3. Если вы хотите , чтобы программное
обе спе че ние SMART Notebook подде рживало другие типы ф айлов, вы може те установить
дополните льные кодировщики (см. Установка кодировщиков для дополнительных

форматов на странице  98).

Добавление аудио-файла к объекту:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Sound («Звук»).

Появится диалоговое окно Insert Sound («Вставить звук»).
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3. Нажмите &quot;Обзор&quot;.

Появится диалоговое окно Insert File («Вставить файл»).

4. Найдите и выде лите аудио -ф айл, з атем нажмите Open («Открыть»).

5. Выбе рите опцию Corner Icon («Угловой значок») , е сли вы хотите воспроизводить
звуковой ф айл при нажатии на значок в нижнем ле вом углу объе кта .

ИЛИ

Выбе рите опциюObject («Объект») , е сли вы хотите воспроизводить аудио -ф айл при
нажатии на любое ме сто объе кта .

6. Нажмите Attach Sound («Вложить звук»).

Добавление записанного звука к объекту:

1. Подключите микроф он к компьюте ру и включите е го .

2. Выбе рите объе кт.

3. Нажмите на стре лку ме ню объе кта и выбе рите Sound («Звук»).

Появится диалоговое окно Insert Sound («Вставить звук»).

4. Нажмите Start Recording («Начать запись»).

5. Создайте запись с помощью микроф она .

IMPORTANT

ПО SMART Notebook останавливае т з апись че ре з минуту. Убе дите сь , что ваша запись
длится не боле е минуты.

6. Нажмите Stop Recording («Остановить запись»).

7. Вве дите имя записи в поле Recording name (Имя записи).

8. Или нажмите Preview Recording («Прослушать запись») , чтобы прослушать звук пе ре д
добавле нием е го к объе кту.

9. Выбе рите опцию Corner Icon («Угловой значок») , е сли вы хотите воспроизводить
звуковой ф айл при нажатии на значок в нижнем ле вом углу объе кта .

ИЛИ

Выбе рите опциюObject («Объект») , е сли вы хотите воспроизводить аудио -ф айл при
нажатии на любое ме сто объе кта .

10. Нажмите кнопку Attach Recording («Вложить запись»).
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Удаление звука объекта:

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите Sound («Звук»).

Появится диалоговое окно Insert Sound («Вставить звук»).

3. Нажмите кнопку Remove Sound («Удалить звук»).

Добавление анимации к объе ктам
Вы може те добавить анимацию к объе кту, чтобы он выле тал на страницу сбоку, вращался,
возникал посте пе нно , сжимался и др . Вы може те задать з апуск анимации при открытии
страницы или при нажатии на объе кт.

Добавление анимации к объекту:

1. Выбе рите объе кт.

2. Если вкладка Properties («Свойства») не отображае тся, нажмите Properties («Свойства»)

.

3. Нажмите Object Animation («Анимация объекта»).

4. Выбе рите параме тры в выпадающих списках Type (Тип), Direction (Направление), Speed

(Скорость), Occurs (События) и Repeats (Повторы).

Использование расширенных функций
страницы
При создании уче бных занятий вы може те использовать сле дующие расшире нные ф ункции
страницы:

l Границы страниц учащихся

l Запись страницы

l Фоны и темы для страниц

Отображение границ страниц учащихся
Если учащие ся используют для отве тов на вопросы и сдачи экзаме нов ПО SMART Notebook

SE (Student Edition), вам може т пригодиться возможность создания страниц с вопросами для
отображе ния границы страницы учащихся, показывающей область страницы, которая буде т
видна на экранах компьюте ров учащихся.
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NOTE

Эта проце дура приме нима , е сли вы используе те ПО SMART Response в режиме CE.

Отображение границ страниц учащихся

1. Выбе рите View &gt; Alignment («Вид» &gt; «Выравнивание»).

Появится диалоговое окноAlignment («Выравнивание»).

2. Нажмите Student Page Border («Границы страниц учащихся»).

3. Установите ф лажок Show a border around the area that will be visible in SMART Notebook

SE during an assessment (Показать границу вокруг области, которая будет

отображаться в SMART Notebook SE во время выполнения экзамена).

4. Выбе рите параме тр Preset value («Предустановленное значение»)и выбе рите
разрешение экрана в выпадающем списке .

ИЛИ

Выбе рите Custom value («Пользовательское значение»), в соотве тствующих полях
вве дите значе ния ширины и высоты экранов учащихся.

5. Нажмите OK.

Вокруг области, которую смогут увиде ть на своих экранах компьюте ров учащие ся,
появится цве тная граница .

Запись страниц с помощью средства з аписи уроков
Надстройка "Сре дство записи уроков" позволяе т з аписывать де йствия, сове ршаемые вами
на странице . Впосле дствии вы може те воспроизве сти запись на той же странице с помощью
сре дства записи уроков или нового видже та воспроизве де ния.

NOTE

Сре дство записи SMART пре дставляе т собой пре дыдущий инструме нт, но с новыми
возможностями. При использовании сре дства з аписи SMART вы може те записывать свой
де йствия в программах, отличных отSMART Notebook. При использовании сре дства з аписи
SMART вы може те ве сти запись все го экрана , указанного окна или прямоугольного
участка экрана . Если вы подключите к компьюте ру микроф он, вы также сможе те
записывать аудио .

Дополните льную инф ормацию см. в разде ле Работа со средством записи SMART на
странице  200.
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Запись страницы

1. Нажмите кнопку &quot;Надстройки&quot; , з атем нажмите &quot;Средство записи

уроков&quot;.

2. Нажмите кнопку &quot;Новая запись&quot;.

По пе риме тру записываемой страницы отображае тся граница красного цве та .

3. Выполните на те кущей странице де йствия, которые тре буе тся записать .

4. После выполне ния этих де йствий нажмите Stop Recording (Остановить запись).

TIPS

o Чтобы сохранить запись , просто сохраните ф айл .notebook.

o Закройте надстройку "Сре дство записи уроков" на время прове де ния
пре зе нтаций. Видже т воспроизве де ния буде т отображаться в нижне й части
страницы.Можно разблокировать е го и пе реме стить в любое ме сто на странице .

o Запись со страницы удалить не возможно .

Воспроизведение записи страницы с помощью надстройки &quot;Средство записи

уроков&quot;

1. Откройте записанную вами страницу.

2. Если надстройка &quot;Сре дство записи уроков&quot; з акрыта , нажмите кнопку

&quot;Надстройки&quot; , з атем нажмите &quot;Средство записи уроков&quot;.

3. Нажмите кнопку &quot;Воспроизведение&quot; на пане ли воспроизве де ния

Вы може те пе ре ключаться между режимами воспроизведения и паузы в
проце ссе воспроизве де ния записи.

4. Дополните льно можно выполнить сле дующие де йствия:

o Нажмите кнопку &quot;Перемотка назад&quot; для пе ремотки записи назад.

o Нажмите кнопку &quot;Перемотка вперед&quot; для пе ремотки записи
впе ре д.
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Воспроизведение записи страницы с помощью виджета воспроизведения

1. Откройте записанную вами страницу.

2. Если надстройка Lesson Recorder («Сре дство записи уроков») открыта , нажмите кнопку

в строке ме ню надстрое к, чтобы закрыть е е .

Видже т воспроизве де ния буде т отображаться в нижне й части страницы.

TIPS

Можно разблокировать и пе ремещать видже т по странице , чтобы к нему можно было
ле гко получить доступ в ходе пре зе нтации.

3. Нажмите кнопку &quot;Воспроизведение&quot; в видже те воспроизве де ния.

Вы може те пе ре ключаться между режимами воспроизведения и паузы в
проце ссе воспроизве де ния записи.

4. Дополните льно можно выполнить сле дующие де йствия:

o Нажмите кнопку &quot;Перемотка назад&quot; для пе ремотки записи назад.

o Нажмите кнопку &quot;Перемотка вперед&quot; для пе ремотки записи
впе ре д.

Применение фонов и тем к страницам
Фон страницы можно приме нить с помощью вкладки "Свойства" или гале ре и.

Применение тем с помощью вкладки "Свойства"
С помощью вкладки "Свойства" можно приме нить ф он страницы в виде одного цве та ,
градие нтного смешения двух цве тов, узора или изображе ния.

Применение фона:

1. Выбе рите Format &gt; Page &gt; Set Background Fill («Формат» &gt; «Страница» &gt;

«Установить заливку фона»).

На вкладке Properties (Свойства ) будут отображаться параме тры Fill Effects (Эффекты
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заливки).
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2. Выбе рите тип заливки

Тип заливки Порядок действий

Бе з з аливки
(прозрачный)

Выбе рите No fill («Без заливки»).

Сплошная заливка a. Выбе рите Solid fill («Сплошная заливка»).

b. Выбе рите один из сле дующих вариантов:
o Выбе рите один из 40 цве тов палитры.

o Нажмите More («Еще»)и выбе рите тре буемый цве т в
диалоговом окне .

o Нажмите пипе тку и выбе рите цве т на экране .

Градие нт из двух
цве тов

a. Выбе рите Gradient fill («Градиентная заливка»).

b. Для каждого цве та выполните одно из сле дующих де йствий:
o Выбе рите один из 40 цве тов палитры.

o Нажмите More («Еще»)и выбе рите тре буемый цве т в
диалоговом окне .

o Нажмите пипе тку и выбе рите цве т на экране .
c. Выбе рите нужный параме тр из выпадающе го списка Style

(Стиль).

Заливка узором a. Выбе рите Pattern fill («Заливка по шаблону»).

b. Выбе рите узор .

c. Нажмите Foreground color («Цвет переднего плана»),
выбе рите в диалоговом окне тре буемый цве т, з атем
нажмите «OK».

d. Нажмите Background color («Цвет фона»), выбе рите в
диалоговом окне тре буемый цве т, з атем нажмите «OK».

Рисунок a. Выбе рите Image fill («Заливка изображением»).

b. Нажмите &quot;Обзор&quot;.

Появится диалоговое окно Insert Image File («Вставить файл
изображения»).

c. Найдите и выде лите изображе ние , которое вы хотите
использовать в каче стве ф она , и нажмите Open
(«Открыть»).

NOTE

При вставке большого изображе ния може т открыться
диалоговое окно с пре дложением уменьшить разме р
ф айла изображе ния либо оставить е го бе з изме не ний.
Дополните льную инф ормацию см. в разде ле Настройка
параметров оптимизации изображения на странице  237.
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Удалениефона:

1. Выбе рите Format &gt; Page &gt; Set Background Fill («Формат» &gt; «Страница» &gt;

«Установить заливку фона»).

На вкладке Properties (Свойства ) будут отображаться параме тры Fill Effects (Эффекты

заливки).

2. Выбе рите No fill («Без заливки»).

Применение фона и тем с помощью галереи
Можно настроить страницу, все страницы группы или все страницы ф айла , используя ф он или
тему из гале ре и.

Применение фонового рисунка или темы:

1. Если гале ре я не отображае тся, нажмите Gallery («Галерея» .

2. Выбе рите My Content («Мое содержимое») в списке кате горий гале ре и, чтобы
просмотре ть ф оновые рисунки и темы, созданные или импортированные вами (см.

Создание тем на противоположной странице ).

ИЛИ

Выбе рите Gallery Essentials («Основные темы галереи») , чтобы просмотре ть ф оны и
темы, установле нные с ПО.

3. Выбе рите Backgrounds and Themes («Фоны и темы»).

Вгале ре е отображаются эскизы имеющихся ф оновых рисунков и тем.

4. Нажмите на эскиз темы, которую вы хотите приме нить .

5. Нажмите на стре лку ме ню этого эскиза и выбе рите пункт Insert in Notebook («Вставить

в Notebook»).

Появится диалоговое окно Insert Theme («Вставить тему»).

6. Выбе рите Insert theme on all pages («Вставить тему на всех страницах») , чтобы
применить ф он или тему ко всем страницам в ф айле .

ИЛИ

Выбе рите Insert theme on all pages of current group («Вставить тему на всех страницах

текущей группы») , чтобы применить ф он или тему ко всем страницам в те кущей группе .

ИЛИ

Выбе рите Insert theme on current page only («Вставить тему только на текущей
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странице») , чтобы применить ф он или тему только к те кущей странице .

7. Нажмите OK.

Удалениефонового рисунка или темы:

1. Выполните ще лчок правой кнопкой на странице .

2. Выбе рите Remove Theme («Удалить тему»).

3. Выбе рите From All Pages («Со всех страниц») , чтобы удалить ф он или тему со все х
страниц, к которым они была приме не ны.

ИЛИ

Выбе рите From Page («Со страницы») , чтобы удалить ф он или тему только с выбранной
страницы.

Создание тем
Вы може те использовать темы для настройки страниц. Вы може те создать тему и добавить е е
в гале рею, чтобы она находилась в удобном для вас ме сте . Затем вы може те приме нить эту
тему к странице , ко всем страницам группы или ко всем страницам ф айла .

Вгале ре е также соде ржится не сколько тем.

Создание темы

1. Выбе рите Format &gt; Theme &gt; Create New Theme («Формат» &gt; «Тема» &gt;

«Создать новую тему».

2. Вве дите название темы в поле Theme name (Название темы).

3. Задайте ф он таким же образом, как для страницы (см. Применение фонов и тем к

страницам на странице  129).

4. Добавьте и отре дактируйте объе кты темы таким же образом, как это де лае тся на
странице (см. Chapter 4: Создание основных объектов на странице  33).

5. Нажмите &quot;Сохранить&quot;.

Тема отобразится в кате горииMy Content («Мое содержимое») гале ре и.

Создание темы на основе текущей страницы

1. Выбе рите Format &gt; Theme &gt; Create New Theme From Page («Формат» &gt; «Тема»

&gt; «Создать тему на основе страницы»).

2. Вве дите название темы в поле Theme name (Название темы).
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3. Нажмите &quot;Сохранить&quot;.

Тема отобразится в кате горииMy Content («Мое содержимое») гале ре и.

Создание примеров учебных заданий
Вэтом разде ле пре дставле ны ме тоды создания уче бных занятий с использованием
приме ров и соде ржатся све де ния о том, как создавать другие типы уче бных занятий.

Создание учебного з адания на соотве тствие

NOTE

Для создания уче бных занятий на соотве тствия нужно уме ть :

l Использование конструктора занятий

l Добавле ние звуков к объе ктам (см. Добавление звуков к объектам на странице  124)

Конструктор занятий позволяе т создавать з адания на соотве тствие , классиф икацию,

пе ре таскивание ме ток, игры и другие занятия с использованием собстве нныхмате риалов.

Используя Конструктор занятий, можно сде лать один из объе ктов на странице объе ктом
задания. После че го нужно буде т опре де лить , какие из объе ктов на странице будут
приниматься при пе ре таскивании на объе кт задания, а какие — отклоняться.

Создание учебного задания на соответствие:

1. Создайте объе кт, который хотите использовать как объе кт задания, а з атем создайте
объе кты, которые будут приниматься или отклоняться при пе ре таскивании на уже
созданный объе кт задания.

2. Нажмите Add-ons («Надстройки») , з атем выбе рите Activity Builder («Конструктор

занятий»).

3. Выбе рите объе кт, который хотите использовать как объе кт задания, з атем нажмите Edit

(«Правка»).

4. Пере тащите в список Accept these objects («Принять эти объекты») объе кты, которые
будут приняты.

Рядом с объе ктами, которые будут приняты, появится значок зе ле ной галочки .
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5. Пере тащите в список Reject these objects («Отклонить эти объекты») объе кты, которые
будут отклоне ны.

Рядом с объе ктами, которые будут отклоне ны, появится значок красного кре стика .

NOTES

o Для быстрого выбора и добавле ния все х оставшихся объе ктов на странице в
список принимаемых или отклоняемых объе ктов нажмите в соотве тствующем
списке Add All Remaining (Добавить все оставшиеся).

o Для удале ния объе кта из списка пе ре тащите е го на значок корзины .

6. Нажмите &quot;Готово&quot;.

Изменение настроек учебного задания на соответствие:

1. Нажмите Add-ons («Надстройки») , з атем выбе рите Activity Builder («Конструктор

занятий»).

2. Выбе рите объе кт задания, з атем нажмите Edit («Правка»).

TIP

Если не знае те , какой из объе ктов на странице являе тся объе ктом задания, нажмите
Identify («Идентификация»). На экране , пове рх каждого объе кта з адания на странице
появятся диагональные линии сине го цве та , которые исче знут че ре з три се кунды.

3. Нажмите кнопку Settings («Настройки»).

4. Выбе рите нужный вариант анимации для принимаемых объе ктов в пе рвом выпадающем
списке Animation (Анимация).

5. Дополните льно можно установить ф лажок Also play the object’s sound («Также

воспроизвести звуковое сопровождение объекта») , чтобы при пе ре таскивании
принимаемого объе кта на объе кт-з адание воспроизводить включе нное в этот объе кт
звуковое сопровожде ние (см. Добавление звуков к объектам на странице  124).

6. Выбе рите нужный вариант анимации для отклоняемых объе ктов в пе рвом выпадающем
списке Animation (Анимация).

7. Дополните льно можно установить ф лажок Also play the object’s sound («Также

воспроизвести звуковое сопровождение объекта») , чтобы при пе ре таскивании
отклоняемого объе кта на объе кт задания воспроизводить включе нное в этот объе кт
звуковое сопровожде ние (см. Добавление звуков к объектам на странице  124).

8. Нажмите &quot;Готово&quot;.
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Презентация учебного задания на соответствие:

1. Пере тащите объе кты на объе кт задания (или попросите учащихся сде лать это ).

o Вслучае принятия объе кта буде т воспроизве де на анимация для принятых объе ктов
(по умолчанию исче знове ние ).

o Вслучае отклоне ния объе кта буде т воспроизве де на анимация для отклоне нных
объе ктов (по умолчанию возврат назад).

2. Нажмите Add-ons (Надстройки) , з атем Activity Builder (Конструктор занятий), а
после заве ршения — Reset All (Сбросить все).

Удаление учебного задания на соответствие:

1. Нажмите Add-ons («Надстройки») , з атем выбе рите Activity Builder («Конструктор

занятий»).

2. Выбе рите объе кт задания, з атем нажмите Clear Properties («Очистить свойства»).

Создание учебных з анятий типа «скрыть/показ ать»

NOTE

Сле дующие задачи не обходимо выполнить при создании уче бных занятий типа
"скрыть/показать":

l Перемещение объе ктов (см. Перемещение объектов на странице  71)

l Блокировка объе ктов (см. LockingObjects.htm)

l Измене ние разме ра объе ктов с помощью же ста масштабирования (см.

Использование жеста масштабирования на странице  80)

Можно скрыть объе кт, з атем посте пе нно отобразить е го с помощью сле дующих способов:

l Добавьте на страницу зате не ние экрана . Входе пре зе нтации посте пе нно удаляйте
зате не ние , открывая те кст и граф ику по ме ре готовности к их обсужде нию (см.

UsingTheScreenShade.htm).

l Закрывайте объе кты слоем циф ровых че рнил, а з атем стирайте че рнила (см. Написание,

рисование и стирание цифровых чернил на странице  34).

l Закрывайте объе кты другими объе ктами, а з атем изме няйте порядок расположения
объе ктов в сте ке (см. Изменение порядка объектов в стеке на странице  75).

l Используйте анимацию объе ктов (см. Добавление анимации к объектам на
странице  126).
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Или можно скрыть объе кт за з аблокированным объе ктом, з атем с помощью же ста
масштабирования уве личить и показать скрытый объе кт, е сли вы работае те с инте рактивным
продуктом SMART, который подде рживае т множе стве нные касания.

Создание учебного занятия типа «скрыть/показать»:

1. Создайте или вставьте объе кт, который нужно скрыть .

2. Создайте или вставьте объе кт, который нужно заблокировать .
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3. Переме стите объе кт, который нужно заблокировать , так, чтобы он находился пове рх
объе кта , который нужно скрыть .

4. Выбе рите объе кт, который нужно заблокировать , нажмите стре лку е го ме ню и выбе рите
Locking &gt; Lock in Place («Блокировать» &gt; «Блокировать на месте»).

5. Используйте же ст масштабирования для уве личе ния и отображения скрытого объе кта
при блокировке объе кта на ме сте (см. Использование жеста масштабирования на
странице  80).
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Создание учебного з адания на постепенное открытие

NOTE

Для создания уче бных занятий на посте пе нное открытие нужно уме ть :

l Создание таблиц (см. Создание таблиц на странице  50)

l Измене ние разме ров яче е к (см. Изменение размеров таблиц, столбцов или строк на
странице  59)

l Установка изображе ния в каче стве ф она таблицы (см. Изменение свойств таблицы на
странице  55)

l Добавле ние объе ктов в яче йки (см. Добавление объектов в таблицы на странице  52)

l Добавле ние и удале ние зате не ния яче е к (см. Использование затенения ячеек на
странице  190)

Таблицы и зате не ния яче е к можно использовать для создания различных уче бных занятий на
посте пе нное открытие . Два приме ра таких занятий:

l Уче бное занятие на посте пе нное открытие типа "Составная картинка", когда учите ль по
оче ре ди открывае т части изображе ния до те х пор , пока учащие ся не догадаются, что
изображе но на рисунке .

l Уче бное занятие на посте пе нное открытие типа "Парные картинки", когда учите ль
открывае т соде ржимое яче йки, а учащие ся по оче ре ди выбирают другие яче йки,
пытаясь найти дубликат открытой картинки.
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Создание учебного задания на постепенное открытие «Составная картинка»:

1. Создайте таблицу, соде ржащую столько яче е к, сколько нужно для уче бного задания на
посте пе нное открытие (см. Создание таблиц на странице  50).

2. Измените разме ры яче е к до подходящих (см. Изменение размеров таблиц, столбцов

или строк на странице  59).

3. Выде лите таблицу, нажмите стре лку ме ню этой таблицы, з атем выбе рите Properties

(«Свойства»).

Появится вкладкаProperties («Свойства»).

4. Нажмите кнопку &quot;Эффекты заливки&quot;.

5. Выбе рите Image fill («Заливка изображением»), нажмите Browse («Обзор»), выбе рите
рисунок, который хотите использовать для создания занятия на посте пе нное открытие ,
з атем нажмите Open («Открыть»).

6. Выбе рите Scale image to fit («Масштабировать изображение по размеру»).

7. Нажмите на стре лку ме ню таблицы и выбе рите Add Table Shade («Добавить затенение

таблицы»).

Создание учебного задания на постепенное открытие «Парные картинки»:

1. Добавьте объе кты, которые хотите использовать в данном уче бном занятии.

2. Создайте таблицу, соде ржащую столько яче е к, сколько нужно для уче бного задания на
посте пе нное открытие (см. Создание таблиц на странице  50).

3. Измените разме ры яче е к до подходящих (см. Изменение размеров таблиц, столбцов

или строк на странице  59).

4. Пере тащите объе кты в яче йки таблицы.

5. Нажмите на стре лку ме ню таблицы и выбе рите Add Table Shade («Добавить затенение

таблицы»).

Презентация учебного задания на постепенное открытие

Нажмите на зате не ние одной из яче е к, чтобы открыть соде ржимое этой яче йки.

Для скрытия соде ржимого яче йки за з ате не нием нажмите в углу яче йки.
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Создание других типов учебных з аданий
Инструме нты для уче бных заданий и приме ры уче бных заданий в гале ре е соде ржат
инте рактивные объе кты, которые можно использовать для создания уче бных заданий.
Подробные све де ния об инструме нтах для уче бных заданий, приме рах уче бных заданий и
гале ре е в це лом см. в разде ле Вставка материалов из Галереи на странице  88.

Веб -сайтSMART Exchange соде ржит тысячи уче бных планов, наборов вопросов и проче го
соде ржимого , которое можно загрузить на свой компьюте р , а потом открыть в
SMART Notebook. Для боле е подробной инф ормации о ве б -сайте SMART Exchange см.

страницу Вставка материалов с веб-сайта SMART Exchange на странице  92.
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Создание занятий с помощью конструктора
учебных занятий (LAB)
С помощью конструктора уче бных занятий улучшайте уроки, создавая и добавляя в них
инте рактивные занятия. Такие занятия помогают учащимся запоминать понятия и ф акты,

опре де лять объе кты, изучать словарные опре де ле ния и многое другое .

Выбе рите один из видов заданий:

Speedup (Гонки)

Speedup (Гонки) — это ве се лое занятие , в котором учащие ся могут играть друг с другом в
гонки, отве чая на вопросы. Чем быстре е учащийся дае т правильные отве ты, тем скоре е е го
машина продвигае тся к ф инишу. См. Добавление занятия Speedup (Гонки) на странице  157.

Label Reveal (Открытие подписей)

Label Reveal (Открытие подписе й) — это задание , в котором учащие ся опре де ляют
компоне нты или части изображе ния, выбранного учите лем. См. Добавление занятия Label

Reveal (Открытие подписей) на странице  151.

Flip Out flip cards (Переворачивание карточек)

В задании на пе ре ворачивание карточе к учащие ся пе ре ворачивают карточки (аналогично
дидактиче ским карточкам). Вы може те добавлять те кст или изображе ния как на лице вую, так
и на обратную сторону карточки. Учащие ся пе ре ворачивают карточки по одной, открывая
соде ржимое на обратной стороне . Задание на пе ре ворачивание карточе к развивае т память
и закре пляе т знания. Для создания задания на пе ре ворачивание карточе к см. Добавление

задания на переворачивание карточек на противоположной странице .

Super Sort (Суперсортировка)

В занятии Super Sort (Супе рсортировка ) учащие ся должны рассортировать элеме нты по
кате гориям. Вы задае те кате гории и элеме нты, а з атем оце нивае те знание учащимися
каждой кате гории и элеме нтов, которые в не е входят. Для создания занятия Super Sort

(Супе рсортировка ) см. Добавление суперсортировки на странице  147.

Match ’EmUp! (Найдите соответствие!)
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В заданииMatch ’Em Up! (Найдите соотве тствие !) учащие ся пе ре таскивают и сопоставляют
элеме нты на одной стороне доски с элеме нтами на другой стороне . Это занятие оче нь ле гко
настроить ! Чтобы создать занятие Match ’Em Up! (Найдите соотве тствие !), см. Добавление

занятия Match ‘Em Up! (Найдите соответствие!) на странице  153.

Fill in the Blanks (Заполните пропуски)

В задании Fill in the Blanks (Заполните пропуски) учащие ся пе ре таскивают пропущенное
соде ржимое , чтобы получить грамматиче ски правильные пре дложения или опре де лить части
ре чи. См. Добавление задания на заполнение пропусков на странице  149.

Rank Order (Порядок сортировки)

Учащие ся выполняют задание на порядок сортировки, играя сортируя элеме нты указанным
вами образом. Попробуйте сортировать це лые числа отме ньше го к большему, этапы
проце сса по порядку или другие элеме нты в же лаемой после довате льности. См.

Добавление задания на сортировку на странице  155.

Занятие Shout It Out! (Кричи!) для мобильных устройств

Shout It Out! (Кричи!) — это инструме нт создания мате риалов, с которым учащие ся и учите ля
могут работать в конструкторе уче бных занятий. С помощью мобильных устройств учащие ся
могут быстро создавать и отправлять изображе ния и те ксты в занятия LAB, а учите ля могут
ле гко прове рять мате риалы. См. Добавление задания «Кричи!» на странице  159.

Добавление задания на переворачивание
карточек
При ф ормировании задания на пе ре ворачивание карточе к можно создать сколько угодно
карточе к, а также выбрать различные темы, наприме р «Остров обе зьян», «Джунгли», «Марс»
или «Луна».

Можно просмотре ть занятие в окне Add an Activity (Добавить занятие).

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Открое тся окно Activity Preview («Предварительный просмотр задания») , в котором
буде т указана подробная инф ормация о задании.
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2. Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

Добавление задания на переворачивание карточек:

1. Открое тся окно &quot;Добавить занятие&quot;.

2. Вокне Choose Design Template and Theme («Выбор дизайна шаблона и темы) выбе рите
тему для карточе к. Нажмите на изображе ние нужного эскиза . Вокруг эскиза появится
голубая рамка .

3. Нажмите &quot;Далее&quot;.

Открое тся диалоговое окно Add content (Добавить содержимое).

4. Нажмите на подсве че нные синим кле тки под обратной и лицевой сторонами карточки и
начните пе чатать , чтобы добавить те кст на обе стороны карточки, или же нажмите на
значок каталога , чтобы добавить изображе ние . См. Совет ниже .Можно скопировать или
пе ре тащить элеме нты, связанные с кате горие й, или добавить мате риалы в кате горию из
заране е сохране нного списка . Дополните льные све де ния о добавле нии мате риалов см.

в разде ле Управление материалами в конструкторе учебных занятий на странице  171.

Вы може те создать сколько угодно карточе к. Если вы создадите боле е 12 карточе к, то
дополните льные будут находиться в се ре дине рабоче го стола Notebook, рядом с
колодой отбоя.

Расположение карт выбирае тся наугад.

TIP

Чтобы использовать изображе ние в занятии на пе ре ворачивание карточе к, нажмите
на значок каталога ф айлов в любом списке мате риалов. Выбе рите изображе ние в
нужной папке проводника Windows, нажав Open (Открыть). Изображение появится в
списке для обратной стороны или лицевой стороны и на самих карточках.

5. Нажмите &quot;Далее&quot;.

Появится диалоговое окно Add game components («Добавить игровые компоненты») .

При не обходимости можно выбрать один из игровых компоне нтов. См. Добавление

игровых компонентов в занятия на странице  169.

6. Нажмите &quot;Готово&quot;. LAB создаст з анятие , которое буде т готово к работе
че ре з пару се кунд.
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7. Учащие ся пе ре ворачивают карточки и открывают соде ржимое на обратной стороне .
Наприме р , на обратной стороне карточки може т быть написано run (бежать), а на
лице вой— verb (глагол). После пе ре ворота и обсужде ния карточки е е можно убрать в
колоду сброса .

TIPS

o Можно просмотре ть занятие в ме ню Add an Activity (Добавить занятие).

Нажмите Preview this Activity («Просмотреть это занятие») , чтобы открыть
предварительный просмотрз адания на пе ре ворачивание карточе к.
Пре дварите льный просмотр позволит вам узнать о выбранном задании
дополните льную инф ормацию.

Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

o Нажмите на кнопку Activity Restart («Сброс занятия») , чтобы сбросить
те куще е занятие . Эта кнопка расположена в ве рхнем правом углу открытой
страницы занятия LAB.

o Чтобы открыть окно Add an Activity (Добавить занятие), используйте кнопку

Activity Edit (Редактировать занятие) . Эта кнопка расположена в ве рхнем
правом углу открытой страницы занятия LAB.

o Используйте кнопку звука для включе ния или выключе ния звука в занятии.

Добавление суперсортировки
В занятии Super Sort (Супе рсортировка ) учащие ся должны рассортировать элеме нты в одну
или две кате гории. Элеме нты исче зают, е сли учащийся помещае т их в правильную
кате горию, и появляются снова при не ве рной сортировке . Чтобы занятие стало боле е
увле кате льным, добавьте дополните льные игровые компоне нты.

Можно просмотре ть занятие в окне Add an Activity (Добавить занятие).

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Открое тся окно Activity Preview («Предварительный просмотр задания») , в котором
буде т указана подробная инф ормация о задании.
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2. Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

Чтобы добавить задание на суперсортировку, выполните следующие действия:

1. Чтобы открыть конструктор уче бных занятий, нажмите значок пане ли инструме нтов
на пане ли инструме нтов Notebook. Открое тся окно Add an Activity («Добавить занятие»)

.

2. Найдите в нем задание супе рсортировки и нажмите Add this Activity («Добавить

занятие»).

Открое тся окно Template and Theme (Шаблон и тема).

3. Выбе рите тему супе рсортировки. Выбранное занятие буде т подсве че но синим.

4. Нажмите Next («Далее»).

Открое тся диалоговое окно Add an Activity (Добавить занятие) Manage Lists

(Управление списками).

5. Вполе &quot;Название категории&quot; укажите название , которое буде т
использоваться для данной кате гории.

6. Напишите названия мате риалов в кате гории, пе ре тащите элеме нты сортировки,
связанные с кате горие й, или отре дактируйте их в поле Category Content (Содержимое

категории). Также можно добавить мате риалы кате гории из ране е сохране нного списка
или вставить их из таблицы Excel® или те кстового докуме нта . Дополните льную
инф ормацию о добавле нии мате риала см. в разде ле Управление материалами в

конструкторе учебных занятий на странице  171.

7. Повторите те же де йствия для кате гории справа .

8. Нажмите &quot;Далее&quot;. Появится диалоговое окно &quot;Добавить игровые

компоненты&quot;. При не обходимости можно выбрать один из игровых компоне нтов.
См. Добавление игровых компонентов в занятия на странице  169.

9. Нажмите &quot;Готово&quot;.

LAB создаст з анятие , которое буде т готово к работе че ре з пару се кунд.
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TIPS

l Можно просмотре ть занятие в ме ню Add an Activity (Добавить занятие).

Нажмите Preview this Activity («Просмотреть это занятие») , чтобы открыть
предварительный просмотрз адания супе рсортировки. Пре дварите льный просмотр
позволит вам узнать о выбранном задании дополните льную инф ормацию.

Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

l Используйте кнопку &quot;Сброс занятия&quot; , чтобы сбросить те куще е
занятие . Эта кнопка расположена в ве рхнем правом углу страницы занятия LAB.

l Чтобы открыть окно Add an Activity (Добавить занятие), используйте кнопку Activity

Edit (Редактировать занятие) .Эта кнопка расположена в ве рхнем правом углу
страницы занятия LAB.

l Используйте кнопку звука для включе ния или выключе ния звука в занятии.

Добавление задания на заполнение
пропусков
Fill In the Blanks (Заполните пропуски) — это ве се лое занятие , в котором учащимся нужно
вставить пропущенную инф ормацию. Напишите пре дложение , укажите до де сяти пропусков и
попросите учащихся пе ре тащить слова на доску и правильно заполнить ими пропущенные
ме ста .

Можно просмотре ть занятие в окне Add an Activity (Добавить занятие).

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Открое тся диалоговое окно Activity Preview («Просмотр занятия») «Заполните
пропуски». Вэтом окне буде т указана подробная инф ормация о задании.

2. Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.
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Добавление задания «Заполните пропуски»:

1. Откройте конструктор уче бных занятий, нажав значок пане ли инструме нтов LAB

на пане ли инструме нтов Notebook.

Открое тся окно &quot;Добавить занятие&quot;.

2. Найдите в нем задание «Заполните пропуски» и нажмите Add this Activity («Добавить

занятие»).

Открое тся страница Choose template and theme (Выбор шаблона и темы) в окне Add an

Activity (Добавить занятие).

Выбе рите тему, нажав на не е . Вокруг выбранной темы появится голубая рамка .

3. Вразде ле Answers (Ответы) выбе рите Check answers right away (Проверять ответы

сразу), чтобы прове рить отве ты сразу после сортировки элеме нтов, или Check answers

after students have finished (Проверить ответы, как только учащиеся завершат

работу), чтобы прове рить отве ты в конце занятия.

4. Нажмите &quot;Далее&quot;.

Открое тся диалоговое окно Add Content («Добавить содержимое») .

Вве дите те кст в области Edit text (Редактировать текст). Можно использовать до 300

символов. Сче тчик указывае т количе ство оставшихся символов. Пропуски можно
указать на сле дующем шаге .

5. Нажмите Define Blanks (Определить пропуски).

Появится диалоговое окно Add Blank Spaces («Добавить пропуски»).

6. Внаписанном вами те ксте нажимайте на слова , на ме сте которых будут пропуски, или
пе ре таскивайте на них рамку пропуска снизу задания.Можно пропускать только части

слов, пе ре таскивая синие ручки рамки.

Вокруг те кста , который вы выбрали в каче стве пропуска , появится прозрачная голубая
рамка .

7. После заме ны все х не обходимых слов пропусками нажмите Next (Далее).

Появится диалоговое окно Add game components («Добавить игровые компоненты») .

При не обходимости можно выбрать один из игровых компоне нтов. См. Добавление

игровых компонентов в занятия на странице  169.

8. Нажмите &quot;Готово&quot;.

Конструктор уче бных занятий создаст з анятие , которое буде т готово к работе че ре з
пару се кунд. Появится пре дложение с пропусками вме сто не которых слов.
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9. Учащие ся должны пе ре таскивать слова на подходящие пропуски в пре дложении.

10. Нажмите кнопку Check answers («Проверить ответы») , которая появится при
заве ршении задания.

Около заполне нных пропусков будут появляться галочки или кре стики, обозначающие ,
соотве тстве нно , правильные и не правильные отве ты. Отве ты можно исправлять , меняя
ме стами.

TIPS

o Можно просмотре ть занятие в ме ню Add an Activity (Добавить занятие).

Нажмите Preview this Activity («Просмотреть это занятие») , чтобы открыть
предварительный просмотрз адания на пе ре ворачивание карточе к.
Пре дварите льный просмотр позволит вам узнать о выбранном задании
дополните льную инф ормацию.

Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

o Нажмите на кнопку Activity Restart («Сброс занятия») , чтобы сбросить
те куще е занятие . Эта кнопка расположена в ве рхнем правом углу открытой
страницы занятия LAB.

o Чтобы открыть окно Add an Activity (Добавить занятие), используйте кнопку

Activity Edit (Редактировать занятие) . Эта кнопка расположена в ве рхнем
правом углу открытой страницы занятия LAB.

o Используйте кнопку звука для включе ния или выключе ния звука в занятии.

Добавление занятия Label Reveal (Открытие
подписей)
Занятие Label Reveal (Открытие подписе й) позволяе т учащимся лучше понимать строе ние
систем и их компоне нтов.

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Открое тся окно Activity Preview («Предварительный просмотр задания») , в котором
буде т указана подробная инф ормация о задании.
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2. Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

Для добавления занятия Label Reveal (Открытие подписей) выполните следующие

действия:

1. Открое тся окно &quot;Добавить занятие&quot;.

2. Найдите занятие Label Reveal (Открытие подписей) и нажмите Add this Activity

(Добавить занятие).

Открое тся окно &quot;Добавить занятие&quot;.

3. Нажмите Next (Далее) для добавле ния в занятие изображе ния одним из сле дующих
способов:
a. нажмите Browse for an image (Укажите путь к изображении) для просмотра и

выбора изображе ния из папки на вашем компьюте ре .

Нажмите Open (Открыть) для добавле ния изображе ния к занятию или пе ре тащите
е го в выде ле нную область в окне занятия.

b. ПЕРЕТАЩИТЕ ИЗОБРАЖЕНИЕ С РАБОЧЕГО СТОЛА КОМПЬЮТЕРА ИЛИ ДРУГОЙ

ПАПКИ В ВЫДЕЛЕННУЮ ОБЛАСТЬ В ОКНЕ ЗАНЯТИЯ.

Можно нажать Label Options (Параметры подписи) для изме не ния разме ра , ф ормы и
цве та подписи.
Можно также вставить или пе ре тащить элеме нты сортировки, связанные с
кате горие й, или добавить соде ржимое кате гории из ране е созданного списка .
Дополните льную инф ормацию о добавле нии конте нта см. в Управление материалами

в конструкторе учебных занятий на странице  171.

4. Нажмите кнопку New Label (Новая подпись) и пе ре тащите е е к компоне нту или части
изображе ния, которую не обходимо подписать .

Открое тся окно Label («Подпись) и инструмент Label edit tool (Редактирование подписи)

.

5. Вве дите краткое описание подписи. Нажмите +Add a description (Добавить описание) и
укажите подробное описание (до 150 символов).

Нажмите Done (Готово), чтобы закрыть окно .

Нажмите на значок пе ра в инструменте Label edit tool (Редактирование подписи),

чтобы изме нить описание .
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6. Нажмите X в инструменте Label edit tool (Редактирование подписи), чтобы закрыть окно .

7. Нажмите &quot;Далее&quot;.

Появится диалоговое окно Add game components («Добавить игровые компоненты») .

При не обходимости можно выбрать один из игровых компоне нтов. См. Добавление

игровых компонентов в занятия на странице  169.

8. Нажмите &quot;Готово&quot;. LAB создаст з анятие , которое буде т готово к работе
че ре з пару се кунд.

Добавление занятия Match ‘Em Up! (Найдите
соответствие !)
Учащие ся могут выполнить анимированное занятие Match ‘Em Up! (Найдите соотве тствие !),
чтобы пе ре таскивать соотве тствующие элеме нты в подводный ре зе рвуар в задании
Immersive Matching (Увле кате льный поиск соотве тствий) или в лабораторные сосуды в
заданииMatching Beakers (Соотве тствующие стаканы). Чтобы занятие стало боле е
увле кате льным, добавьте игровые компоне нты.

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Открое тся диалоговое окно Match ‘Em Up! Activity Preview (Просмотр занятия Найдите
соотве тствия!). Вэтом окне буде т указана подробная инф ормация о занятии.

2. Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

Добавление задания «Найдите соответствие»:

1. Открое тся окно &quot;Добавить занятие&quot;.

2. Найдите в нем задание «Найди соответствие!» и нажмите Add this Activity («Добавить

занятие»).

Открое тся диалоговое окно Template and Theme (Шаблон и тема).

3. Вдиалоговом окне Template and Theme (Шаблон и тема) выбе рите Immersive Matching

(Увлекательный поиск соответствий) илиMatching Beakers (Соответствующие стаканы).

Вокруг выбранной темы появится голубая рамка .
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4. Вразде ле Answers («Ответы») в пункте Check matches («Проверка соответствий»)

выбе рите Check answers right away («Проверять ответы немедленно») , чтобы сразу же
отклонять не правильные отве ты, или Check answers after students have finished

(«Проверить ответы, как только учащиеся завершат работу») , чтобы отклонять
не правильные отве ты в конце задания.

5. Нажмите &quot;Далее&quot;.

Открое тся диалоговое окно Add Content («Добавить содержимое») .

6. ВполяхCategory Name (Название категории) укажите названия, которые будут
использоваться для каждой кате гории.

7. Напишите названия мате риалов в кате гории, пе ре тащите элеме нты сортировки,
связанные с кате горие й, или отре дактируйте их в полях содержимого категорий. Также
можно добавить мате риалы кате гории из ране е сохране нного списка , вставить их из
таблицы или те кстового докуме нта или добавить изображе ние . Дополните льную
инф ормацию о добавле нии мате риала см. в разде ле Управление материалами в

конструкторе учебных занятий на странице  171.

TIP

Чтобы использовать в занятии изображе ние , нажмите на значок е го каталога в
любом списке мате риалов. Найдите и выде лите изображе ние , з атем нажмите Open

(Открыть). Изображение появится в списке мате риалов. Не смотря на возможность
создать любое количе ство элеме нтов, в занятии будут использованы только пе рвые
10 из них. Создайте не ме не е двух пар соотве тствий, чтобы продолжить .

8. Повторите те же де йствия для кате гории справа .

9. Нажмите &quot;Далее&quot;.

Появится диалоговое окно Add game components («Добавить игровые компоненты») .

При не обходимости можно выбрать один из игровых компоне нтов. См. Добавление

игровых компонентов в занятия на странице  169.
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10. Нажмите &quot;Готово&quot;.

Конструктор уче бных занятий создаст з анятие , которое буде т готово к работе че ре з
пару се кунд.

TIPS

o Можно просмотре ть занятие в ме ню Add an Activity (Добавить занятие).

Нажмите Preview this Activity («Просмотреть это занятие»). Открое тся окно
пре дварите льного просмотра задания, в котором буде т указана подробная
инф ормация о задании.

Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

o Используйте кнопку &quot;Сброс занятия&quot; , чтобы сбросить те куще е
занятие . Эта кнопка расположена в ве рхнем правом углу открытой страницы
занятия LAB.

o Чтобы открыть окно Add an Activity (Добавить занятие), используйте кнопку

Activity Edit (Редактировать занятие) . Эта кнопка расположена в ве рхнем
правом углу открытой страницы занятия LAB.

o Используйте кнопку звука для включе ния или выключе ния звука в занятии.

Добавление задания на сортировку
В задании на порядок сортировки учащие ся расставляют элеме нты по порядку исходя из
ваших указаний. Попробуйте расставить це лые числа отме ньше го к большему, этапы
научного алгоритма по порядку или другие элеме нты в же лаемой после довате льности.

Можно просмотре ть занятие в окне Add an Activity (Добавить занятие).

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Открое тся диалоговое окно Activity Preview («Просмотр занятия») на порядок
сортировки. Вэтом окне буде т указана подробная инф ормация о задании.

2. Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.
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Добавление задания на сортировку:

1. Откройте конструктор уче бных занятий, нажав значок пане ли инструме нтов LAB

на пане ли инструме нтов Notebook.

Открое тся окно &quot;Добавить занятие&quot;.

2. Найдите в нем задание на порядок сортировки и нажмите Add this Activity («Добавить

занятие»).

3. Выбе рите нужную тему в разде ле Template and Theme (Шаблон и тема). Вокруг
выбранной темы появится голубая рамка .

4. Вразде ле Answers (Ответы) нажмите Correct/Incorrect (Верно/Неверно)для оце нки
мате риалов занятия или выбе рите Preference (Предпочтения), чтобы учащие ся
расставляли элеме нты по собстве нному же ланию.

5. Вразде ле Answers (Ответы) выбе рите Check answers right away (Проверять ответы

сразу), чтобы прове рить отве ты сразу после сортировки элеме нтов, или Check answers

after students have finished (Проверить ответы, как только учащиеся завершат

работу), чтобы прове рить отве ты в конце занятия.

6. Нажмите Next (Далее). Открое тся диалоговое окно Items to order (Объекты для

сортировки).

7. Вдиалоговом окне Add an Activity (Добавить занятие), Item order (Сортировка

элементов) укажите нужный порядок сортировки.Можно выбрать First → Last (Первый →

Последний), Smallest → Biggest (Меньший → Больший), Highest → Lowest (Наибольший →

Наименьший)или Custom (Порядок пользователя).

Если вы выбрали Custom (Порядок пользователя), укажите условия сортировки,
наприме р Tallest (Высокий) и Shortest (Низкий).

Если вы хотите поме нять порядок, сначала выбе рите нужный, наприме р First → Last

(«Первый» → «Последний»), а з атем нажмите «Поменять порядок». Порядок стане т
таким: Last →First («Последний» → «Первый»).

8. Укажите элеме нты, которые нужно буде т отсортировать .

Не смотря на возможность создать любое количе ство элеме нтов, в занятии появятся
только пе рвые 10 из них.

Дополните льные све де ния о добавле нии мате риала см. в разде ле
Управление материалами в конструкторе учебных занятий на странице  171.
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9. TIP

Чтобы использовать в занятии изображе ние , нажмите на значок каталога в списке
мате риалов. Найдите и выде лите изображе ние , з атем нажмите Open («Открыть»).

Изображение появится в списке мате риалов. Создайте не ме не е двух элеме нтов,
чтобы продолжить .

10. Нажмите &quot;Далее&quot;.

Появится диалоговое окно Add game components («Добавить игровые компоненты») .

При не обходимости можно выбрать один из игровых компоне нтов. См. Добавление

игровых компонентов в занятия на странице  169.

11. Нажмите &quot;Готово&quot;.

Конструктор уче бных занятий создаст з анятие , которое буде т готово к работе че ре з
пару се кунд.

12. Учащие ся должны пе ре таскивать элеме нты в правильном порядке (све рху вниз ). Если
сортировка выполне на правильно , элеме нты начнут сле гка двигаться.

TIPS

Около каждого отве та появится зе ле ная галочка или красный кре стик, обозначая,
соотве тстве нно , правильный и не правильный отве ты. Отве ты можно менять ме стами до те х
пор , пока все из них не окажутся правильными.

Если вы выбрали Check answers right away («Проверять ответы немедленно»), то они
будут прове ряться сразу после получе ния. Верные отве ты будут приняты, а не ве рные —

отклоне ны.

Если вы выбрали Check answers after students have finished (Проверить ответы, как

только учащиеся завершат работу), то прове рка отве тов произойде т после того , как
учащие ся отве тят на все вопросы, что позволит вам обсудить вопросы.

Добавление занятия Speedup (Гонки)
Учащимся понравится соре вноваться в быстроте отве тов с помощью задания Speedup

(Гонки).

Чтобы просмотреть занятие, выполните следующие действия:

1. Нажмите Preview this Activity («Просмотреть это занятие»).

Открое тся диалоговое окно Activity Preview (Предварительный просмотр занятия) с
указанием подробной инф ормации о занятии.
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2. Нажмите Cancel («Отмена»), чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

Для добавления занятия Speedup (Гонки) выполните следующие действия:

1. Открое тся диалоговое окно Add an Activity (Добавить занятие).

2. Найдите занятие Speedup (Гонки) и нажмите Add this Activity (Добавить занятие).

Открое тся диалоговое окно Add an Activity (Добавить занятие).

3. Вдиалоговом окне Template and Theme (Шаблон и тема) выбе рите тему для карточе к.
Нажмите на изображе ние нужного эскиза . Вокруг эскиза появится голубая рамка .

4. Нажмите &quot;Далее&quot;.

Открое тся диалоговое окно Add question (Добавить вопрос).

5. Нажмите +Add Question (Добавить вопрос).

Открое тся диалоговое окно Question(s) (Вопрос (-ы)).

6. Напишите вопрос в области Enter a Question (Введите вопрос).

Также можно добавить мате риалы кате гории из ране е сохране нного списка или нажать
Manage Lists (Управление списками) для создания новых списков или изме не ния ране е
сохране нных списков.

Дополните льные све де ния о добавле нии мате риалов см. в разде ле
Управление материалами в конструкторе учебных занятий на странице  171.

7. Чтобы ограничить время для отве та на вопрос , установите ф лажок Limit time (Ограничить

время) и укажите время в се кундах.

8. Вобласти Enter Answers (Введите ответы) укажите отве ты, из которых будут выбирать
учащие ся. Необходимо указать по крайне й ме ре два варианта отве та .

9. Нажмите кнопку рядом с правильным отве том.

10. Нажмите +Add another Question (Добавить другой вопрос) для добавле ния сле дующих
вопросов; нажмите Cancel (Отменить), чтобы отме нить изме не ние ; или нажмите Done

(Готово), чтобы просмотре ть , отре дактировать или удалить вопросы или добавить
соде ржимое кате горий из ране е сохране нного списка .

11. После заве ршения добавле ния вопросов нажмите Next (Далее).

12. Нажмите Finish (Готово).

LAB создаст з анятие , которое буде т готово к работе че ре з пару се кунд.
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NOTE

В задание Speedup (Гонки) не льзя добавить игровые компоне нты.

Для запуска задания Speedup (Гонки) выполните следующие действия:

1. После открытия занятия нажмите Start (Запуск).

2. Выбе рите количе ство участников (от одного до че тыре х). Вгонках могут участвовать до
че тыре х че лове к, но также могут участвовать и другие учащие ся.

3. Выбе рите изображе ние гонщика и нажмите галочку, чтобы подтве рдить выбор .
На выбор изображе ния дае тся 15 се кунд. Если изображе ния не выбраны, гонка начне тся
автоматиче ски.

4. После начала гонки быстро нажимайте на стре лку ускоре ния гонщика , чтобы уве личить

е го скорость .

5. Вразличных точках трассы будут заданы вопросы. Гонщики выбирают букву
соотве тствующе го отве та на своих пультах управле ния.

6. После заве ршения гонки изображе ние побе дите ля отображае тся в окне ре зультатов.
Рядом с изображе нием каждого участника отображае тся итоговое время гонки в
се кундах. Нажмите Review answers (Просмотреть ответы), чтобы увиде ть все отве ты.

Нажмите Show Players (Показать игроков), чтобы увиде ть изображе ние каждого
гонщика .

Добавление задания «Кричи!»
В занятии Shout It Out! (Кричи!) учащие ся могут с помощью ве б -браузе ров своих устройств
быстро создавать и отправлять изображе ния и те ксты в занятия создания мате риалов LAB, а
учите ля могут ле гко прове рять мате риалы.

Чтобы получить наилучшие впе чатле ния от работы с заданием «Кричи!» см. Рекомендуемые

параметры браузеров, устройств, операционных систем и сетей на странице  167.

IMPORTANT

Если вы используе те пробную ве рсию программного обе спе че ния SMART Notebook для
совме стного обуче ния, може т появиться уве домле ние reCaptcha. Для работы с заданием
Shout It Out! (Кричи!) не обходимо подтве рдить пробную ве рсию. Дополните льную
инф ормацию см. в Подтверждение пользователя в задании «Кричи!» на странице  161.
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Можно просмотре ть занятие в окне Add an Activity (Добавить занятие).

Чтобы просмотреть занятие, выполните следующие действия:

Нажмите Preview this Activity («Просмотреть это занятие»), и открое тся диалоговое
окно Activity Preview («Просмотр задания «Кричи!») . Вэтом окне буде т указана
подробная инф ормация о задании.

Нажмите Cancel («Отмена») , чтобы закрыть окно , или Add this Activity («Добавить

занятие») , чтобы продолжить создание занятия.

Добавление задания «Кричи!»:

1. Откройте конструктор уче бных занятий, нажав значок пане ли инструме нтов на
пане ли инструме нтов Notebook. Открое тся окно Add an Activity («Добавить занятие») .

2. Найдите в нем задание «Кричи!» и нажмите Add this Activity («Добавить занятие»).

Открое тся страница Choose design («Выберите дизайн»)для задания «Кричи!».Выбе рите
тему.Можно выбрать либо темуArranged Randomly («Произвольно»), либо тему
Categorized («По категориям»).

3. Нажмите кнопку Next («Далее»).

Открое тся страница Add content (Добавить содержимое). При выборе варианта
Categorized (По категориям) для занятия потре буе тся создать минимум две кате гории.

Вполе Contribution Categories («Категории загруженных материалов»)укажите названия
для кате горий, в которых будут находиться отправле нные учащимися мате риалы.

Вполе Acceptable Contributions (Допустимые материалы)выбе рите тип мате риалов: Text

(Текст) или Images (Изображения).

4. Укажите максимально допустимое количе ство загружаемых с одного устройства
те кстов или изображе ний.

5. Нажмите Off («Выключить») илиOn («Включить») под надписью Display contributor

names («Показывать имя отправителя») , чтобы отобразитьть или скрыть имя
отправите ля.

6. Нажмите Next («Далее»). Появится диалоговое окно Add game components («Добавить

игровые компоненты») . При не обходимости можно выбрать один из игровых
компоне нтов. См. Добавление игровых компонентов в занятия на странице  169.
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7. Нажмите &quot;Готово&quot;.

Конструктор уче бных занятий создаст з анятие , которое буде т готово к работе че ре з
пару се кунд. Чтобы начать выполне ние задания и позволить учащимся добавлять
мате риалы, см. Добавление материалов учащихся в задание «Кричи!» на сле дующей
странице .

Запуск задания «Кричи!»:

1. После создания задания «Кричи!» не обходимо подтве рдить , что параме тры Display

Contributor Names («Отображать имена пользователей, выполнивших загрузку») и
Contributions per Device («Количество загрузок с одного устройства») выбраны
правильно .

2. Нажмите Start Activity («Начать занятие»).

Появится окно LAB Student Contribution Activity («Загрузка мате риалов учащимися в
LAB»). Оно включае т в се бя URL-адре с , который учащие ся должны указать в своих
браузе рах, и созданный иде нтиф икационный номе р занятия, который учащие ся укажут

на ве б -сайте конструктора уче бных занятий SMART Notebook. Значок занятия
стане т з е ле ным. Это значит, что занятие в настоящий момент запущено .

3. Учащимся не обходимо пе ре йти на страницу classlab.com и вве сти свои име на и
иде нтиф икационный номе р занятия. Тогда учащие ся будут подключе ны к занятию.

Мате риалы, добавле нные учащимися, появятся на странице конструктора уче бных
занятий Notebook. См. Добавление материалов учащихся в задание «Кричи!» на
сле дующей странице .

NOTE

Чтобы удалить добавле нный мате риал, пе ре тащите е го в мусорную корзину сле ва вве рху
страницы конструктора уче бных занятий. Удале нный мате риал не льзя восстановить .

Подтве рждение польз овате ля в з адании «Кричи!»
Если вы используе те пробную ве рсию программного обе спе че ния SMART Notebook для
совме стного обуче ния, при пе рвом запуске задания «Кричи!» в конструкторе уче бных
занятий може т появиться уве домле ние reCaptcha.

Если вы увиде ли это уве домле ние , то пе ре д использованием задания «Кричи!» нужно
подтве рдить пробную ве рсию. После ре гистрации в каче стве пробного пользовате ля вы
больше не буде те получать уве домле ния reCaptcha.
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Подтверждение пользователя пробной версии:

1. Если вы увиде ли уве домле ние reCaptcha в диалоговом окне LAB Student Contribution

Activity («Задание LAB с добавлением материалов учащихся») , установите ф лажок I’m

not a robot («Я не робот») .

Появится изображе ние с вопросом.

2. Отве тьте на вопрос и нажмите Verify («Проверить»).

Если вы отве тили правильно , то появится зе ле ная галочка в поле I’m not a robot («Я не

робот») .

3. Нажмите Start Activity («Запустить задание») , чтобы начать работу с заданием «Кричи!».
См. Добавление задания «Кричи!» на странице  159.

Добавление мате риалов учащихся в з адание «Кричи!»
Учащимся понравится загружать мате риалы в ваши занятия конструктора уче бных занятий.
Они могут добавлять те кст или изображе ния в зависимости от тре бований занятия. Другие
учащие ся могут добавлять в кате гории комментарии или использовать з агруженные
мате риалы для обсужде ния.

Добавление текстовых материалов учащихся

После того , как учащие ся войдут в занятие с помощью диалогового окна LAB Student

Contribution Activity («Загрузка материалов учащимися в LAB») в браузе рах своих
компьюте ров или мобильных устройств, открое тся окно Activity response («Ответ») .

1. Тепе рь учащие ся могут вве сти отве т в те кстовое окно . Учащийся може т написать в окне
до 150 символов (включая пробе лы), и може т давать отве ты столько раз , сколько скаже т
учите ль .
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Если ране е вы выбрали вариант «По категориям» , то в те кстовом окне также буде т
находиться ме ню кате горий.

После ввода отве тов учащие ся выбирают из выпадающе го ме ню Select a category

(Выбрать категорию) кате горию, в которую они хотят добавить отве т.

2. Учащие ся должны нажать Send Response («Отправить ответ») , чтобы отправить отве ты
на страницу конструктора уче бных занятий Notebook.

Мате риалы, добавле нные учащимися, появятся на странице занятия в конструкторе
уче бных занятий Notebook.

При выбранном виде Categorized («По категориям») , нажмите , чтобы сократить
работу окна иде нтиф икации и просмотре ть загруженные мате риалы, которые появятся в

правой части страницы занятия. Нажмите , чтобы заново открыть окно .
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TIP

Загруженные учащимися мате риалы можно пе ремещать из одной кате гории в другую, для
этого нужно нажать на эти мате риалы и пе ре тащив их в другую кате горию. (Эта ф ункция
доступна в SMART Notebook 15.2.)

Добавление изображений, загружаемых учащимися

1. После того , как учащие ся войдут в занятие с помощью диалогового окна LAB Student

Contribution Activity («Загрузка материалов учащимися в LAB») , открое тся окно Activity

response («Ответ») .

2. Учащийся нажимае тSelect an image («Выбрать изображение»).

Открое тся ф айловый мене дже р устройства .
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3. Учащийся выбирае т изображе ние и нажимае тOpen (Открыть).

Как и в случае с те кстовыми мате риалами, з агруженные изображе ния появятся на
странице конструктора уче бных занятий Notebook.

Чтобы уве личить загруженное изображе ние , учите ль може т нажать на не го на странице
Notebook.

Чтобы изображение ве рнулось к изначальному разме ру, нажмите вне уве личе нного
изображе ния или нажмите на кре стик в е го правом ве рхнем углу.

IMPORTANT

Один учащийся може т загрузить до 50 изображе ний за занятие . Если учащийся пре высит
это количе ство , то появится пре дупрежде ние и дополните льные мате риалы этого
учаще гося не будут отображе ны в те кущем занятии.

NOTE

Чтобы удалить добавле нный мате риал, пе ре тащите е го в мусорную корзину сле ва вве рху
страницы конструктора уче бных занятий. Удале нный мате риал не льзя восстановить .

4. Чтобы покинуть задание , учащемуся нужно нажать на символ выхода из приложения в

браузе ре свое го устройства .

Управление з аданием «Кричи!»
Вы може те управлять се ссие й занятия Shout It Out! (Кричи!) сле дующим образом:

пе ремещать загруженные учащимися мате риалы на рабочем столе Notebook,

приостанавливать загрузку мате риалов и отключать отображе ние име ни учаще гося,
з агрузивше го мате риалы. Кроме того , з анятие можно сохранить и использовать поздне е .

Для перемещения текстов или изображений, добавленных учащимися, выполните

следующие действия:

1. Наве дите стре лку курсора на объе кт на рабочем столе занятия в конструкторе уче бных
занятий.

2. Нажмите ле вой кнопкой мыши на объе кт и пе ре тащите е го в другое ме сто на странице .
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Чтобы приостановить добавление материалов учащимися на рабочий стол Notebook

необходимо выполнить следующие действия:

1. Нажмите на синюю кнопку Pause Contributions (Приостановить добавление

материалов) в диалоговом окне LAB Student Contribution Activity (Добавление

материалов учащихся в LAB).

Кнопка стане т з е ле ной, и надпись изме нится на Resume (Возобновить).

Учащие ся увидят на своих компьюте рах или устройствах сообщение Activity Paused

(Занятие приостановлено).

2. Для возобновле ния занятия снова нажмите на кнопку.

Кнопка стане т сине й, и надпись изме нится на Pause Contributions (Приостановить

загрузку материалов).

Сообщение Activity Paused (Занятие приостановлено) исче зне т, и учащие ся смогут
продолжить загрузку мате риалов.

Отображения/сокрытие имени учащегося, добавившего материал:

1. Нажмите на ползунок Off On («Выкл./Вкл.») около надписи Display Contributor Names

(«Отображать име на пользовате ле й, выполнивших загрузку»).

Имена учащихся, з агрузивших мате риалы, больше не будут отображаться.

Завершение, сохранение и перезапуск задания «Кричи!»:

1. Нажмите End and Save («Завершить и сохранить») в диалоговом окне LAB Student

Contribution Activity («Загрузка мате риалов учащимися в LAB»).

Появится диалоговое окно Contribution for this activity has ended («Загрузка материалов

для этого занятия завершена») .

2. Нажмите Restart Activity («Возобновить занятие») , чтобы продолжить работу с тем же
занятием.

NOTE

Одновреме нно можно запускать только одно задание .
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Рекомендуемые параме тры брауз е ров, устройств, операционных
систем и се тей
Вданном разде ле описаны ве б -браузе ры, устройства , опе рационные системы и пропускная
способность се ти, работа с которыми позволит в полной ме ре воспользоваться всеми
ф ункциями занятия Shout It Out! (Кричи!) из конструктора уче бных занятий. Также указаны
ве рсии драйве ров продукта  SMART, обе спе чивающихмаксимально эфф е ктивную работу с
инте рактивными продуктами SMART, и список ве б -сайтов, к которым не обходимо настроить
доступ для правильной работы занятия Shout It Out! (Кричи!).

NOTE

При работе с з аданием «Кричи!» учащие ся могут прове рить доступ к сайту на странице
http://classlab.com/connection/check.html.

Рекомендуемые веб-браузеры
l Google Chrome™ 30 или боле е поздне й ве рсии

l Safari 7 или боле е поздне й ве рсии

l Firefox® 40 или боле е поздне й ве рсии

l Firefox ESR

l Internet Explorer® 10 или боле е поздне й ве рсии

l Internet Explorer 11 Metro

l NOTE

Устройства на ОС Android™ должны использовать вме сто ве рсий Chrome или Firefox для
Android.

Рекомендуемые устройства
l Любой ноутбук илиMacBook

l iPad 2 или боле е поздне й ве рсии

l iPad Air

l iPad mini

l Microsoft® Surface RT2 или Pro

l Samsung Galaxy Note (8" и 10")

l Google Nexus 2013 или боле е поздне й ве рсии (7" и 10")

http://classlab.com/connection/check.html
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l Любая ве рсия Google Chromebook

IMPORTANT

Внастояще е время занятие Shout It Out! (Кричи!) не подде рживае тся на iPad 1 пе рвого
поколе ния или Samsung Galaxy Tab 3.

Рекомендуемые мобильные устройства
l iPhone 5C - 8ГБ, MG2E2C/A

l iPhone 6 Plus - 16ГБ, MG9M2CL/A

l iPhone 4S - 16ГБ, MC924LL/A

l iPod touch - 16ГБ, A1421

l Samsung Galaxy S4 - 16ГБ, SGH-I337M

l Samsung Galaxy S5 - 16ГБ, SM-G900W8

l Nexus 5 - 16ГБ, - LG-D820

l Nexus 6 - 32ГБ, - XT1103

l Motorola moto g - 8ГБ, XT1032

l Nokia Lumia 635 - Windows phone, RM-975

l HTC Desire 510 - 8ГБ

Рекомендуемые операционные системы
l ОСWindows® 7 или боле е поздне й ве рсии

l Опе рационная система OS X 10.8 или боле е поздне й ве рсии

l Опе рационная система iOS 8 или боле е поздне й ве рсии

l Опе рационная система Android™ 4.2 или боле е поздне й ве рсии

l Те кущая ве рсия опе рационной системы Chrome OS™

Рекомендуемые параметры сети
При минимальных тре бованиях к характе ристикам се ти, з адание «Кричи!» обе спе чивае т
плодотворную совме стную работу. Ре коме ндуемая скорость пе ре дачи данных в се ти только
для задания — 0,3Мбит/с на одно устройство . Если в вашей школе ре гулярно используются
другие инструме нтыWeb 2.0, убе дите сь , что пропускная способность се ти позволит
работать с з аданием. Если «Кричи!» используе тся совме стно с другими онлайн-ре сурсами
(наприме р , потоковой пе ре даче й ме диа ), тре буе тся еще большая пропускная способность (в
зависимости от характе ра используемых ре сурсов).
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Необходимый доступ к веб-сайтам
Для правильной работы занятия Shout It Out! (Кричи!) вне сите в свой список разрешенных
URL-адре сов сле дующие адре са :

l https://www.classlab.com

l http://id.smarttech.com

l https://smart-labc-prod.firebaseio.com

l https://smart-labc-prod-001.firebaseio.com

l https://smart-labc-prod-002.firebaseio.com

l https://smart-labc-prod-010.firebaseio.com

l https://content.smarttech-prod.com

l https://metric.smarttech-prod.com

l https://google.com

l http://google-analytics.com

l https://www.gstatic.com (используе тся компание й Google для загрузки reCAPTCHA)

Добавление игровых компонентов в занятия

Игровые компоненты
Доступны пять различных игровых компоне нтов.

Таймер

Используйте тайме р и отслеживайте продолжите льность выполне ния задания учащимися. В
диалоговом окне Timer (Таймер) можно выбрать отсче т 15 се кунд, 30 се кунд или 1 минуты
(обратный или прямой) или самостояте льно указать время в минутах и се кундах.

Игральные кости
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Бросьте кубики, чтобы выбрать случайные числа . Выбе рите один или два кубика в
диалоговом окне Add Dice (Добавить кубики).

Жребий

Жребий позволяе т произвольно выбрать учащихся или мате риалы занятия.Можно
использовать карточки, номе ра или списки учащихся. Вдиалоговом окне Hat Picker

(«Жребий») можно наугад выбрать обратные стороны карт или числа от 1 до 30. Также можно
наугад выбрать учащихся, указав их име на в поле Student List («Список учащихся»), или
использовать для этого заране е сохране нный список. Каждый элеме нтможно выбрать
только один раз .

Кнопка звукового сигнала

Учащие ся могут соре вноваться за право быть сле дующим. Вдиалоговом окне Buzzer

(Кнопка звукового сигнала) можно выбрать до че тыре х кнопок звукового сигнала .

Вращающийся барабан

Вращающе е ся коле со позволяе т произвольно выбрать учащихся или мате риалы занятия.
Можно использовать карточки, номе ра или списки учащихся. Вдиалоговом окне Spinning

Wheel («Вращающееся колесо») можно выбрать ге не ратор случайных чисе л, чтобы наугад
выбрать обратные стороны карт или числа от 1 до 30.Можно добавить учащихся или
использовать для этого заране е сохране нный список учащихся. Каждый элеме нтможно
выбрать не ограниче нное число раз .

Чтобы добавить игровые компоненты в занятие, выполните следующие действия:

1. Вдиалоговом окне Add game components («Добавить игровые компоненты») нажмите
On («Вкл.») рядом с любым игровым компоне нтом.

2. Выбе рите один из игровых компоне нтов.
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3. Нажмите &quot;Готово&quot;.

Конструктор уче бных занятий создаст з анятие , которое буде т готово к работе че ре з
пару се кунд.

Управление  материалами в конструкторе
учебных занятий
Управлять мате риалами в кате гории конструктора уче бных занятий оче нь просто .
Добавляйте в занятия Super Sort (Супе рсортировка ), Rank Order (Порядок сортировки), Match

‘Em Up! (Найдите соотве тствие !), Flip Out flip card (Пере ворачивание карточе к) и Label Reveal

(Открытие подписе й) новые элеме нты списка или мате риалы из заране е сохране нных
списков.

Для создания новых списков материалов выполните следующие действия:

1.Вокне конструктора уче бных занятий Add an Activity (Добавить занятие) нажмите
Manage Lists (Управление списками).

Открое тся диалоговое окно Manage Lists (Управление списками).

2. Нажмите Create New (Создать новый).

3. Из выпадающе го списка выбе рите Content list (Список содержимого).

4. Вполе Content List Name (Название списка содержимого) вве дите название списка .

5. Вдиалоговом окне List Items (Элементы списка) вве дите список слов или добавьте
изображе ния, которые вы хотите сохранить и использовать позже .

a. Чтобы добавить нужное изображе ние , нажмите значок Add Image (Добавить

изображение) и

Появится диалоговое окно Open (Открыть).

b. Выбе рите изображе ние , которое вы хотите добавить в список, и нажмите Open

(Открыть).

Изображение появится в диалоговом окне List Items (Элементы списка).

6. Нажмите &quot;Сохранить&quot;.
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Для создания нового списка учащихся выполните следующие действия:

1.Вокне конструктора уче бных занятийManage Lists (Управление списками) нажмите
Manage Lists (Управление списками).

Открое тся диалоговое окно Manage Lists (Управление списками).

2. Нажмите Create New (Создать новый).

3. Из выпадающе го списка выбе рите Student List (Список учащихся).

4. Вполе Student List Name (Название списка учащихся) вве дите название списка .

5. Вдиалоговом окне List Items (Элементы списка) вве дите име на учащихся, которые вы
хотите сохранить и использовать позже .

6. Нажмите &quot;Сохранить&quot;.

Чтобы отредактировать ранее сохраненные списки, выполните следующие действия:

1. Выбе рите значок Edit (Правка ) рядом со списком, который нужно отре дактировать .

Открое тся диалоговое окно Manage Lists (Управление списками).

2. Измените название в Content List name (Название списка содержимого) или List Items

(Элементы списка).

3. Нажмите &quot;Сохранить&quot;.

Выбор и добавление заранее сохраненных списков материалов для заданий:

l В занятии Super Sort (Супе рсортировка ) в диалоговом окне Manage Lists (Управление

списками) на странице Add an Activity (Добавить занятие) нажмите Add from list

(Добавить из списка) в пункте Category Content (Содержимое категории) для
добавле ния ране е сохране нного списка в кате гории сортировки. Чтобы удалить ране е
сохране нный список, нажмите Clear (Очистить). Чтобы сохранить новый список, нажмите
Save list (Сохранить список).

l В занятии Flip Out (Пере ворачивание карточе к) в диалоговом окне Manage Lists

(Управление списками) на странице Add an Activity (Добавить занятие) нажмите Add

from list (Добавить из списка) в выпадающих спискахCard back (Обратная сторона

карты) или Card face (Лицевая сторона карты) для добавле ния ране е сохране нного
списка . Чтобы удалить ране е сохране нный список, нажмите Clear (Очистить). Чтобы
сохранить новый список, нажмите Save list (Сохранить список).
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l В занятии Rank Order (Порядок сортировки) в диалоговом окне Manage Lists (Управление

списками) на странице Add an Activity (Добавить занятие) нажмите Lists (Списки) в
пункте Items to order (Объекты для сортировки) для добавле ния ране е сохране нного
списка . Чтобы удалить ране е сохране нный список, нажмите Clear (Очистить). Чтобы
сохранить новый список, нажмите Save list (Сохранить список).

l В занятииMatch 'Em Up! (Найдите соотве тствие !) в диалоговом окне Manage Lists

(Управление списками) на странице Add an Activity (Добавить занятие)нажмите Lists

(Списки) в пункте Category Name (optional) (Название категории (дополнительно)) для
добавле ния ране е сохране нного списка . Чтобы удалить ране е сохране нный список,
нажмите Clear (Очистить). Чтобы сохранить новый список, нажмите Save list (Сохранить

список).

TIPS

l Можно добавить мате риалы из таблицы Excel®, выбрав и скопировав нужные яче йки
таблицы и вставив их в области Category content (Содержимое категории) диалогового
окна Add content (Добавить содержимое).

l Можно добавить мате риалы из те кстового докуме нта , выбрав в нем и скопировав
нужный те кст и вставив е го в области Category content (Содержимое категории)

диалогового окна Add content (Добавить содержимое).
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Chapter 9: Работа с концептуальными
картами

Конце птуальные карты стимулируют учащихся принимать боле е активное участие в занятии.
Для создания конце птуальных картможно использовать как стандартные взаимоде йствия,
так и спе циальные же сты для че рнил.

Для начала работы с конце птуальными картами см. Создание узлов концептуальных карт и

работа с ними выше .

Создание узлов концептуальных карт и
работа с ними

Чтобы создать корне вой уз е л, выполните сле дующие действия :
Для начала работы откройте "Создание конце птуальных карт" на пане ли инструме нтов.
Корне вой узе л появится автоматиче ски. Дале е можно добавить дополните льные узлы.

Чтобы создать корневой узел, выполните следующие действия:

1. Вменю Add-ons (Надстройки) нажмите Start a new concept map (Создать новую

концептуальную карту).

Открое тся корне вой узе л.

2. Чтобы ре дактировать те кст, дважды нажмите на корне вой узе л. Нажмите Properties

(«Свойства») или Text («Текст») чтобы открыть ме ню Text («Те кст»), в котором
можно выбрать разме р ,шриф т и цве т те кста .
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Чтобы создать дополнительные узлы, выполните следующие действия:

1. Нажмите кнопку "+" в корне вом узле . Появится новый узе л и линия, сое диняющая е го с
корне вым узлом.

2. Чтобы ре дактировать те кст, дважды нажмите на узе л.

Использование изображения в каче стве уз ла

Чтобы использовать изображение в качестве узла, выполните следующие действия:

1. Откройте "Создание конце птуальных карт" и пе ре тащите либо скопируйте изображе ние ,
че рнила или те кст на страницу Notebook.

2. С помощью марке ра Notebook обве дите изображе ние .

3. Изображение появится внутри узла . Переме стите узе л в любое ме сто на странице
Notebook.
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4. Тепе рь с помощью марке ра нарисуйте сплошную линию от нового узла к другому узлу.
Линия пре вращае тся в се гме нт и сое диняе т два узла .

TIPS

o Используйте кнопкиUndo («Отменить») и Redo («Восстановить») для
отме ны или восстановле ния де йствия с конце птуальной картой.

o При удале нии корне вого узла все другие узлы также будут удале ны.
o Можно уве личивать и уме ньшать разме р узла , нажимая на марке р изме не ния

разме ра и пе ремещая е го . См. Изменение размеров объектов на странице  80
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Chapter 10: Презентация учебных занятий и
упрощение совместного обучения

Подготовка пе ре д пре зе нтацие й 180
Настройка режима отображения страницы 181

Уве личе ние и уме ньшение 181
Панорамирование страниц 182
Отображение страниц в режиме прозрачного ф она 183
Отображение страниц в двухстраничном режиме 185

Отображение ссылок 186
Перемещение окон между экранами 187
Настройка громкости 187

Использование инструме нтов пре зе нтации в классе 188
Запись страниц с помощью сре дства записи уроков 188
Использование зате не ния яче е к 190
Работа с инструме нтом Magic Pen (Волшебное пе ро ) 191

Выбор инструме нта«Волшебное пе ро» 191
Использование инструме нта Magic Pen (Волшебное пе ро ) для создания
исче зающих объе ктов 192

Использование инструме нта Text Pen (Те кстовое пе ро ) 192
Ввод те кста инструме нтом Text Pen (Те кстовое пе ро ) 192
Ре дактирование те кста инструме нтом Text Pen (Те кстовое пе ро ) 193

Добавле ние ссылок на инструме нты для объе ктов 196
Использование инструме нта Standard pen (Стандартное пе ро ) для создания
исче зающих объе ктов 198
Работа с блоками SMART 198

Опе рации с блоками SMART 199
Работа со сре дством записи SMART 200

Запуск сре дства з аписи SMART 201
Скрытие сре дства з аписи SMART 202
Измене ние каче ства виде о - и аудиозаписи 202
Измене ние ф ормата виде озаписи 203
Измене ние ме стоположения ф айла записи 205
Добавле ние ф илиграни к записям 207
Запись де йствий 209
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Улучшение характе ристик системы при записи 213
Уменьшение разрешения экрана и количе ства цве тов 214
Отключе ние аппаратного ускоре ния 214
Пре доставле ние обще го доступа к записи 215

Работа с инструме нтами изме ре ния 216
Работа с лине йкой 216
Работа с транспортиром 218
Работа с транспортиром Ге одре йе к 220
Работа с циркулем 222

Очистка или сброс страниц после пре зе нтации 223
Очистка страниц 224
Сброс страниц 225

Режим двух пользовате ле й при использовании инте рактивной доски 226
Режим двух пользовате ле й при использовании инте рактивной доски SMART Board

се рии D600 227
Режим двух пользовате ле й при использовании инте рактивной доски SMART Board

се рии 800 227
Выбор инструме нтов 228

После создания уче бных занятий в ПО SMART Notebook вы може те прове сти пре зе нтацию
этих уче бных занятий для учащихся с помощью инте рактивного продукта и пре зе нтационных
ф ункций ПО.

Помимо пре зе нтаций уче бных занятий вы также може те упростить совме стное обуче ние
учащихся с помощью ПО SMART Notebook и инте рактивных продуктов. Наприме р , двое
уче ников могут одновреме нно использовать инте рактивную доску SMART Board се рий D600

или 800.

Подготовка перед презентацией
Подготовив ф айлы *.notebook к пре зе нтации для учащихся, сохраните их на CD- или DVD-

диске или на USB-носите ле . Это позволит начать пре зе нтацию ф айлов при подключе нии USB-

носите ля или загрузки CD или DVD в компьюте р , подключе нный к инте рактивному продукту.
Можно также открыть доступ к ф айлам из локальной се ти, а з атем просматривать их на
инте рактивном продукте .

Дале е не обходимо подготовиться к пре зе нтации сле дующим образом:

l Настроить режим отображения страницы

l Прове рить все ссылки в ф айле
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l Если в вашем классе е сть не сколько различных инте рактивных продуктов пе реме стите
окна на соотве тствующие экраны.

l Если в пре зе нтации присутствуют виде о - или аудиоф айлы, отре гулируйте урове нь
громкости.

Настройка режима отображения страницы
Вы може те производить уве личе ние и уме ньшение с помощью кнопки "Просмотр экранов"
или не сколькими касаниями (е сли ваш инте рактивный продукт подде рживае т режим
не скольких касаний).

Кроме того , ПО SMART Notebook включае т сле дующие режимы просмотра :

l Полноэкранный режим уве личивае т область страницы до разме ров инте рактивного
экрана , скрывая строку заголовка , пане ль инструме нтов, пане ль задач и боковую
пане ль .

l Режим прозрачного ф она позволяе т виде ть соде ржимое рабоче го стола и окон,
расположенных за окном SMART Notebook, и продолжать работать с открытой
прозрачной странице й.

l Двухстраничный режим выводит на экран две страницы, расположенные рядом.

Увеличение и уменьшение
Вы може те производить уве личе ние и уме ньшение с помощью кнопки "Просмотр экранов"
или не сколькими касаниями (е сли ваш инте рактивный продукт подде рживае т режим
не скольких касаний).

Увеличение и уменьшение с помощью кнопки View Screens («Просмотр экранов»):

1. Нажмите кнопку View Screens («Просмотр экранов») .

2. Укажите коэфф ицие нт уве личе ния от50% до 300%.

ИЛИ

Выбе рите Entire Page («Вся страница») , чтобы разме р страницы совпадал с разме ром
экрана .

ИЛИ

Выбе рите PageWidth («Ширина страницы») , чтобы установить ширину страницы равной
ширине экрана .
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Увеличение и уменьшение с помощью множественных касаний:

Двигайте пальцы в противоположных направле ниях для уве личе ния.

ИЛИ

Двигайте пальцы по направле нию друг к другу для уме ньшения.

Появляе тся сообщение о те кущем уровне уве личе ния.

Панорамирование страниц
Вы може те выполнять панорамирование страницы в уве личе нном режиме , е сли ваш
инте рактивный продукт подде рживае тже сты панорамирования (см. разде л Увеличение и

уменьшение на пре дыдущей странице ).
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Панорамирование:

1. Нажмите на экран двумя пальцами одной руки и уде ржите касание .

2. Не убирая пальцы с экрана , пе ремещайте их вве рх, вниз , вле во и вправо .

3. Когда на экране появится нужная область , отпустите пальцы.

Отображение страниц в режиме прозрачного фона
Режим прозрачного ф она позволяе т виде ть соде ржимое рабоче го стола и окон,
расположенных за окном SMART Notebook, и продолжать работать с открытой прозрачной
странице й. На прозрачной странице можно писать циф ровыми че рнилами и сохранять записи
в ф айл. Также можно отображать инструме нты изме ре ния, создавать снимки экрана и
выполнять другие де йствия. Если область экрана не соде ржит никаких объе ктов SMART

Notebook, можно выде лять элеме нты рабоче го стола и приложения, расположенные за
окном SMART Notebook, и работать с ними.

Отображение страниц в режиме прозрачного фона

Нажмите View Screens («Просмотр экранов») , з атем выбе рите Transparent

Background («Прозрачный фон»).

Фон ПО SMART Notebook стане т прозрачным, что позволит виде ть рабочий стол и
приложения, расположенные за SMART Notebook, но все объе кты на странице ф айла
*.notebook останутся видимыми.

Появляе тся пане ль инструме нтов Transparent Background (Прозрачный фон).
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Кнопка Команда Действие

Выбрать Выде ляе т объе кты на те кущей странице или
взаимоде йствуе т с объе ктами рабоче го стола и
приложений, которые не являются объе ктами SMART
Notebook.

Перо и
выде ле ние

Пишите или рисуйте на те кущей странице циф ровыми
че рнилами.

Пре дыдущая
страница

Отображение пре дыдущей страницы те куще го ф айла .

Сле дующая
страница

Отображение сле дующей страницы те куще го ф айла .

Дополните льные
возможности

Открывае т ме ню параме тров, которое позволяе т
добавлять зате не ние экрана , выбирать другие циф ровые
че рнила , выбирать художе стве нное пе ро , добавлять
прямые линии, ф игуры и выполнять другие де йствия.

Выход из
режима
прозрачного
ф она

Возврат к стандартному виду.

Параме тры
пане ли
инструме нтов

Отображаются дополните льные кнопки пане ли
инструме нтов.

NOTES

o На пане ли инструме нтов отображае тся номе р те кущей страницы и обще е
количе ство страниц в ф айле .

o Если установле но ПО SMART Response, появляются дополните льные кнопки,
позволяющие вставлять вопросы и управлять экзаме нами.

Отображение дополнительных кнопок на панели инструментов

Нажмите Toolbar Options («Параметры панели инструментов») .

Пане ль инструме нтов разве рне тся для включе ния сле дующих кнопок.

Кнопка Команда Действие

Новая страница Вставка новой пустой страницы в те кущий ф айл.
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Кнопка Команда Действие

Отменить Отме на после дне го де йствия.

Удалить Удале ние все х выде ле нных объе ктов.

Очистить
страницу

Удале ние все х циф ровых че рнил и все х объе ктов со
страницы.

Инструме нт
захвата экрана

Открытие пане ли инструме нтов "Захват экрана".

Вставить
лине йку

Добавле ние лине йки на страницу (см. Работа с линейкой на
странице  216).

Вставить
транспортир

Добавле ние транспортира на страницу (см. Работа с
транспортиром на странице  218).

Вставить
транспортир
Ге одре йе к

Добавле ние транспортира Ге одре йе к на страницу (см.
Работа с транспортиром Геодрейек на странице  220).

Вставить
компас

Добавле ние циркуля на страницу (см. Работа с циркулем на
странице  222).

Отображение страниц в двухстраничном режиме
На экран можно выве сти две страницы, расположенные рядом. На любой из этих страниц
можно рисовать , де лать заме тки, импортировать ф айлы и добавлять ссылки таким же
образом, как это де лае тся на одной странице .

Когда отображаются две страницы, вы може те закре пить страницу, чтобы она продолжала
отображаться, пока вы буде те просматривать другие страницы в сортировщике страниц.

Отображение страниц в двухстраничном режиме

Нажмите View Screens («Просмотр экранов») , з атем выбе рите Dual Page Display

(«Двустраничный режим»).

Появится вторая страница . Красной рамкой обозначе на активная страница .

Закрепление страницы

1. Отобразите на экране две страницы, е сли это не было сде лано ране е .

2. Выбе рите страницу, которую не обходимо отображать .
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3. Выбе рите View &gt; Dual Page Display &gt; Pin Page («Вид» &gt; «Двустраничный

режим» &gt; «Закрепить страницу»).

Вве рхних углах закре пле нной страницы будут отображаться значки булавки .

Снятие закрепления страницы

Снимите выде ле ние с пункта ме ню View &gt; Dual Page Display &gt; Pin Page («Вид» &gt;

«Двустраничный режим» &gt; «Закрепить страницу»).

Чтобы вернуться к обычному режиму отображения, выполните следующие действия:

Нажмите View Screens («Просмотр экранов») , з атем выбе рите Single Page Display

(«Одностраничный режим»).

Отображение ссылок
Вы може те прикре пить копию ф айла , ярлык ф айла , ссылку на ве б -страницу или звуковой
ф айл к любому объе кту на странице (см. Добавление ссылок к объектам на странице  122).

Вы може те выве сти анимированный индикатор вокруг каждого объе кта , соде ржаще го
ссылку.

Отображение ссылки при открытии страницы

Выбе рите View &gt; Show All Links When PageOpens («Вид» &gt; «Показывать все

ссылки при открытии страницы»).

При каждом открытии страницы анимированный индикатор буде т отображаться вокруг
каждого объе кта , соде ржаще го ссылку. В зависимости от способа опре де ле ния ссылок,
каждый индикатор окружае т либо це лый объе кт, либо значок в нижнем ле вом углу
объе кта . Индикаторы автоматиче ски исче зают че ре з не сколько се кунд.

NOTE

Снимите ф лажок View &gt; Show All Links When PageOpens («Вид» &gt; «Показывать

все ссылки при открытии страницы») , чтобы не отображать ссылки при открытии
страницы.
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Отображение ссылок на текущей странице

Выбе рите View &gt; Show All Links («Вид» &gt; «Показывать все ссылки»).

Анимированный индикатор появится вокруг каждого объе кта , соде ржаще го ссылку. В
зависимости от способа опре де ле ния ссылок, каждый индикатор окружае т либо це лый
объе кт, либо значок в нижнем ле вом углу объе кта . Индикаторы автоматиче ски исче зают
че ре з не сколько се кунд.

Перемещение окон между экранами
На одном компьюте ре можно работать с не сколькими инте рактивными продуктами.Можно
разде лить экран компьюте ра на два и боле е экрана или же просматривать одни программы
на одном экране , а другие – на другом. Дополните льную инф ормацию см. в разде ле
«Подключение нескольких интерактивных досок к одному компьютеру»

(smarttech.com/kb/000315).

Если к одному компьюте ру подключе но не сколько инте рактивных продуктов, вы може те
пе ремещать окна с одного экрана на другой.

Перемещение окна с одного экрана на другой:

1. Если этого не было сде лано ране е , откройте окно .

NOTE

Нельзя пе ремещать разве рнутые на ве сь экран и све рнутые окна .

2. Косните сь пальцем и уде рживайте окно на пе рвом экране .

3. Косните сь второго экрана пальцем другой руки.

4. Убе рите пале ц с пе рвого экрана .

Окно исче зне т с пе рвого экрана и появится на втором.

Настройка громкости
При воспроизве де нии виде о или звукового ф айла урове нь громкости можно настроить с

помощью кнопки Volume Control («Управление громкостью») , отре гулировав затем
громкость вашей опе рационной системы с помощью соотве тствующих элеме нтов
управле ния.

NOTE

Убе дите сь , что динамики включе ны.

http://www.smarttech.com/kb/000315
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Для добавле ния этой кнопки на пане ль инструме нтов, см. страницу Настройка панели

инструментов на странице  233.

Использование инструментов презентации в
классе
Во время пре дставле ния уче бных занятий учащимся можно использовать сле дующие
инструме нты:

l Зате не ние экрана

l Зате не ние яче е к

l Волшебное пе ро

l Те кстовое пе ро (для написания ре дактируемого те кста че рнилами)

l Стандартное пе ро (для создания исче зающих объе ктов)

l Блоки SMART

l Инструме нты изме ре ния

o Лине йка

o Транспортир

o Транспортир Ге одре йе к

o Компас

Запись страниц с помощью средства з аписи уроков
Надстройка "Сре дство записи уроков" позволяе т з аписывать де йствия, сове ршаемые вами
на странице . Впосле дствии вы може те воспроизве сти запись на той же странице с помощью
сре дства записи уроков или нового видже та воспроизве де ния.

NOTE

Сре дство записи SMART пре дставляе т собой пре дыдущий инструме нт, но с новыми
возможностями. При использовании сре дства з аписи SMART вы може те записывать свой
де йствия в программах, отличных отSMART Notebook. При использовании сре дства з аписи
SMART вы може те ве сти запись все го экрана , указанного окна или прямоугольного
участка экрана . Если вы подключите к компьюте ру микроф он, вы также сможе те
записывать аудио .

Дополните льную инф ормацию см. в разде ле Работа со средством записи SMART на
странице  200.
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Запись страницы

1. Нажмите кнопку &quot;Надстройки&quot; , з атем нажмите &quot;Средство записи

уроков&quot;.

2. Нажмите кнопку &quot;Новая запись&quot;.

По пе риме тру записываемой страницы отображае тся граница красного цве та .

3. Выполните на те кущей странице де йствия, которые тре буе тся записать .

4. После выполне ния этих де йствий нажмите Stop Recording (Остановить запись).

TIPS

o Чтобы сохранить запись , просто сохраните ф айл .notebook.

o Закройте надстройку "Сре дство записи уроков" на время прове де ния
пре зе нтаций. Видже т воспроизве де ния буде т отображаться в нижне й части
страницы.Можно разблокировать е го и пе реме стить в любое ме сто на странице .

o Запись со страницы удалить не возможно .

Воспроизведение записи страницы с помощью надстройки &quot;Средство записи

уроков&quot;

1. Откройте записанную вами страницу.

2. Если надстройка &quot;Сре дство записи уроков&quot; з акрыта , нажмите кнопку

&quot;Надстройки&quot; , з атем нажмите &quot;Средство записи уроков&quot;.

3. Нажмите кнопку &quot;Воспроизведение&quot; на пане ли воспроизве де ния

Вы може те пе ре ключаться между режимами воспроизведения и паузы в
проце ссе воспроизве де ния записи.

4. Дополните льно можно выполнить сле дующие де йствия:

o Нажмите кнопку &quot;Перемотка назад&quot; для пе ремотки записи назад.

o Нажмите кнопку &quot;Перемотка вперед&quot; для пе ремотки записи
впе ре д.
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Воспроизведение записи страницы с помощью виджета воспроизведения

1. Откройте записанную вами страницу.

2. Если надстройка Lesson Recorder («Сре дство записи уроков») открыта , нажмите кнопку

в строке ме ню надстрое к, чтобы закрыть е е .

Видже т воспроизве де ния буде т отображаться в нижне й части страницы.

TIPS

Можно разблокировать и пе ремещать видже т по странице , чтобы к нему можно было
ле гко получить доступ в ходе пре зе нтации.

3. Нажмите кнопку &quot;Воспроизведение&quot; в видже те воспроизве де ния.

Вы може те пе ре ключаться между режимами воспроизведения и паузы в
проце ссе воспроизве де ния записи.

4. Дополните льно можно выполнить сле дующие де йствия:

o Нажмите кнопку &quot;Перемотка назад&quot; для пе ремотки записи назад.

o Нажмите кнопку &quot;Перемотка вперед&quot; для пе ремотки записи
впе ре д.

Использование з атенения яче е к
Кяче йкам таблицы можно приме нить эфф е кт зате не ния. Это позволит посте пе нно открывать
инф ормацию в яче йках в ходе пре зе нтации.

NOTES

l Зате не ние яче е к не обходимо удалить , е сли вы хотите изме нить свойства яче йки,
вставить столбцы или строки, удалить столбцы, строки или яче йки или разде лить или
объе динить яче йки.

l Также вы може те добавить зате не ние экрана , з акрывающе е всю страницу (см.

UsingTheScreenShade.htm).

Добавление затенения ячейки:

1. Выде лите яче йку.

2. Нажмите стре лку ме ню яче йки и выбе рите Add Cell Shade («Добавить затенение

ячейки»).
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Показать и скрыть содержимое ячейки:

1. Нажмите на зате не ние яче йки.

Зате не ние яче йки исче зае т, появляе тся соде ржимое яче йки.

2. Нажмите в ве рхнем ле вом углу яче йки.

Появляе тся зате не ние яче йки, соде ржимое яче йки скрывае тся.

Удаление затенения ячейки:

1. Выде лите яче йку.

2. Нажмите стре лку ме ню яче йки и выбе рите Remove Cell Shade («Удалить затенение

ячейки»).

Работа с инструментомMagic Pen (Волшебное пе ро )
Волшебное пе ро позволяе т сде лать сле дующе е :

l Создать ме дле нно исче зающий объе кт

l Открыть окно уве личе ния

l Открыть окно подсве тки

Выбор инструмента«Волшебное перо»
Необходимо выбрать инструме нт "Волшебное пе ро" пе ре д е го использованием.

Выбор инструмента «Волшебное перо»:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Magic Pen («Волшебное перо»).
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Использование инструмента Magic Pen (Волшебное перо) для создания исчезающих

объектов
С помощью инструме нта "Волшебное пе ро" вы може те создать объе кт, который буде т
ме дле нно исче зать .

NOTE

Исче зающие объе кты не сохраняются в ф айлах *.notebook.

Создание исчезающего объекта:

1. Выбе рите инструме нт «Волшебное пе ро» (см. разде л Выбор инструмента«Волшебное

перо» на пре дыдущей странице ).

2. Пальцем или пе ром напишите или нарисуйте объе кты на инте рактивном экране .

Объе кты ме дле нно исче зают.

Для задания числа секунд до исчезновения объекта:

1. Выбе рите инструме нт «Волшебное пе ро» (см. разде л Выбор инструмента«Волшебное

перо» на пре дыдущей странице ).

2. Если вкладка Properties («Свойства») не отображае тся, нажмите Properties («Свойства»)

.

3. Нажмите кнопку &quot;Эффекты заливки&quot;.

4. Ввыпадающем списке Fade time (Время исчезновения) вве дите или выбе рите время в
се кундах до исче знове ния объе кта .

TIP

Можно сохранить изме не ния в параме трах по умолчанию инструме нта «Волшебное
пе ро», нажав Save Tool Properties («Сохранить свойства инструмента») (см. разде л
Сохранение свойств инструмента на странице  71).

Использование инструмента Text Pen (Текстовое пе ро )
Те кстовое пе ро позволяе т выполнять сле дующие де йствия:

l Делать записи с автоматиче ским пре образованием в ре дактируемый те кст.

l Ре дактировать те кст во время работы бе з помощи клавиатуры

Ввод текста инструментом Text Pen (Текстовое перо)
С помощью те кстового пе ра вы може те де лать записи с автоматиче ским пре образованием в
ре дактируемый те кст.
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Написание редактируемого текста:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Text Pen («Текстовое перо»).

3. Выбе рите тип линии.

TIP

Пишите аккуратно , пе чатными буквами, по горизонтальной линии. Хотя SMART

Notebook може т пре образовывать написанный наклонно или письме нными буквами
те кст, это не все гда получае тся должным образом.

4. Сде лайте запись циф ровыми че рнилами на странице .

Рукописный те кст буде т пре образован в пе чатный. Рядом с пе чатным те кстом появятся
значки принятия и отме ны.

5. Нажмите , чтобы принять пе чатный те кст.

ИЛИ

Нажмите , чтобы ве рнуть запись , выполне нную рукописным те кстом.

TIPS

o Это де йствие можно выполнять , когда активно те кстовое пе ро , и для этого не

нужно пе ре ключаться на инструме нт выбора .

o Если вы не нажме те какую-либо из кнопок, пе чатный те кст буде т приме не н по
умолчанию.

Редактирование текста инструментом Text Pen (Текстовое перо)
С помощью те кстового пе ра вы може те приме нять разме тку и вносить правки в
ре дактируемый те кст. Ненужный те кст можно удалять , з аче ркнув е го с помощью пе ра . Для
выде ле ния различных участков те кста можно использовать цве тные че рнила . Также вы
може те приме нять другую разме тку для вставки пробе лов, вставки те кста и заме ны старого
те кста новым.

TIP

Вы може те выбрать цве т разме тки, отличный от цве та ре дактируемого те кста . Это позволит
учащимся проще виде ть правки в ходе занятий, посвященных обуче нию письму.
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Приме ры доступной разме тки приве де ны в сле дующей таблице :

Правка Инструкция Пример

Удале ние
те кста

Заче ркните те кст.

Вставка
пробе ла

Нарисуйте ве ртикальную линию в
те ксте .

Вставка те кста 1. Нарисуйте символ вставки ^ в том
ме сте , где не обходимо
вставить те кст.

2. Впишите новый те кст в
появивше е ся те кстовое поле .

TIP

Нажмите на тип линии или
нажмите &quot;Цвет&quot; ,
чтобы выбрать новый цве т те кста
вставки.

Под рукописным те кстом будут
отображаться слова , наиболе е
точно соотве тствующие
написанному.

3. Выбе рите слово , чтобы вставить
е го в виде пе чатного те кста . Также
можно нажать , чтобы
автоматиче ски выбрать слово ,
набранное полужирным те кстом.

ИЛИ

Нажмите , чтобы отме нить
вставку те кста .
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Правка Инструкция Пример

Заме на те кста 1. Нарисуйте окружность вокруг
участка те кста , который вы хотите
заме нить .

2. Впишите новый те кст в
появивше е ся те кстовое поле .
Под рукописным те кстом будут
отображаться слова , наиболе е
точно соотве тствующие
написанному.

3. Выбе рите слово , чтобы заме нить
им пе чатный те кст, или нажмите ,
чтобы автоматиче ски выбрать
слово , набранное полужирным
те кстом.

ИЛИ

Нажмите , чтобы отме нить
заме ну те кста .

Измене ние
цве та те кста

1. Нажмите на один из типов линии или
нажмите &quot;Цвет&quot; ,
чтобы выбрать новый цве т
пе чатного те кста .

2. Нарисуйте окружность вокруг
пе чатного те кста , который
не обходимо изме нить .

3. Нажмите , чтобы автоматиче ски
принять выбор нового цве та .
ИЛИ

Нажмите , чтобы отме нить выбор
нового цве та .

Измене ние
цве та слов с
помощью
же ста

1. Нажмите на один из типов линии или
нажмите &quot;Цвет&quot; ,
чтобы выбрать новый цве т
пе чатного те кста .

2. Заче ркните слово горизонтальной
линие й и ве рните сь к началу линии,
не отрывая пальца от пове рхности.
Слово буде т автоматиче ски
окрашено в выбранный цве т.
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Добавление ссылок на инструменты для объе ктов
Пане ль инструме нтов ПО SMART Notebook соде ржит сре дства , позволяющие создавать
базовые объе кты на страницах и работать с ними. Если пользовате ли будут испытывать
затрудне ния при работе с пане лью инструме нтов, вы може те привязать ссылку на
инструме нты "Выбор", "Перья или "Ластик" к объе кту, что позволит создать
пе рсонализированный инструме нт, который можно разме стить в любом ме сте страницы.

Инструме нтможно активировать в любое время посре дством нажатия на данный объе кт.

Добавление ссылки на инструмент для объекта

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите &quot;Ссылка на инструмент&quot;.



CHAPTER10
ПРЕЗЕНТАЦИЯ УЧЕБНЫХ ЗАНЯТИЙ И УПРОЩЕНИЕ СОВМЕСТНОГО ОБУЧЕНИЯ

197

3. Выбе рите один из пре дложенных инструме нтов.

Данный объе кт буде т связан с инструме нтом.

При нажатии на объе кт со ссылкой происходит запуск инструме нта :

Перо o При нажатии на объе кт буде т
активирован инструме нтPens
(Перья).

o Ввод соде ржимого можно выполнять
только с помощью инструме нта Pen
(Перо).

Ластик o При нажатии на объе кт буде т
активирован инструме нтEraser
(Ластик).

o Позволяе т стирать соде ржимое ,
созданное с помощью пе рье в любых
типов.

Выбор o При нажатии на объе кт буде т
активирован инструме нтSelect
(Выбор).

o Позволяе т нажимать на другие
объе кты, расположенные на
странице , чтобы открывать их ме ню
или пе ремещать их по странице .

TIPS

o Можно нарисовать свой объе кт, использовать объе кт из гале ре и или те кстовый
объе кт.

o Можно пре дварите льно задавать настройки цве та или типа линии пе ре д
присвое нием ссылки на инструме нт&quot;Перья&quot; какому-либо объе кту.
Если вы зададите новые настройки цве та или типа линии в инструме нте
&quot;Перья&quot;, расположенном на пане ли инструме нтов, изме не ние буде т
автоматиче ски приме не но к связанному объе кту.

Удаление ссылки на инструмент для объекта

1. Выбе рите объе кт.

2. Нажмите на стре лку ме ню объе кта и выбе рите &quot;Ссылка на инструмент&quot;.

3. Нажмите &quot;Отсутствует&quot;.
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Использование инструмента Standard pen (Стандартное пе ро ) для
создания исче з ающих объе ктов
Вы также може те рисовать объе кты от руки, исче зающие че ре з опре де ле нное время, с
помощью инструме нта "Перо".

NOTE

Вы также може те от руки рисовать объе кты, исче зающие че ре з опре де ле нное время, с
помощью инструме нта «Волшебное пе ро» (см. разде л Использование инструмента Magic

Pen (Волшебное перо) для создания исчезающих объектов на странице  192).

Написание или рисование исчезающими цифровыми чернилами:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Pen («Перо»).

3. Выбе рите тип линии.

4. Если вкладка Properties («Свойства») не отображае тся, нажмите Properties («Свойства»)

.

5. Нажмите кнопку &quot;Эффекты заливки&quot;.

6. Установите ф лажок Enable ink to fade after you write it (Включить исчезновение чернил

после ввода), а з атем в выпадающем списке Fade time (Время исчезновения) вве дите
или выбе рите время в се кундах, че ре з которое исче знут данные , написанные или
нарисованные циф ровыми че рнилами.

7. Пишите или рисуйте на странице циф ровыми че рнилами.

Работа с блоками SMART
Блоки SMART являются бе сплатной надстройкой, которая позволяе т выполнять
арифме тиче ские опе рации вме сте с классом. Для этого нужно написать циф ры на странице и
затем сое динить их с блоком SMART. Доступно семь различных типов арифме тиче ских
опе раций. Ознакомите льную инф ормацию по работе с блоками SMART вы сможе те найти во
всплывающих окнах справки.

Доступ к блокам SMART:

Нажмите Add-ons («Надстройки») , з атем выбе рите SMART Blocks («Блоки SMART»).
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Доступ к всплывающей справке блоков SMART:

1. Нажмите Add-ons («Надстройки») , з атем выбе рите SMART Blocks («Блоки SMART»).

2. Нажмите Learn More («Дополнительно»).

Операции с блоками SMART

IMPORTANT

Блоки SMART производят вычисле ния внутри самих блоков. Не пишите циф ровыми
че рнилами внутри блоков. См. приме ры ниже .

Доступны сле дующие опе рации с блоками SMART.

Блок SMART Функция

Блоки сложения подде рживают до двух входных значе ний. На выходе
получае тся сумма входных значе ний.
Приме р :

Блоки вычитания подде рживают до двух входных значе ний. На выходе
получае тся разность входных значе ний.
Приме р :

Блок умножения име е т два входа . Ре зультат на выходе являе тся
произве де нием входов.
Приме р :

Блоки де ле ния подде рживают до двух входных значе ний. На выходе
получае тся частное входных значе ний.
Приме р :
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Блок SMART Функция

Блоки сте пе ни подде рживают до двух входных значе ний. На выходе
получае тся число , для которого пе рвое значе ние являе тся основанием, а
второе — показате лем.

Приме р :

Блоки квадратного корня подде рживают одно входное значе ние . На выходе
получае тся квадратный коре нь входного значе ния.
Приме р :

Блоки не изве стного значе ния подде рживают до двух входных значе ний. На
выходе производится выбор случайного значе ния.
Приме р :

Работа со сре дством з аписи SMART
Сре дство записи SMART позволяе т з аписывать де йствия, выполняемые на инте рактивном
продукте . Подключив к компьюте ру микроф он, вы сможе те записать также свой голос .

Созданную запись можно воспроизве сти на любом компьюте ре с помощьюWindows Media®

Player. Также можно пре доставить общий доступ к записи другим пользовате лям.

NOTES

l Windows Media Player можно скачать с ве б -сайта microsoft.com/mediaplayer.

l Если ваш компьюте р удовле творяе т минимальным тре бованиям ПО SMART Notebook,

вы може те использовать сре дство записи SMART. Однако , чтобы достичь наилучше го
быстроде йствия, ПО ре коме ндуе тся устанавливать на компьюте ре с проце ссором
Pentium 4 или боле е мощным, звуковой картой и микроф оном, которые совме стимы с
опе рационной системойWindows.

Созданную запись можно воспроизве сти на любом компьюте ре с помощью виде опле е ра
SMART или проигрывате ля Windows Media®. Запись также можно пе ре дать другим
пользовате лям.

http://www.microsoft.com/mediaplayer
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NOTES

l Windows Media Player можно скачать с ве б -сайта microsoft.com/mediaplayer.

l Если ваш компьюте р удовле творяе т минимальным тре бованиям ПО
SMART Meeting Pro, вы може те использовать сре дство записи SMART. Однако , чтобы
достичь наилучше го быстроде йствия, ПО ре коме ндуе тся устанавливать на
компьюте ре с проце ссором Pentium 4 или боле е мощным, звуковой картой и
микроф оном, которые совме стимы с опе рационной системойWindows.

Созданную запись можно воспроизве сти на любом компьюте ре с помощью виде опле е ра
SMART или проигрывате ля Windows Media®. Запись также можно пе ре дать другим
пользовате лям.

NOTES

l Windows Media Player можно скачать с ве б -сайта microsoft.com/mediaplayer.

l Если компьюте р удовле творяе т минимальным тре бованиям программного
обе спе че ния SMART Meeting Pro PE, тогда можно использовать сре дство записи
SMART. Однако для оптимальной работы ре коме ндуе тся устанавливать программное
обе спе че ние на компьюте ре с проце ссором Pentium 4 или большей мощности,
звуковой картой и микроф оном, которые совме стимы с опе рационной системой
Windows.

Запуск средства записи SMART
Первый этап приме не ния сре дства з аписи SMART з аключае тся в запуске данного
приложения.

Запуск средства записи SMART

Нажмите на значок SMART Board в области уве домле ний и выбе рите
&quot;Средство записи&quot;.

NOTE

Если ваш компьюте р в данный момент не подключе н к инте рактивному продукту, в

правом нижнем углу на значке SMART Board отображае тся символ X .

Если ваш компьюте р в данный момент не подключе н к инте рактивному продукту, в

правом нижнем углу на значке SMART Board се рого цве та отображае тся символ X .

Вопе рационной системе Windows 7 выбе рите &quot;Пуск&quot; &gt; &quot;Все

программы&quot; &gt; SMART Technologies &gt; SMART Tools &gt; &quot;Средство

записи&quot;.

http://www.microsoft.com/mediaplayer
http://www.microsoft.com/mediaplayer
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ИЛИ

Вопе рационной системе Windows 8 пе ре йдите на экран Apps (Приложения), з атем
найдите и выбе рите SMART Technologies &gt; Recorder (Средство записи).

ИЛИ

Вопе рационной системе Windows 10 выбе рите Start (Пуск) &gt; All apps (Все

приложения), а з атем найдите и выбе рите SMART Technologies &gt; Recorder (Средство

записи).

Сре дство записи SMART появится на экране . Вобласти уве домле ний появится значок
&quot;Средство записи SMART&quot;.

Скрытие средства записи SMART
При же лании сре дство записи SMART можно скрыть , но сохранить возможность обращаться

к командам е го ме ню с помощью значка &quot;Средство записи SMART&quot; .

Скрытие средства записи SMART

Всре дстве записи SMART выбе рите &quot;Меню&quot; &gt; &quot;Свернуть в

системную область&quot;.

Сре дство записи SMART исче зне т с экрана .

Отображение средства записи SMART

Нажмите на значок &quot;Средство записи SMART&quot; в области уве домле ний и
выбе рите &quot;Показать&quot;.

Сре дство записи SMART появится на экране .

Изменение качества видео- и аудиозаписи
Вы може те изме нить каче ство аудио - и виде озаписе й сре дства з аписи SMART.

Изменение качества видео- и аудиозаписей

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).
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2. Выбе рите нужное каче ство звука в списке &quot;Качество звука&quot;.

NOTE

Боле е высокое каче ство звука обе спе чивае т и боле е каче стве нное
воспроизве де ние аудиозаписе й, но при этом уве личивае тся разме р ф айла .

3. Выбе рите каче ство виде озаписи в списке &quot;Качество видео&quot;.

ИЛИ

Выбе рите вариант&quot;Другое&quot; и задайте нужную частоту кадров.

NOTE

Боле е высокая частота кадров позволяе т з аписать боле е каче стве нное виде о , но при
этом уве личивае тся разме р ф айла .

TIP

Если выбран вариант&quot;Автоматический выбор (рекомендуется)&quot;, сре дство
записи SMART автоматиче ски оце нит характе ристики ваше го компьюте ра и подбе ре т
оптимальную частоту кадров.

4. Нажмите OK.

Восстановление принятого по умолчанию качества видео- и аудиозаписей

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Нажмите &quot;Восстановить значения по умолчанию&quot;.

3. Нажмите OK.

Изменениеформата видеозаписи
Вы може те изме нить параме тры сре дства записи SMART и выбрать нужный ф ормат
виде озаписи.
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Изменениеформата видеозаписи

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Нажмите на вкладку Video Format (Формат видео).

3. Выбе рите &quot;Видеофайлы Windows Media (*.wmv)&quot; или &quot;Видео средства

записи SMART (*.avi)&quot;.

NOTES

o Виде оф айлыWindows Media можно воспроизве сти с помощью проигрывате ля
Windows Media любой ве рсии. Проигрывате ль Windows Media може т также
воспроизводить виде оф айлы cре дства записи SMART, е сли на компьюте ре , где
воспроизводятся виде оф айлы, установле но ПО SMART Notebook.

Виде оф айлыWindows Media можно воспроизве сти с помощью проигрывате ля
Windows Media любой ве рсии. Проигрывате ль Windows Media може т также
воспроизводить виде оф айлы cре дства записи SMART, е сли на компьюте ре , где
воспроизводятся виде оф айлы, установле но ПО SMART Meeting Pro.

Виде оф айлыWindows Media можно воспроизве сти с помощьюWindows Media

Player любой ве рсии. Windows Media Player може т также воспроизводить
виде оф айлы cре дства записи SMART, е сли на компьюте ре , где воспроизводятся
виде оф айлы, установле но программное обе спе че ние SMART Meeting Pro PE.

o Виде оф айл cре дства записи SMART можно пре образовать в виде оф айл
Windows Media с помощью совме стного доступа к записи (см. Предоставление

общего доступа к записи на странице  215).

4. Нажмите OK.
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Восстановление принятого по умолчанию формата видеозаписи

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Нажмите на вкладку Video Format (Формат видео).

3. Нажмите &quot;Восстановить значения по умолчанию&quot;.

4. Нажмите OK.

Изменение местоположения файла записи
Вы може те изме нить параме тры сре дства записи SMART и указать ме стоположение ф айлов
записе й.

Выбор другой папки для сохранения файлов средства записи SMART

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Нажмите на вкладку Target Files («Конечныефайлы») .

3. Нажмите кнопку &quot;Обзор&quot;, расположенную рядом с полем &quot;Каталог

сохранения по умолчанию&quot;.

4. Выбе рите папку, в которой сле дуе т сохранять ф айлы, а з атем нажмите OK.

TIP

Для повышения быстроде йствия сохраняйте ф айлы на же стком диске компьюте ра , а
не на се те вом диске .

5. Нажмите OK.
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Выбор другой папки для сохранения временных файлов средства записи SMART

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Нажмите на вкладку Target Files («Конечныефайлы») .

3. Нажмите кнопку &quot;Обзор&quot;, расположенную рядом с полем &quot;Временный

каталог файлов&quot;.

4. Выбе рите папку, в которой сле дуе т сохранять време нные ф айлы, а з атем нажмите OK.

TIP

Для повышения быстроде йствия сохраняйте ф айлы, включая време нные ф айлы, на
один диск. Это позволит уме ньшить время, з атрачиваемое на сохране ние записе й.

5. Нажмите OK.

Указание ограничения дискового пространства

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Нажмите на вкладку Target Files («Конечныефайлы») .

3. Установите ф лажок &quot;Предупредить, если свободного места меньше&quot;, а
потом вве дите объем свободного ме ста на диске , при котором буде т выводиться
сообщение о не достатке свободного ме ста на диске .

4. Вве дите минимальный разме р свободного ме ста на диске , начиная с которого сре дство
записи SMART приостановит запись .

5. Нажмите OK.
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Восстановление заданного по умолчанию местоположения файлов записей

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Нажмите на вкладку Target Files («Конечныефайлы») .

3. Нажмите &quot;Восстановить значения по умолчанию&quot;.

4. Нажмите OK.

Добавление филиграни к записям
Вы може те изме нить параме тры сре дства записи SMART и добавить к ф ону записи
ф илигрань .

Добавление филиграни к записям

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Выбе рите вкладку &quot;Филигрань&quot; .

3. Выбе рите &quot;Изображение&quot;.

4. Нажмите &quot;Обзор&quot;.

5. Просмотрите и выбе рите нужное изображе ние и нажмите &quot;Открыть&quot;.

6. Нажмите &quot;Свойства&quot;.

Появится диалоговое окно &quot;Свойства филиграни&quot;. Выбранное изображе ние
появится в области &quot;Предварительного просмотра&quot;.
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7. Выполните сле дующе е :

o Чтобы изме нить ме стоположение ф илиграни, пе ре тащите изображе ние в другое
ме сто области &quot;Предварительный просмотр&quot; .

o Чтобы изме нить разме р ф илиграни, потяните за бе лый кружок в правом нижнем
углу изображе ния в области пре дварите льного просмотра .

8. Задайте параме тры &quot;Прозрачность&quot; и &quot;Эффект&quot;.

9. Нажмите кнопку OK.Диалоговое окно &quot;Свойства филиграни&quot; з акрое тся.

10. Чтобы после закрытия сре дства з аписи SMART ве рнуться к обычному режиму бе з
использования ф илиграни, выбе рите вариант&quot;Отключать филигрань при

закрытии средства записи&quot;.

11. Нажмите кнопку OK.Диалоговое окно &quot;Параметры&quot; з акрое тся.

Добавление текстовой филиграни к записям

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Выбе рите вкладку &quot;Филигрань&quot; .

3. Выбе рите &quot;Текст&quot;.

4. Вве дите те кстф илиграни.

5. Нажмите &quot;Свойства&quot;.

Появится диалоговое окно Watermark Properties («Свойства филиграни»).Изображение
появится в областиPreview («Предварительный просмотр»).

6. Задайте параме тры &quot;Цвет&quot;, &quot;Шрифт&quot; и
&quot;Прозрачность&quot;.
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7. Выполните сле дующе е :

o Чтобы изме нить ме стоположение ф илиграни, пе ре тащите изображе ние в другое
ме сто области &quot;Предварительный просмотр&quot; .

o Чтобы изме нить разме р ф илиграни, потяните за бе лый кружок в правом нижнем
углу изображе ния в области пре дварите льного просмотра .

o Чтобы добавить в ф илигрань дополните льную инф ормацию, выбе рите
&quot;Добавить текущую дату&quot;, &quot;Добавить текущее время&quot; и/или
&quot;Добавить номер кадра&quot;

8. Нажмите кнопку OK.Диалоговое окно &quot;Свойства филиграни&quot; з акрое тся.

9. Чтобы после закрытия сре дства з аписи SMART ве рнуться к обычному режиму бе з
использования ф илиграни, выбе рите вариант&quot;Отключать филигрань при

закрытии средства записи&quot;.

10. Нажмите кнопку OK.Диалоговое окно &quot;Параметры&quot; з акрое тся.

Удалениефилиграни из записей

1. Всре дстве записи SMART выбе рите Menu (Меню) &gt; Options (Параметры).

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Options («Параметры»).

2. Выбе рите вкладку &quot;Филигрань&quot; .

3. Выбе рите вариант&quot;Без филиграни&quot;.

4. Нажмите OK.

Запись действий
Сре дство записи SMART позволяе т з аписывать де йствия на всем экране , в заданном окне
или в прямоугольной области экрана . Подключив к компьюте ру микроф он, вы сможе те
записать свое голосовое выступле ние .

Можно создавать з аписи в ф ормате виде оф айла сре дства з аписи SMART, Windows Media или
в виде самораспаковывающе гося ф айла .
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Вы може те создать з апись в ф ормате виде оф айла сре дства з аписи SMART, который можно
воспроизве сти с помощью виде опле е ра SMART, или в ф ормате виде оф айла Windows Media,

который можно воспроизве сти с помощью проигрывате ля Windows Media. Если вы создали
запись в ф ормате виде оф айла сре дства з аписи SMART, то сможе те пре образовать е е в
ф ормат виде оф айла Windows Media или пре вратить в самораспаковывающийся ф айл и
пе ре дать пользовате лям, на компьюте ре которых не установле но ПО SMART.

NOTE

Вы также може те создавать виде оф айлы в ф ормате Windows Media или
самораспаковывающие ся ф айлы из ране е созданных виде озаписе й, чтобы пе ре давать их
другим пользовате лям (см. разде л Предоставление общего доступа к записи на
странице  215).

Создание записи

1. Всре дстве записи SMART з адайте нужные значе ния параме тров каче ства , ф ормата
виде о , ме стоположения ф айла и ф илиграни.

NOTES

o Если вы используе те не сколько экранов, выбе рите экран, с которого буде те
ве сти запись .

o Вы може те скрыть сре дство записи SMART, но сохранить возможность
обращаться к командам е го ме ню с помощью значка &quot;Средство записи

SMART&quot; в области уве домле ний.



CHAPTER10
ПРЕЗЕНТАЦИЯ УЧЕБНЫХ ЗАНЯТИЙ И УПРОЩЕНИЕ СОВМЕСТНОГО ОБУЧЕНИЯ

211

2. Для записи де йствий на всем экране нажмите &quot;Запись&quot; .

NOTE

Если сре дство записи SMART скрыто , для записи де йствий на всем экране нажмите на

значок &quot;Средство записи SMART&quot; в области уве домле ний и выбе рите
&quot;Запись&quot;.

ИЛИ

Для записи де йствий в опре де ле нной области экрана нажмите стре лку вниз ,

расположенную рядом с кнопкой &quot;Запись&quot; в сре дстве з аписи SMART,

выбе рите &quot;Запись в области&quot;и нарисуйте прямоугольник вокруг области, в
которой вы хотите ве сти запись .

ИЛИ

Для записи де йствий в окне нажмите стре лку вниз , расположенную рядом с кнопкой

&quot;Запись&quot; в сре дстве з аписи SMART, выбе рите &quot;Запись окна&quot;и
выбе рите окно , в котором вы хотите ве сти запись .

TIP

Чтобы уменьшить разме р ф айла записи, ограничьте з апись прямоугольной областью
на экране или окном.

3. Выполните на экране де йствия, которые тре буе тся записать . Если вы подключили к
компьюте ру микроф он, говорите в микроф он.

Сре дство записи SMART показывае т время, прошедше е с начала записи.

TIP

Анимация и другие спе циальные эфф е кты суще стве нно уве личивают разме р ф айла
записи.

4. Чтобы приостановить запись , нажмите кнопку &quot;Пауза&quot; . Чтобы

возобновить запись , нажмите кнопку &quot;Запись&quot; .

NOTES

o Чтобы приостановить запись , когда окно средства записи SMART скрыто ,

нажмите на значок &quot;Средство записи SMART&quot; в области
уве домле ний и выбе рите &quot;Пауза&quot;.

o Чтобы возобновить запись , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний и выбе рите &quot;Запись&quot;.
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5. После выполне ния все х де йствий, которые тре бовалось записать , нажмите кнопку

&quot;Остановить&quot; в сре дстве з аписи SMART.

NOTE

Чтобы остановить запись , когда сре дство записи SMART скрыто , нажмите на значок

&quot;Средство записи SMART&quot; в области уве домле ний и выбе рите
&quot;Остановить&quot;.

Появится диалоговое окно Save As («Сохранить как»).

NOTE

Если вы хотите заве ршить работу, не сохраняя записи, нажмите &quot;Отмена&quot;,

з атем нажмите &quot;Да&quot;, чтобы подтве рдить наме ре ние удалить запись , и
пропустите остальные шаги этой проце дуры.

6. Вве дите имя ф айла .

7. Если вы хотите сохранить ф айл в другом ме сте , выбе рите новое ме стоположение .

8. Нажмите &quot;Сохранить&quot;.

Пока сре дство записи SMART создае т виде оф айл, на экране буде т отображаться
диалоговое окно &quot;Завершение захвата&quot;.

После того как сре дство записи SMART создаст виде оф айл, появится диалоговое окно
&quot;Запись завершена&quot;. В этом диалоговом окне буде т показано
ме стоположение записи, разме р ф айла и продолжите льность записи.

9. Для просмотра записи закройте диалоговое окно и выбе рите &quot;Воспроизвести

запись&quot;.

10. Чтобы пре доставить общий доступ к записи другим пользовате лям, выбе рите Share

Recording (Предоставить общий доступ к записи).

Если вы хотите открыть совме стный доступ к записи пользовате лям, у которых не
установле н виде опле е р SMART, и вы создали запись в виде оф ормате сре дства з аписи
SMART, выбе рите &quot;Сделать запись доступной для совместного

использования&quot;.
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11. Нажмите OK.

Если выбран пункт&quot;Воспроизвести запись&quot;, ф айл буде т воспроизве де н на
проигрывате ле по умолчанию.

Если выбран пункт&quot;Сделать запись доступной для совместного

использования&quot;, появится диалоговое окно &quot;Сделать запись доступной для

совместного использования&quot;.Вы може те создать виде оф айл в ф ормате
Windows Media или самораспаковывающе гося ф айла , как описано дале е .

Создание видеофайла в форматеWindows Media или самораспаковывающегося файла

1. Создайте запись , как описано выше . Убе дите сь , что выбран параме тр Share Recording

(Предоставить общий доступ к записи).

Появится диалоговое окно Share Recording («Сделать запись доступной для

совместного использования»).

2. Выбе рите WMV, чтобы создать виде оф айл в ф ормате Windows Media, и нажмите кнопку
&quot;Далее&quot;.

ИЛИ

Выбе рите вариант&quot;Самораспаковывающийся файл&quot;, чтобы создать
самораспаковывающийся ф айл, и нажмите кнопку &quot;Далее&quot;.

3. Нажмите &quot;Далее&quot;.

4. Нажмите &quot;Обзор&quot;, выбе рите папку, в которой вы хотите сохранить ф айл,
вве дите имя ф айла и нажмите &quot;Сохранить&quot;.

5. Нажмите &quot;Далее&quot;.

6. Нажмите &quot;Готово&quot;.

Улучшение характеристик системы при записи
Если при использовании сре дства з аписи SMART ваша система работае т ме дле нно или вас
не удовле творяе т каче ство записи, приве де нные дале е ре коме ндации помогут вам улучшить
характе ристики системы.

l Уменьшите разрешение экрана компьюте ра и изме ните цве товые настройки экрана .
При мале ньких экранах с малым количе ством отте нков цве та быстроде йствие буде т
выше .

l Сохраняйте ф айлы на локальный же сткий диск. Се те вые диски боле е ме дле нные , и при
их использовании быстроде йствие снижае тся.

l Отключите аппаратное ускоре ние .
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l Попробуйте заме нить виде окарту. Некоторые виде окарты пре длагают боле е высокий
урове нь производите льности. Виде окарты с инте рф е йсом PCI Express обладают боле е
высокой производите льностью по сравне нию с виде окартами с инте рф е йсами AGP и
PCI.

l Выбе рите боле е низкое каче ство виде озаписи. Вы должны соизме рять тре бования к
каче ству виде озаписи с возможностями ваше го компьюте ра . Виде оф айлы боле е
высокого каче ства имеют больший разме р , поэтому к компьюте ру пре дъявляются
боле е высокие тре бования.

Уменьшение разрешения экрана и количества цветов
Если при использовании сре дства з аписи SMART ваша система работае т ме дле нно или вас
не удовле творяе т каче ство записи, вы може те уме ньшить разрешение экрана и количе ство
цве тов. При мале ньких экранах с малым количе ством отте нков цве та быстроде йствие буде т
выше .

NOTE

Эта проце дура може т изме няться в зависимости от ве рсии используемой опе рационной
системыWindows и настрое к системы.

Уменьшение разрешения экрана и количества цветов

1. Откройте пане ль управле ния Windows.

2. Нажмите &quot;Экран&quot;, з атем &quot;Настройка параметров экрана&quot;.

3. Выбе рите боле е низкое значе ние из выпадающе го списка Resolution (Разрешение).

4. Выбе рите боле е низкое значе ние из выпадающе го списка Colors (Цвет).

5. Нажмите OK.

Отключение аппаратного ускорения
Во время записи сре дство записи SMART постоянно де лае т снимки экрана . Некоторые
опе рационные системы де лают снимки с экрана оче нь ме дле нно , и это може т повлиять на
каче ство записи. Чтобы повысить каче ство записи, отключите аппаратное ускоре ние или
обновите виде одрайве р и виде окарту.

IMPORTANT

Отключе ние аппаратного ускоре ния може т снизить производите льность ПО
SMART Notebook.
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NOTE

Эта проце дура може т изме няться в зависимости от ве рсии используемой опе рационной
системыWindows и настрое к системы.

Отключение аппаратного ускорения

1. Откройте пане ль управле ния Windows.

2. Нажмите &quot;Экран&quot;, з атем &quot;Настройка параметров экрана&quot;, з атем
&quot;Дополнительные параметры&quot;.

3. Выбе рите вкладку &quot;Устранение неполадок&quot; .

4. Пере тащите ползунок &quot;Аппаратное ускорение&quot; в положение
&quot;Нет&quot;.

5. Нажмите OK.

6. Пере загрузите компьюте р .

Предоставление общего доступа к записи
Чтобы пре доставить общий доступ к записи другим пользовате лям, создайте виде оф айл
Windows Media, воспроизводимый с помощьюWindows Media Player, или создайте
самораспаковывающийся ф айл, который можно буде т воспроизве сти на любом
компьюте ре .

Если вы собирае те сь использовать з аписи совме стно с пользовате лями, на компьюте ре
которых установле но ПО SMART Meeting Pro, создайте запись в ф ормате виде оф айла
сре дства з аписи SMART, которую они смогут воспроизве сти в виде опле е ре SMART. Если вы
хотите использовать з аписи совме стно с пользовате лями, не имеющими ПО
SMART Meeting Pro, создайте запись в ф ормате виде оф айла Windows Media, которую они
смогут воспроизве сти на виде опле е ре Windows Media, или создайте
самораспаковывающийся ф айл, который можно буде т воспроизве сти на любом
компьюте ре .

Если вы собирае те сь пре доставить общий доступ к записи другим пользовате лям, на
компьюте ре которых установле но программное обе спе че ние SMART Meeting Pro PE,

создайте запись в ф ормате виде оф айла сре дства з аписи SMART, которую можно буде т
воспроизве сти в виде опле е ре SMART. Если вы хотите пре доставить общий доступ к записи
другим пользовате лям, не имеющими программного обе спе че ния SMART Meeting Pro,

создайте запись в ф ормате виде оф айла Windows Media, воспроизводимую с помощью
Windows Media Player, или создайте самораспаковывающийся ф айл, который можно буде т
воспроизве сти на любом компьюте ре .
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Преобразование видеофайла средства записи SMART

1. Выбе рите &quot;Меню&quot; &gt; &quot;Сделать запись доступной для совместного

использования&quot; в сре дстве з аписи SMART.

NOTE

Если сре дство записи SMART скрыто , нажмите на значок &quot;Средство записи

SMART&quot; в области уве домле ний, з атем выбе рите &quot;Настройка

параметров&quot;.

Появится диалоговое окно Share Recording («Сделать запись доступной для

совместного использования») .

2. Выбе рите WMV, чтобы создать виде оф айл в ф ормате Windows Media.

ИЛИ

Выбе рите вариант&quot;Самораспаковывающийся файл&quot;, чтобы создать
самораспаковывающийся ф айл, и нажмите кнопку &quot;Далее&quot;.

3. Нажмите &quot;Обзор&quot;.

4. Просмотрите и выбе рите виде оф айл сре дства з аписи SMART, который вы хотите
пре образовать , и нажмите &quot;Открыть&quot;.

5. Нажмите &quot;Далее&quot;.

6. Чтобы изме нить ме стоположение и имя пре образованного ф айла , нажмите
&quot;Обзор&quot;, выбе рите папку, в которой вы хотите сохранить ф айл, вве дите имя
ф айла и нажмите &quot;Сохранить&quot;.

7. Нажмите &quot;Далее&quot;.

8. Нажмите &quot;Готово&quot;.

Работа с инструментами измерения
Работая с инструме нтами изме ре ния ПО SMART Notebook, вы може те выве сти на страницу
лине йку, транспортир , транспортир Ге одре йе к или циркуль .

Работа с линейкой
Можно вставить на страницу лине йку, настроить е е разме р , длину, поворот и положение , а
з атем рисовать вдоль е е крае в.

Вставка линейки:

Нажмите Measurement Tools («Инструменты измерения») и выбе рите Insert Ruler

(«Вставить линейку») .
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Появится лине йка .

Перемещение линейки

Нажмите на сре днюю часть лине йки (отображае тся боле е темным синим полутоном), и
пе ре тащите лине йку в другое ме сто на странице .

Изменение размеров линейки

1. Выде лите лине йку.

2. Потяните ручку изме не ния разме ра лине йки (кружок в нижнем правом углу) для
уве личе ния или уме ньшения разме ра лине йки.

Увеличение длины линейки (без изменения шкалы)

Нажмите на дальний край лине йки, между стре лкой ме ню и сре дством изме не ния
разме ров, а з атем тяните в направле нии от лине йки.

Уменьшение длины линейки (без изменения шкалы)

Нажмите на дальний край лине йки, между стре лкой ме ню и сре дством изме не ния
разме ров, а з атем тяните в направле нии к це нтру лине йки.

Поворот линейки

Нажмите на ве рхнюю или нижнюю часть лине йки (отображае тся боле е све тлым синим
полутоном) и тащите лине йку в том направле нии, куда е е нужно пове рнуть .

На лине йке отображае тся те кущий угол поворота в градусах.

Переворот размеров:

Нажмите на символ пе ре ворота лине йки .

Если ме триче ские е диницы отображались на ве рхне й кромке лине йки, они будут
отображаться на нижне й кромке , и наоборот.
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Рисование с помощью пера и линейки:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Pen («Перо») или Calligraphic Pen

(«Каллиграфическое перо»).

3. Выбе рите тип линии.

4. Рисуйте вдоль края лине йки.

Циф ровые че рнила ф ормируют прямую линию вдоль кромки лине йки.

Удаление линейки:

1. Выде лите лине йку.

2. Нажмите на стре лку ме ню лине йки и выбе рите Delete («Удалить»).

Работа с транспортиром
Можно вставить на страницу транспортир , настроить е го разме р , поворот и положение , а
з атем рисовать вдоль е го крае в.

Вставка транспортира:

Нажмите Measurement Tools («Инструменты измерения») и выбе рите Insert

Protractor («Вставить транспортир») .

Появится транспортир .

Перемещение транспортира

Нажмите на внутре ннюю часть транспортира (отображае тся боле е темным синим
полутоном), и пе ре тащите е го в другое ме сто на странице .
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Изменение размеров транспортира

Нажмите на внутре нний круг чисе л, а з атем тащите в направле нии от транспортира для
е го уве личе ния или в направле нии к це нтру – для уме ньшения.

Поворот транспортира

Нажмите на наружный круг чисе л и тащите транспортир в том направле нии, куда е го
нужно пове рнуть .

На транспортире отображае тся те кущий угол поворота в градусах.

Отображение транспортира в виде полного круга:

1. Нажмите на синий кружок около надписи 180º на внутре ннем круге значе ний.

2. Нажмите на синий кружок еще раз , чтобы ве рнуться к отображе нию в виде полукруга .
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Рисование с помощью пера и транспортира:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Pen («Перо») или Calligraphic Pen

(«Каллиграфическое перо»).

3. Выбе рите тип линии.

4. Рисуйте вдоль края транспортира .

Циф ровые че рнила ф ормируют дугу вдоль кромки транспортира .

Отображение углов с помощью транспортира:

1. Выде лите транспортир .

2. Пере таскивайте зе ле ный кружок, пока он не покаже т правильное значе ние угла пе рвых
двух пе ре се кающихся линий.

3. Пере таскивайте бе лый кружок, пока он не покаже т правильное значе ние угла второй из
двух пе ре се кающихся линий.

4. Нажмите на зе ле ную стре лку в нижнем углу.

Линии и угол между ними будут отображаться в виде отде льного объе кта .

Удаление транспортира:

1. Выде лите транспортир .

2. Нажмите на стре лку ме ню транспортира и выбе рите Delete («Удалить»).

Работа с транспортиром Геодрейек
Вы може те вставить транспортир Ге одре йе к (также называемый угольником или ре йсшиной)
на страницу и управлять е го разме ром, углом поворота и ме стоположением.

Вставка транспортира Геодрейек:

Нажмите Measurement Tools («Инструменты измерения») и выбе рите Insert

Geodreieck («Вставить транспортир Геодрейек») .
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Появится транспортир Ге одре йе к.

Перемещение транспортира

Нажмите на внутре ннюю часть транспортира (внутри полукруга ), и пе ре тащите
транспортир в другое ме сто на странице .

Изменение размеров транспортира

Нажмите полукруг и затем тащите в направле нии от це нтра транспортира , чтобы
уве личить разме р , или к це нтру, чтобы уменьшить разме р .

Поворот транспортира

Нажмите на внешнюю часть транспортира (вне полукруга ) и тащите транспортир в том
направле нии, куда е го нужно пове рнуть .

На транспортире отображае тся те кущий угол поворота в градусах.

Рисование с помощью пера и транспортира Геодрейек:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Pen («Перо») или Calligraphic Pen

(«Каллиграфическое перо»).

3. Выбе рите тип линии.

4. Рисуйте вдоль края транспортира .

Циф ровые че рнила ф ормируют прямую линию вдоль кромки транспортира .
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Удаление транспортира:

1. Выде лите транспортир .

2. Нажмите на стре лку ме ню транспортира и выбе рите Delete («Удалить»).

Работа с циркулем
Можно вставить циркуль на страницу, настроить е го ширину, поворот и положение , а з атем
использовать е го для рисования окружносте й и дуг.

Вставка циркуля:

Нажмите Measurement Tools («Инструменты измерения») и выбе рите Insert Compass

(«Вставить циркуль») .

Появится циркуль .

Перемещение циркуля

Нажмите на край циркуля, на котором находится острие , и пе ре тащите циркуль в другое
ме сто на странице .

Расширение циркуля

1. Нажмите на край циркуля, на котором находится гриф е ль .

Появятся две стре лки сине го цве та .

2. Пере таскиванием задайте угол между острием и гриф е лем.

Число , отображаемое на рукоятке циркуля указывае т те кущий угол между острием и
гриф е лем.

Переворот циркуля:

Нажмите на символ пе ре ворота циркуля .

Гриф е ль циркуля окаже тся на противоположной стороне от острия.
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Поворот циркуля (без рисования)

Нажмите на ручку поворота (з е ле ный кружок) циркуля, и тащите циркуль в том
направле нии, куда е го нужно пове рнуть .

Рисование с помощью циркуля

1. Нажмите на кончик гриф е ля циркуля.

Курсор изме нится на символ гриф е ля.

2. Тащите циркуль в том направле нии, в котором е го нужно пове рнуть .

Изменение цвета грифеля циркуля:

1. (missing or bad snippet)
2. Нажмите Pen Types («Типы перьев»), з атем выбе рите Pen («Перо»).

3. Выбе рите тип линии.

Цве т гриф е ля циркуля изме нится на новый.

Удаление циркуля:

1. Выде лите циркуль .

2. Нажмите на стре лку ме ню циркуля и выбе рите Delete («Удалить»).

Очистка или сброс страниц после
презентации
После пре зе нтации уче бного занятия Вы може те очистить или выполнить сброс страниц в
ф айлах .notebook, чтобы использовать их повторно на после дующих уче бных занятиях.
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Очистка страниц
Вы може те стирать циф ровые че рнила и удалять отде льные объе кты со страницы. Также со
страницы можно удалить все объе кты или все объе кты, созданные циф ровыми че рнилами
одновреме нно .

NOTE

Нельзя удалить заблокированные объе кты (см. LockingObjects.htm) или объе кты,

получе нные в ре зультате бе сконе чного клонирования (см. Клонирование объектов на
странице  79). Чтобы удалить все объе кты со страницы, не обходимо сначала
разблокировать все з аблокированные объе кты и снять выде ле ние инструме нта Infinite

Cloner («Бесконечное клонирование») со все х объе ктов, получе нных в ре зультате
бе сконе чного клонирования.

Стирание всех объектов с экрана:

1. Если этого не было сде лано ране е , выве дите на экран страницу, которую вы хотите
очистить .

2. Выбе рите Edit &gt; Clear Page («Правка» &gt; «Очистить страницу»).

NOTES

o Эта опция отключе на , е сли страница не соде ржит объе ктов или е сли объе кты
заблокированы или бе сконе чно клонированы.

o Этот вариантможно также выбрать сле дующим образом:

o Щелчок правой кнопкой на странице

o Нажатие стре лки ме ню страницы в сортировщике страниц

o Нажатие стре лки ме ню страницы во время ре дактирования групп страниц (см.

GroupingPages.htm)

o Нажатие Clear Page («Очистить страницу») , е сли такой вариант име е тся
на пане ли инструме нтов (см. Настройка панели инструментов на
странице  233)

o Можно очистить все объе кты с не скольких страниц одновреме нно . Выде лите
эскизы страниц в сортировщике страниц, нажмите стре лку ме ню и выбе рите
Clear Page («Очистить страницу»).
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Удаление всех объектов цифровых чернил со страницы:

1. Если этого не было сде лано ране е , выве дите на экран страницу, которую вы хотите
очистить .

2. Выбе рите Edit &gt; Clear Ink from Page («Правка» &gt; «Очистить страницу от чернил»).

NOTES

o Этот вариант отключе н, е сли страница не соде ржит объе ктов, созданных
циф ровыми че рнилами, или е сли циф ровые че рнила заблокированы или
бе сконе чно клонированы.

o Этот вариантможно также выбрать сле дующим образом:

o Щелчок правой кнопкой на странице

o Нажатие стре лки ме ню страницы в сортировщике страниц

o Нажатие стре лки ме ню страницы во время ре дактирования групп страниц (см.

GroupingPages.htm)

o Нажатие Clear Ink («Очистить чернила») , е сли такой вариант име е тся на
пане ли инструме нтов (см. Настройка панели инструментов на странице  233)

o Можно очистить все объе кты, созданные циф ровыми че рнилами, с не скольких
страниц одновреме нно . Выде лите эскизы страниц в сортировщике страниц,
нажмите стре лку ме ню и выбе рите Clear Ink from Page («Очистить страницу от

чернил»).

Сброс страниц
Если вы вносили на страницу изме не ния (бе з сохране ния), страницу можно сбросить до
состояния, пре дше ствующе го вне се нию изме не ний.

NOTE

При сбросе страницы ф айлы, совме стимые с Adobe Flash Player, з апущенные на странице ,
не изме няются.

Сброс страницы:

1. Если этого не было сде лано ране е , выве дите на экран страницу, которую вы хотите
сбросить .
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2. Выбе рите Edit &gt; Reset Page («Правка» &gt; «Сбросить страницу»).

Появляе тся диалоговое окно , в котором нужно подтве рдить сброс .

NOTES

o Эта опция отключе на , е сли на страницу не было вне се но изме не ний со време ни
после дне го е е сохране ния.

o Этот вариантможно также выбрать сле дующим образом:

o Щелчок правой кнопкой на странице

o Нажатие стре лки ме ню страницы в сортировщике страниц

o Нажатие стре лки ме ню страницы во время ре дактирования групп страниц (см.

GroupingPages.htm)

o Нажатие Reset Page («Сбросить страницу») , е сли такой вариант име е тся
на пане ли инструме нтов (см. Настройка панели инструментов на
странице  233)

o Можно сбросить не сколько страниц одновреме нно . Выде лите эскизы страниц в
сортировщике страниц, нажмите стре лку ме ню и выбе рите Reset Page

(«Сбросить страницу»).

3. Нажмите Reset Page («Сбросить страницу»).

Режим двух пользователей при
использовании интерактивной доски
На инте рактивной доске SMART Board се рии D600 или 800 два пользовате ля одновреме нно
могут создавать объе кты и управлять ими в ПО SMART Notebook. На способ работы в
режиме двух пользовате ле й влияе т моде ль инте рактивной доски: SMART Board се рии D600

или SMART Board се рии 800.

Режим двух пользовате ле й при использовании инте рактивной доски удобе н в сле дующих
сце нариях:

l Два учащихся одновреме нно работают над заданием на инте рактивной доске

l Учите ль и учащийся одновреме нно работают над заданием на инте рактивной доске

l Учите ль или учащийся задают вопросы или задают задачи на инте рактивной доске ,
другой учащийся отве чае т на вопросы или решае т задачи
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Режим двух польз овате лей при использ овании
инте рактивной доски SMART Board се рии D600
При использовании инте рактивной доски SMART Board се рии D600 одновреме нно два
пользовате ля могут работать с инте рактивной доской, когда ПО SMART Notebook находится
в режиме работы двух пользовате ле й. Врежиме работы двух пользовате ле й экран де лится
пополам. Каждый пользовате ль може т касаться свое й половины экрана пальцем, чтобы
выполнить ще лчок ле вой кнопкой мыши или пе ре таскивать объе кты, писать с помощью пе ра
из лотка и стирать циф ровые че рнила с помощью ластика .

Чтобы пе ре ключиться из режима работы одного пользовате ля в режим работы двух
пользовате ле й, не обходимо нажать кнопку на пане ли инструме нтов.

Для отображения файла в режиме работы двух пользователей

Нажмите View Screens («Просмотр экранов») , з атем выбе рите DualWrite Mode

(«Режим двойного рукописного ввода»).

Для возврата в режим работы одного пользователя

Нажмите Exit («Выйти») .

Режим двух польз овате лей при использ овании
инте рактивной доски SMART Board се рии 800
На инте рактивной доске SMART Board се рии 800 два пользовате ля одновреме нно могут
создавать объе кты и управлять ими в ПО SMART Notebook. Оба пользовате ля могут
создавать объе кты и управлять ими в области страницы ПО SMART Notebook. Для указанной
области страницы ограниче ний ни для одного пользовате ля не т.

Режим работы двух пользовате ле й активируе тся, когда вы бе ре те пе ро из лотка для пе рье в.
Один из пользовате ле й создае т объе кты и управляе т ими с помощью пальце в
("пользовате ль , работающий касаниями"). Другой создае т объе кты и управляе т ими пе ром
("пользовате ль , работающий пе ром").

NOTE

Вдополне ние к варианту с пользовате лями, работающими пе ром и пальцами
одновреме нно , можно активировать режим двух пользовате ле й, одновреме нно
работающих на доске пе рьями или с помощью касаний. Но оба пользовате ля должны
использовать один и тотже инструме нт.
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Выбор инструментов
Для сме ны инструме нтов или настройки свойств касаний пользовате ль , работающий
касаниями, нажимае т соотве тствующую кнопку на пане ли инструме нтов или на вкладке
"Свойства". Дале е описывае тся приме р :

Для сме ны инструме нтов или настройки свойств пе ра пользовате ль , работающий пе ром,

нажимае т пе ром соотве тствующую кнопку на пане ли инструме нтов или во вкладке
"Свойства". Дале е описывае тся приме р :

NOTES

l Если пользовате ль , работающий пе ром, нажимае т кнопку на пане ли инструме нтов
пальцем, а не пе ром, SMART Notebook изме няе т выбранный инструме нт для
пользовате ля, работающе го касаниями, а не для пользовате ля, работающе го пе ром.

l Когда оба пользовате ля выбирают не сколько объе ктов на экране , цве т пунктирной
границы объе ктов, выбранных пользовате лем, работающим пальцами, буде т
отличаться от границы объе ктов, выбранных пользовате лем, работающим пе ром.
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Chapter 11: Расширение функционала ПО
SMART Notebook с помощью
надстроек

Установка надстрое к 229
Работа с надстройками 230
Опре де ле ние отсутствующих надстрое к 230
Отключе ние и удале ние надстрое к 231

Надстройки— это расшире ния для ПО SMART Notebook, созданные компание й
SMART Technologies и сторонними разработчиками программного обе спе че ния.

ПО SMART Notebook включае т надстройки «Конструктор занятий» (см. Создание учебного

задания на соответствие на странице  134) и «Инструме нты выравнивания» (см. Выравнивание

объектов на странице  73). Вы може те установить другие надстройки с ве б -сайта
SMART Exchange, чтобы добавить в ПО различные спе циализированные ф ункции. Кроме
того , вы може те управлять всеми установле нными надстройками с помощью Диспе тче ра
надстрое к.

Установка надстроек
Вы може те искать , просматривать и устанавливать надстройки с ве б -сайта SMART Exchange.

Установка надстройки

1. Выбе рите Add-ons &gt; Manage Add-ons («Надстройки» &gt; «Управление

надстройками»).

Появится диспе тче р надстрое к.

2. Выбе рите одну из надстрое к на ле вой пане ли и нажмите Done («Готово»).
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Работа с надстройками
После установки надстройки вы може те использовать все е е ф ункции как и любые другие
ф ункции ПО SMART Notebook.

Просмотр надстройки

1. Нажмите кнопку &quot;Надстройки&quot; для просмотра списка надстрое к.

2. Нажмите на значок надстройки, чтобы открыть е е .

3. Нажмите кнопку для возврата в список надстрое к.

Просмотр версии и другой информации о надстройке

1. Выбе рите &quot;Надстройки&quot; &gt; &quot;Управление надстройками&quot; на
пане ли инструме нтов ПО

ИЛИ

Нажмите кнопку в строке ме ню надстрое к.

Появится диспе тче р надстрое к.

2. Нажмите на имя надстройки.

3. Нажмите &quot;О программе&quot;.

Определение отсутствующих надстроек
При открытии страницы ф айла *.notebook, для работы которой не обходима надстройка ,
отключе нная или отсутствующая на компьюте ре , в ве рхне й части страницы появится
соотве тствующе е сообщение . Нажмите на сообщение для запуска диспе тче ра надстрое к.
Диспе тче р надстрое к опре де лит не обходимую надстройку. После этого вы може те
установить эту надстройку (см. Установка надстроек на пре дыдущей странице ) или включить
е е (см. Отключение и удаление надстроек на противоположной странице ).
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Отключение и удаление надстроек
Вне которых ситуациях може т потре боваться отключе ние или удале ние ране е установле нных
надстрое к.

Если вы захотите отключить надстройку, она больше не буде т отображаться в ПО
SMART Notebook, но все равно буде т оставаться установле нной на вашем компьюте ре .
Впосле дствии вы може те включить эту надстройку.

Если вы захотите удалить надстройку, она больше не буде т отображаться в ПО
SMART Notebook, а также буде т удале на с ваше го компьюте ра .

Отключение надстройки

1. Выбе рите Add-ons &gt; Manage Add-ons («Надстройки» &gt; «Управление

надстройками»).

Появится диспе тче р надстрое к.

2. Нажмите на имя надстройки.

3. Нажмите Disable («Отключить»).

TIP

Для повторного включе ния надстройки нажмите Enable («Включить»).

Удаление надстройки

1. Выбе рите Add-ons &gt; Manage Add-ons («Надстройки» &gt; «Управление

надстройками»).

Появится диспе тче р надстрое к.

2. Дважды нажмите на имя надстройки.

3. Нажмите кнопку Remove («Удалить»).

NOTES

o Надстройки "Конструктор занятий" и "Инструме нты выравнивания" не возможно
удалить .

o Можно удалять только те надстройки, которые были установле ны после

установки ПО SMART Notebook.
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Chapter 12: Техническое обслуживание ПО
SMART Notebook

Настройка пане ли инструме нтов 233
Настройка ПО SMART Notebook 235

Смена программы по умолчанию для ф айлов *.notebook 235
Настройка параме тров же стов 236
Настройка параме тров оптимизации изображе ния 237

Уменьшение разме ра изображе ния вручную 238
Экспорт оптимизированного ф айла 239

Настройка параме тров цве та ф она по умолчанию 240
Настройка параме тров инструме нтов изме ре ния 240
Настройка параме тров отступов в яче йках таблиц 242

Установка языка 243
Удале ние ПО SMART 245
Обновле ние и активация ПО SMART 246

Обновле ние ПО SMART 246
Активация ПО SMART 249

Получе ние ключа продукта 249
Активация программного обе спе че ния SMART с помощью ключа продукта 249

Отправка отзыва в компанию SMART 251

Вданной главе пре дставле на инф ормация о настройке ПО SMART Notebook.

Настройка панели инструментов
Пане ль инструме нтов SMART Notebook позволяе т выбирать и использовать различные
команды и инструме нты. Вы може те настроить параме тры пане ли инструме нтов, поме стив
туда наиболе е часто используемые инструме нты.

После добавле ния или удале ния кнопок с пане ли инструме нтов все гда можно ве рнуться к
набору кнопок по умолчанию. Кроме того , можно ве рнуть настройки по умолчанию всем
инструме нтам, е сли они были изме не ны и сохране ны на вкладке Properties («Свойства») (см.

разде л Сохранение свойств инструмента на странице  71).
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Добавление и удаление кнопок с панели инструментов:

1. Нажмите Customize the toolbar («Настроить панель инструментов») .

ИЛИ

Выполните ще лчок правой кнопкой мыши на пане ли инструме нтов.

Появится диалоговое окно Customize Toolbar (Настроить панель инструментов).

2. Нажмите Actions («Действия») или Tools («Инструменты»).

3. Выполните сле дующе е :

o Чтобы добавить кнопку на пане ль инструме нтов, нажмите значок нужной кнопки в
диалоговом окне и пе ре тащите е го на пане ль инструме нтов.

o Чтобы удалить кнопку с пане ли инструме нтов, нажмите е е значок на пане ли
инструме нтов и пе ре тащите е го за пре де лы пане ли инструме нтов.

o Чтобы пе ре ставить кнопки, нажмите нужный значок на пане ли инструме нтов и
пе ре тащите е го на новое ме сто на этой пане ли.

NOTES

o Можно добавлять , удалять и пе ре ставлять кнопки только на пане ли инструме нтов,
выбранной на шаге 2. Наприме р , е сли на шаге 2 вы нажали Actions (Действия),

можно только добавлять , удалять и пе ре ставлять кнопки на пане ли Actions

(Действия).

o Для расшире ния кнопки по строке захватите е е , пе реме стите и уде рживайте
между двух столбцов кнопок.

Вслучае использования экрана с не большим разрешением, не растягивайте по
строке боле е двух кнопок, так как это може т приве сти к чре зме рному
уве личе нию ширины пане ли по отношению к ширине окна ПО SMART Notebook.

4. Нажмите &quot;Готово&quot;.

Восстановление набора кнопок по умолчанию:

1. Нажмите Customize the toolbar («Настроить панель инструментов») .

ИЛИ

Выполните ще лчок правой кнопкой мыши на пане ли инструме нтов.
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Появится диалоговое окно Customize Toolbar (Настроить панель инструментов).

2. Нажмите Restore Default Toolbar («Восстановить панель инструментов по

умолчанию»).

Восстановление настроек по умолчанию для инструментов:

1. Нажмите Customize the toolbar («Настроить панель инструментов») .

ИЛИ

Выполните ще лчок правой кнопкой мыши на пане ли инструме нтов.

Появится диалоговое окно Customize Toolbar (Настроить панель инструментов).

2. Нажмите Restore Default Tool Properties («Восстановить свойства инструмента по

умолчанию»).

Настройка ПО SMART Notebook
Вданном разде ле пре дставле на инф ормация о настройке ПО SMART Notebook.

Смена программы по умолчанию для ф айлов *.notebook
Если вме сто ПО SMART Notebook вы устанавливае те другую программу SMART, которая
може т открывать ф айлы *.notebook, вы може те настроить эту программу по умолчанию для
ф айлов *.notebook. При же лании вы сможе те изме нить программу по умолчанию для ф айлов
*.notebook на SMART Notebook.

Смена программы по умолчанию во время открытия файла:

1. Откройте какой-либо ф айл *.notebook с помощью ПО SMART Notebook (см. Открытие

файлов на странице  16).

Появится сообщение с вопросом, хотите ли вы сме нить программу по умолчанию для
ф айлов *.notebook на SMART Notebook.

2. Нажмите Yes («Да»).

Для смены программы по умолчанию с использованием диалогового окна Preferences

(«Настройки»):

1. Выбе рите Edit &gt; Preferences («Изменить» &gt; «Настройка»).

На экране появится диалоговое окно SMART Notebook Preferences (Настройка SMART

Notebook).



CHAPTER12
ТЕХНИЧЕСКОЕ ОБСЛУЖИВАНИЕ ПО SMART NOTEBOOK

236

2. Нажмите General («Общие»).

3. Нажмите Make Default («Сделать программой по умолчанию»).

4. Если вы хотите , чтобы это сообщение появлялось на экране во время открытия ф айлов
*.notebook, когда программой по умолчанию не являе тся SMART Notebook, выбе рите
вариантTell me if SMART Notebook software isn’t the default program for .notebook files

(«Сообщать мне, если SMART Notebook не является программой по умолчанию для

файлов *.notebook»).

5. Нажмите OK.

Настройка параме тров же стов
Взаимоде йствие с объе ктами в ПО SMART Notebook можно также осуще ствлять с помощью
же стов, включая же сты встряхивания и долгого нажатия.

Жест Имя Назначение

Жест встряхивания Группировка двух или
не скольких объе ктов.

Жест долгого нажатия Выполне ние ще лчка правой
кнопкой мыши.

Жесты встряхивания и долгого нажатия включе ны по умолчанию. Но вы може те отключить эти
же сты, е сли учащие ся будут не пре днаме ре нно их выполнять .
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Отключение жеста встряхивания:

1. Выбе рите Edit &gt; Preferences («Изменить» &gt; «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART

Notebook»).

2. Нажмите General («Общие»).

3. Снимите ф лажок Use the shake gesture to group and ungroup objects (Использовать

жест встряхивания для группировки и разгруппировки объектов).

4. Нажмите OK.

Отключение жеста долгого нажатия:

1. Выбе рите Edit &gt; Preferences («Изменить» &gt; «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART

Notebook»).

2. Нажмите General («Общие»).

3. Снимите ф лажок Press and hold to perform a right-click (Нажать и удерживать для

выполнения щелчка правой кнопки мыши).

4. Нажмите OK.

Настройка параме тров оптимиз ации изображения
Если в ф айле *.notebook соде ржатся большие изображе ния (разме ром боле е 1 МБ), он
може т открываться и работать оче нь ме дле нно . Вэтом случае можно уме ньшить разме р
изображе ний бе з суще стве нной поте ри каче ства . Вре зультате разме р ф айла *.notebook

стане т ме ньше , и ф айл буде т открываться и работать быстре е .

Настройка параметров оптимизации изображения:

1. Выбе рите Edit &gt; Preferences («Изменить» &gt; «Настройка»).

На экране появится диалоговое окно SMART Notebook Preferences (Настройка SMART

Notebook).

2. Нажмите Defaults («Настройки по умолчанию»).
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3. Выбе рите один из сле дующих вариантов из выпадающе го списка Image optimization

(Оптимизация изображения):

o Выберите Ask every time I insert a large image («Спрашивать при каждом

добавлении большого изображения») , чтобы при добавле нии ф айла
изображе ния можно было выбрать уме ньшение е го разме ра или сохране ние
исходного разме ра .

o Выберите Never change the resolution of inserted images («Никогда не изменять

разрешение добавляемых изображений») , чтобы все гда добавлять изображе ния
в исходном разрешении.

o Выберите Always change image resolution to optimize file size («Всегда изменять

разрешение изображения для оптимизации размера файла») , чтобы все гда
уме ньшать разме р ф айла изображе ния при добавле нии.

4. Нажмите OK.

Уменьшение размера изображения вручную
Если вы выбрали вариантAsk every time I insert a large image («Спрашивать при каждом

добавлении большого изображения») из выпадающе го списка Image Optimization

(«Оптимизация изображения»), е го разме р можно уме ньшить вручную при добавле нии
изображе ния в ф айл или поздне е .

Уменьшение размера больших изображений на этапе добавления в файл:

1. Вставьте изображе ние , как описано в разде ле Вставка изображений на странице  93.

После нажатия кнопкиOpen (Открыть) появится диалоговое окно Image Optimization

(Оптимизация изображения).
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2. Нажмите Optimize («Оптимизировать») , чтобы уменьшить разме р ф айла изображе ния.

ИЛИ

Нажмите Keep Resolution («Сохранить разрешение») , чтобы не уме ньшать разме р
ф айла изображе ния.

NOTES

o Вслучае добавле ния ф айла в ф ормате BMP ПО SMART Notebook

самостояте льно пре образуе т е го в ф айл ф ормата PNG. Такое пре образование
уме ньшит разме р ф айла . Вре зультате оптимизация ф айла *.notebook може т
оказаться излишней (см. Экспорт оптимизированного файла выше ), даже е сли
разме р ф айла BMP пре вышал 1 МБ.

o ПО SMART Notebook автоматиче ски уме ньшае т разме р граф иче ского ф айла ,
е сли он пре вышае т5МБ или 5 ме гапиксе ле й, в зависимости от выбранного
варианта .

Уменьшение размера больших изображений после их добавления в файл:

1. Выбе рите изображе ние .

2. Нажмите стре лку ме ню выбранного изображе ния и выбе рите ImageOptimization

(«Оптимизация изображения»).

Появится диалоговое окно Image Optimization («Оптимизация изображения»).

3. Нажмите Optimize («Оптимизировать»).

Экспорт оптимизированного файла
Если у вас е сть ране е созданные ф айлы, в которых соде ржатся большие изображе ния, или
е сли вы выбрали вариантNever change the resolution of inserted images (Никогда не

изменять разрешение добавляемых изображений) в выпадающем списке Image

Optimization (Оптимизация изображения), вы може те экспортировать оптимизированные
ве рсии этих ф айлов, которые будут соде ржать уме ньшенные изображе ния. Эта ф ункция
особе нно приме нима в те х случаях, когда не обходимо прове сти пре зе нтацию ф айла
*.notebook на устаре вшем или маломощном компьюте ре .

Экспорт оптимизированного файла:

1. Выбе рите File &gt; Export As &gt; Optimized SMART Notebook File («Файл» &gt;

«Экспортировать как» &gt; «Оптимизированный файл SMART Notebook»).

Появится диалоговое окноExport Optimized File («Экспортировать оптимизированный

файл»).
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2. Выбе рите папку для сохране ния нового ф айла .

3. Вве дите имя ф айла в поле File name (Имя файла).

4. Нажмите &quot;Сохранить&quot;.

Настройка параме тров цве та фона по умолчанию
Для новых страниц, добавляемых в ф айл, з адан бе лый цве тф она по умолчанию. Цве тф она
по умолчанию можно изме нить .

NOTE

Эта настройка косне тся только новых страниц, а в случае приме не ния темы она буде т
заме не на соотве тствующими параме трами этой темы.

Изменение цвета фона по умолчанию:

1. Выбе рите Edit &gt; Preferences («Изменить» &gt; «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART

Notebook»).

2. Нажмите Defaults («Настройки по умолчанию»).

3. Нажмите Change Color («Изменить цвет»), з атем выбе рите цве т.

4. Нажмите OK.

Настройка параме тров инструментов измерения
Лине йка , транспортир и транспортир Ге одре йе к по умолчанию имеют синий цве т в ПО SMART

Notebook и лучше все го отображаются на све тлом ф оне .
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Можно изме нить цве т этих инструме нтов изме ре ния на же лтый, е сли вы хотите использовать
их на темном ф оне .

NOTE

Выполне ние сле дующей проце дуры изме нит внешний вид инструме нтов изме ре ния в
ф айлах *.notebook только для вашей копии ПО SMART Notebook. Если вы открое те тотже
ф айл *.notebook на другой копии ПО SMART Notebook, инструме нты изме ре ния могут
име ть другой цве т.

Изменение цвета инструментов измерения:

1. Выбе рите Edit &gt; Preferences («Изменить» &gt; «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART

Notebook»).

2. Нажмите Defaults («Настройки по умолчанию»).

3. Выбе рите вариантBlue tint (recommended for light backgrounds) («Синий оттенок

(рекомендуется для светлого фона)») в выпадающем списке Measurement tool color

(«Цвет инструментов измерения») , чтобы изме нить цве т инструме нтов изме ре ния на
синий.

ИЛИ

Выбе рите вариантYellow tint (recommended for dark backgrounds) («Желтый оттенок

(рекомендуется для темного фона)») в выпадающем списке Measurement tool color

(«Цвет инструментов измерения») , чтобы изме нить цве т инструме нтов изме ре ния на
же лтый.

4. Нажмите OK.
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Настройка параме тров отступов в ячейках таблиц
ВПО SMART Notebook 11 стало возможным задавать отступы в яче йках таблиц.

Выполните сле дующую проце дуру для удале ния отступов в яче йках таблиц. Эта ф ункция
особе нно поле зна , е сли вы создали таблицы до обновле ния ПО SMART Notebook 11 и хотите ,
чтобы соде ржимое таблицы отображалось бе з отступов в яче йках.

NOTE

Выполне ние сле дующей проце дуры изме нит внешний вид таблиц в ф айлах *.notebook

только для вашей копии ПО SMART Notebook. Если вы открое те тотже ф айл *.notebook на
другой копии ПО SMART Notebook, таблицы будут отображаться с отступами в яче йках
(е сли данная проце дура не была выполне на на этой копии ПО SMART Notebook).

Удаление отступов в ячейках таблиц:

1. Выбе рите Edit &gt; Preferences («Изменить» &gt; «Настройка»).

На экране появится диалоговое окноSMART Notebook Preferences («Настройки SMART

Notebook»).

2. Нажмите Defaults («Настройки по умолчанию»).

3. Снимите ф лажок Add cell padding to table cells (Добавлять отступы в ячейках таблиц).

4. Нажмите OK.

5. Закройте , з атем снова запустите ПО SMART Notebook.

Новые и ране е созданные таблицы в ф айлах .notebook будут отображаться бе з отступов
в яче йках.
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Установка языка
Утилита настройки языка SMART позволяе т выбирать язык для опре де ле нного приложения
SMART или для все х приложений SMART, установле нных на компьюте ре .

Для выбора языка выполните следующее:

1. Выбе рите &quot;Параметры&quot; &gt; &quot;Настройка языка&quot;.

Появится диалоговое окно &quot;Настройка языка&quot;.

2. Выбе рите в пе рвом выпадающем списке пункт&quot;Все перечисленные

приложения&quot; , чтобы установить язык сразу для все х программ.

ИЛИ

Выбе рите в пе рвом выпадающем списке конкре тное приложение , чтобы установить
язык только для не го .

3. Выбе рите нужный язык из второго выпадающе го списка .

NOTES

o Если рядом с выбранным языком отображае тся значок , значит этот язык
установле н на компьюте ре .

o Если рядом с выбранным языком отображае тся значок , значит утилита
настройки языка SMART сможе т загрузить язык с ве б -сайта после нажатия кнопки
&quot;OK&quot;.

o По умолчанию утилита настройки языка SMART используе т настройки инте рне т-
браузе ра Internet Explorer для подключе ния к се ти Инте рне т. Однако можно
использовать разные настройки для выполне ния шагов в рамках сле дующей
проце дуры.

TIP

Для отображения названий языков на языке оригинала (наприме р , Deutsch для
неме цкого языка ) установите ф лажок Show native names (Показать исходные

названия).
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4. Чтобы использовать разные языки для прове рки правописания и распознавания
рукописного те кста , выбе рите их в выпадающих спискахHandwriting recognition

(Распознавание рукописного текста) и Spell check (Проверка правописания).

NOTE

Если в выпадающем списке появляе тся пункт&quot;АВТО&quot; , языковая настройка
SMART выде лит выбранный вами язык или близкий язык в ином случае . Если ни один из
параме тров не доступе н, языковая настройка SMART выбирае т те кущий язык.

5. Для использования другой раскладки клавиатуры выбе рите е е из выпадающе го списка
Keyboard input language (Язык ввода для клавиатуры).

IMPORTANT

Выпадающий список &quot;Язык ввода для клавиатуры&quot; доступе н только при
условии, что на компьюте ре установле ны не сколько раскладок клавиатуры.

Раскладка , выбранная из выпадающе го списка &quot;Язык ввода для

клавиатуры&quot; , при работе с ПО SMART буде т автоматиче ски приме няться как к
экранной клавиатуре , так и к обычной клавиатуре , подключе нной к компьюте ру.

Вне которых ситуациях може т понадобиться выбрать раскладку, отличную от
раскладки клавиатуры, подключе нной к компьюте ру (наприме р , для обуче ния второму
языку). Втаких случаях экранная клавиатура работае т корре ктно , но клавиатура ,
подключе нная к компьюте ру, може т работать не корре ктно .

Для достижения наилучших ре зультатов убе дите сь , что выбранная раскладка
соотве тствуе т раскладке клавиатуры, подключе нной к вашему компьюте ру.
Наприме р , е сли к компьюте ру подключе на клавиатура с английской (США)

раскладкой, выбе рите из выпадающе го списка English (United States) (Английский

(США)).

Дополните льные све де ния о раскладках клавиатур см. в статье
http://msdn.microsoft.com/en-us/goglobal/bb964651.

6. Нажмите  &quot;OК&quot;.

Для настройки параметров соединения выполните следующее:

1. Выбе рите &quot;Параметры&quot; &gt; &quot;Настройка языка&quot;.

Появится диалоговое окно &quot;Настройка языка&quot;.

2. Нажмите  &quot;Параметры подключения&quot;.

Появится диалоговое окно &quot;Параметры подключения&quot;.

http://msdn.microsoft.com/en-us/goglobal/bb964651
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3. Выбе рите &quot;Использовать настройки Internet Explorer&quot;.

ИЛИ

Выбе рите &quot;Использовать другой прокси-сервер&quot;, а з атем укажите хост, имя
пользовате ля и пароль в соотве тствующих полях.

4. Нажмите  &quot;OК&quot;.

Удаление ПО SMART
Служба подде ржки SMART може т пре дложить вам удалить ПО SMART пе ре д установкой
новой ве рсии. Вы може те сде лать это с помощью Программы удале ния SMART.

Для удаления ПО SMART выполните следующее:

1. Вопе рационной системе Windows XP илиWindows 7 выбе рите &quot;Пуск&quot; &gt;

&quot;Все программы&quot; &gt; SMART Technologies &gt; SMART Tools &gt;

&quot;Программа удаления SMART&quot;.

ИЛИ

Вопе рационной системе Windows 8 пе ре йдите на экран &quot;Приложения&quot; , а
з атем найдите и выбе рите  &quot;Программа  удаления SMART&quot;.

2. Нажмите  &quot;Далее&quot;.
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3. Проставьте ф лажки напротив ПО SMART и сопутствующих паке тов, которые не обходимо
удалить , а з атем нажмите  &quot;Далее&quot;.

NOTES

o Некоторое ПО SMART взаимосвязано с другим ПО SMART. Наприме р , е сли
поставить ф лажок напротив SMART  Notebook , программа удале ния SMART

автоматиче ски установитф лажок напротив SMART Response , потому что ПО
SMART Response взаимосвязано с ПО SMART Notebook.

o Программа удале ния SMART автоматиче ски удаляе т сопутствующие паке ты,

которые больше не будут использоваться. Если вы удалите паке тПО SMART

полностью, Программа удале ния SMART удалит все сопутствующие паке ты,

включая се бя.

TIPS

o Для выбора все х приложений и сопутствующих паке тов нажмите  &quot;Выбрать

все&quot;.

o Чтобы отме нить выбор все х приложений и сопутствующих паке тов,
нажмите  &quot;Очистить все&quot;.

4. Нажмите  &quot;Удалить&quot;.

Программа удале ния SMART выполнит удале ние выбранного ПО и е го сопутствующих
паке тов.

5. Нажмите  &quot;Готово&quot;.

Обновление и активация ПО SMART
После установки ПО SMART не обходимо произве сти е го активацию. После активации ПО
не обходимо установить обновле ния отSMART.

IMPORTANT

Для обновле ния и активации ПО SMART тре буе тся подключе ние к се ти Инте рне т.

Обновление ПО SMART
Компания SMART пе риодиче ски выпускае т обновле ния для свое го программного
обе спе че ния и микропрограмм. (Микропрограммы— это программное обе спе че ние ,
которое устанавливае тся на такие продукты, как инте рактивная доска SMART Board.) Вы
може те использовать SMART Product Update (SPU) для прове рки и установки этих
обновле ний.
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Системный администратор може т установить SPU в полноэкранном режиме или в виде
пане ли. Вполноэкранном режиме можно просматривать установле нные ве рсии, а также
загружать и устанавливать обновле ния, как описано в этом разде ле . Версия в виде пане ли
позволяе т только просматривать установле нные ве рсии.

Для автоматической проверки наличия обновлений

1. Вопе рационной системе Windows XP илиWindows 7 выбе рите &quot;Пуск&quot; &gt;

&quot;Все программы&quot; &gt; SMART Technologies &gt; SMART Tools &gt; SMART

Product Update.

ИЛИ

Вопе рационной системе Windows 8 пе ре йдите на экран &quot;Приложения&quot; , а
з атем найдите и выбе рите SMART Product Update.

Появится окно SMART Product Update.

2. Установите ф лажок &quot;Автоматически проверять наличие обновлений&quot; , а
з атем вве дите инте рвал в днях (не боле е 60) между после довате льными прове рками для
SPU.

3. Закройте окно SMART Product Update (Обновление продукта SMART).

Если при оче ре дной прове рке SPU обнаружит обновле ние для продукта , автоматиче ски
появится окно SMART Product Update (Обновление продукта SMART), в котором буде т
активна кнопка Update (Обновить) для данного продукта .

Для проверки наличия обновлений вручную

1. Вопе рационной системе Windows XP илиWindows 7 выбе рите &quot;Пуск&quot; &gt;

&quot;Все программы&quot; &gt; SMART Technologies &gt; SMART Tools &gt; SMART

Product Update.

ИЛИ

Вопе рационной системе Windows 8 пе ре йдите на экран &quot;Приложения&quot; , а
з атем найдите и выбе рите SMART Product Update.

Появится окно SMART Product Update.

2. Нажмите  &quot;Проверить сейчас&quot;.

Если для продукта доступно обновле ние , кнопка &quot;Обновить&quot; стане т активной.

3. Если для продукта доступно обновле ние , установите е го , выполнив сле дующую
проце дуру.
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Для установки обновления

1. Откройте окно SMART Product Update, как описано выше .

2. Пере йдите на строку продукта .

Появится подробное описание продукта . Это описание соде ржит ве рсию
установле нного продукта , количе ство доступных обновле ний, дату и разме р ф айла для
загрузки (е сли обновле ние доступно ).

TIP

Нажмите  &quot;Просмотреть комментарии разработчика&quot;, чтобы просмотре ть
краткий обзор изме не ний и системные тре бования для установки обновле ний.

3. Нажмите  &quot;Обновить&quot;.

4. Загрузите ф айл и установите обновле ние , сле дуя инструкциям на экране .

IMPORTANT

Для установки обновле ний не обходимо име ть права администратора .

Для отключения функции автоматической проверки обновлений

1. Вопе рационной системе Windows XP илиWindows 7 выбе рите &quot;Пуск&quot; &gt;

&quot;Все программы&quot; &gt; SMART Technologies &gt; SMART Tools &gt; SMART

Product Update.

ИЛИ

Вопе рационной системе Windows 8 пе ре йдите на экран &quot;Приложения&quot; , а
з атем найдите и выбе рите SMART Product Update.

Появится окно SMART Product Update.

2. Снимите ф лажок Check for updates automatically (Автоматически проверять наличие

обновлений).

IMPORTANT

Компания SMART ре коме ндуе т не отключать эту ф ункцию.
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Активация ПО SMART
Обычно ПО SMART активируе тся сразу после установки. Но в не которых ситуациях
приходится активировать е го поздне е . Наприме р , е сли не обходимо оце нить ПО до е го
приобре те ния.

NOTES

l Вве рсии 11.1 активация ПО SMART Notebook и SMART Product Drivers не тре буе тся.
SMART пре доставляе т права на использование этого ПО непосре дстве нно при
покупке инте рактивного продукта SMART.

l Если вы хотите использовать ПО SMART Notebook на устройстве , которое не являе тся
инте рактивным продуктом SMART, вы должны приобре сти ключ продукта .

Получение ключа продукта
Портал SMART Software Portal — это ве б -се рвис для просмотра ключе й продуктов, активаций
и проче й инф ормации об установле нном ПО SMART. Внастоящий момент портал SMART

Software Portal доступе н только для англоговорящих пользовате ле й в Се ве рной Аме рике и
Ве ликобритании. Посе тить портал можно по адре су licensing.smarttech.com.

Если вы живе те з а пре де лами Се ве рной Аме рики и Ве ликобритании, свяжите сь с
ре се лле ром (smarttech.com/wheretobuy), чтобы получить ключ продукта .

TIP

Если вы поте ряли ключ продукта , пе ре йдите на страницу: smarttech.com/findproductkey.

Активация программного обеспечения SMART с помощью ключа продукта
После получе ния ключа продукта вы може те использовать е го для активации ПО SMART.

Для активации ПО SMART

1. Вопе рационной системе Windows XP илиWindows 7 выбе рите &quot;Пуск&quot; &gt;

&quot;Все программы&quot; &gt; SMART Technologies &gt; SMART Tools &gt; SMART

Product Update.

ИЛИ

Вопе рационной системе Windows 8 пе ре йдите на экран &quot;Приложения&quot; , а
з атем найдите и выбе рите SMART Product Update.

Появится окно SMART Product Update.

http://licensing.smarttech.com/
http://www.smarttech.com/wheretobuy
http://www.smarttech.com/findproductkey
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2. Нажмите  &quot;Активировать&quot; или &quot;Управление&quot; рядом с названием
ПО, которое хотите активировать .

Появится окно &quot;Активация ПО SMART&quot;.

NOTE

Значе ния в столбце &quot;Состояние&quot; обозначают состояние каждого продукта .

Значение Описание

Установлено ПО установле но .

Активировано ПО установле но и активировано с бе ссрочной лице нзие й или
лице нзие й на те хобслуживание .

Подписка ПО установле но и активировано с лице нзие й по подписке . Число в
скобках обозначае т количе ство оставшихся дне й пе риода подписки.

Срок
истекает

ПО установле но , но не активировано . Число в скобках обозначае т
количе ство оставшихся дне й пробного пе риода .

Срок
действия
истек

ПО установле но , но не активировано . Пробный пе риод исте к. С этого
моме нта продуктможно буде т использовать только после активации.

Неизвестно Состояние ПО неизве стно .

3. Нажмите  &quot;Добавить&quot;.

4. Выполните активацию ПО с помощью ключа продукта , сле дуя инструкциям на экране .

Для просмотра ключей продукта

1. Вопе рационной системе Windows XP илиWindows 7 выбе рите &quot;Пуск&quot; &gt;

&quot;Все программы&quot; &gt; SMART Technologies &gt; SMART Tools &gt; SMART

Product Update.

ИЛИ

Вопе рационной системе Windows 8 пе ре йдите на экран &quot;Приложения&quot; , а
з атем найдите и выбе рите SMART Product Update.

Появится окно SMART Product Update.

2. Выбе рите Tools &gt; View Licenses («Инструменты» &gt; «Просмотр лицензий»).

Появится диалоговое окно &quot;Ключи продукта&quot;.
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3. По заве ршении просмотра ключе й продукта нажмите  OK.

NOTE

Также можно просмотре ть ключ отде льного продукта . Для этого нажмите е го
название в окне SMART Product Update («Обновление продукта SMART») и
выбе рите  View licenses («Просмотреть лицензии»).

Отправка отзыва в компанию SMART
При пе рвом запуске ПО SMART може т появиться диалоговое окно с пре дложением принять
участие в программе сбора отзывов пользовате ле й SMART. Вслучае ваше го согласия ПО
SMART Notebook отправит компании SMART све де ния, которые помогут улучшить новые
ве рсии программного обе спе че ния. После пе рвого запуска ПО эту ф ункцию можно
отключить или включить из ме ню Help (Справка).

Кроме того , з апросы на ф ункции можно отправлять в компанию SMART по эле ктронной
почте .

Для включения функции отслеживания программы сбора отзывов пользователей

выполните следующее:

Выбе рите &quot;Справка&quot; &gt; &quot;Программа сборов отзывов

покупателей&quot; &gt; &quot;Включить отслеживание отчетов&quot;.

Для отключения функции отслеживания программы сбора отзывов пользователей

выполните следующее:

Выбе рите &quot;Справка&quot; &gt; &quot;Программа сбора отзывов

покупателей&quot; &gt; &quot;Выключить отслеживание отчетов&quot;.

Для отправки по электронной почте запроса на функции выполните следующее:

1. Выбе рите &quot;Справка&quot; &gt; &quot;Отправить запрос функций&quot;.

Открое тся почтовый клие нт, з аданный по умолчанию, и появится окно нового
сообщения.

2. Вве дите свой запрос в те ле нового сообщения эле ктронной почты и
нажмите  &quot;Отправить&quot;.
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Chapter 13: Поиск и устранение
неисправностей ПО
SMART Notebook

Поиск и устране ние не исправносте й ф айлов 253
Поиск и устране ние не исправносте й циф ровых че рнил 253
Поиск и устране ние не исправносте й же стов 254
Устране ние не исправносте й параме тров DPI на диспле ях 4K UHD 254

Вданной главе пре дставле на инф ормация о поиске и исправле нии не исправносте й ПО
SMART Notebook.

Поиск и устранение неисправностей файлов
Проблема Рекомендации

Файл соде ржит большие картинки и
открывае тся в SMART Notebook оче нь
ме дле нно .

Экспортируйте оптимизированную ве рсию
ф айла (см. разде л Настройка параметров
оптимизации изображения на странице  237).

Поиск и устранение неисправностей
цифровых чернил
Проблема Рекомендации

SMART Notebook не распознае т рукописный
те кст на опре де ле нном языке .

Установите соотве тствующий языковой
паке т (см. разде л Установка языка на
странице  243).
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Проблема Рекомендации

Вы хотите , чтобы рукописный те кст
отображался в SMART Notebook боле е
е сте стве нно и плавно .

Используйте инструме нт
«Каллиграф иче ское пе ро» вме сто
инструме нта «Стандартное пе ро» (см. разде л
Написание или рисование цифровыми
чернилами на странице  34).

Возникли проблемы с плавным написанием
слов в SMART Notebook на компьюте ре с
опе рационной системойWindows 7.

Включе на ф ункция панорамирования с
помощью одного пальца . Выключите е е (см.

докуме нт smarttech.com/kb/147470).

При написании пе ром SMART Notebook на
компьюте ре с опе рационной системой
Windows 7 инте рпре тируе т все де йствия как
ще лчки мышью.

Включе на ф ункция быстрого движения.
Выключите е е (см. докуме нт
smarttech.com/kb/144274).

Поиск и устранение неисправностей жестов
Проблема Рекомендации

Жесты с не сколькими касаниями, описанные
в этом руководстве , не работают в ПО
SMART Notebook.

Убе дите сь , что инте рактивный продукт
подде рживае тже сты с не сколькими
касаниями, и ф ункция же стов с не сколькими
касаниями включе на .

Устранение неисправностей параметров DPI
на дисплеях 4K UHD
Мы ре коме ндуем использование 125% масштабирование DPI для диспле е в с разрешением
4K UHD. Если ваши те кущие настройки не оптимальны, то при запуске Notebook в ле вом
ве рхнем углу пе рвой страницы може т появиться уве домле ние с ре коме ндацие й уве личить
DPI диспле я. Если вы пять раз з акрое те уве домле ние и не вне се те никаких изме не ний, то
появится диалоговое окно . Внем вы сможе те узнать о том, как изме нить DPI, или отключить
появле ние уве домле ния.

Боле е подробную инф ормацию об изме не нии параме тров DPI можно прочитать зде сь :
Уве личе ние разме ров экрана SMART Notebook с помощью изме не ния параме тров DPI.

http://www.smarttech.com/kb/147470
http://www.smarttech.com/kb/144274
http://knowledgebase.force.com/articles/HOW_TO/Increase-the-size-of-the-screen-display-for-SMART-Notebook-by-adjusting-the-DPI-settings?q=000016952&l=en_US&fs=Search&pn=1
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